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Jump Right In
Thanks for referring to the manual. If your PS System is already set up and you want to skip 
ahead:

Be safe —see Safety Systems on page 1-4
Where’s the _____ ? —see Machine Components on page 1-11
How to run a job —see Running a Job on PS Systems on page 3-2
What if it stops? —see Troubleshooting on page 4-58
What info does Data I/O want when I request service? --see page --x in the Preface.
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- Preface

Using This Manual
IF YOU LIKE EASY TO FIND INFORMATION, read on. This 
manual uses graphics, color and special messages to make it 
easy to read, as well as to make the PS System easy-to-use and 
keep the operator safe.

Warnings and Cautions
Special paragraphs with red lines are safety warnings as follows:

WARNING:   A warning message like this has red text and calls 
your attention to potentially hazardous situations and  practices 
that might injure people or cause serious monetary loss.

CAUTION:  A caution message like this has black text and calls 
your attention to potentially hazardous situations and  practices 
that might damage equipment. The potential loss is not as serious 
as a warning.

Definition of a Warn-
ing.

Definition of a Caution.
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Safety Symbols
Safety symbols in this manual mean this:

—Crush Hazard

—Electric Shock Hazard

—General Hazard Warning

—Eye Protection Warning

—Hazardous Materials Warning

—Laser Hazard Warning

—Electrostatic Discharge Warning
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Symbols for Specific Models/Equipment
The following symbols appear in the side bar next to paragraphs or 
procedural steps that are limited to a specific model or piece of 
optional equipment. If the symbol is next to a heading, the entire con-
tent under that heading is limited to the equipment indicated.

Jump Right In
Thanks for reading about the safety symbols, notes, and icons. If your 
PS System is already set up and you want to skip ahead:

Be safe —see Safety Systems on page 1-4
Where’s the _____? —see Machine Components on page 1-11
How to run a job —see Running a Job on PS Systems on page 3-2
What if it stops? —see Troubleshooting on page 4-58
What info is needed when I request service? -see next page.

For a description of any 
PS model or optional 
equipment, see 
Chapter 1.

. . . adjacent information is limited to the:

PS288 Machines only.

PS388 Machines only.

All PS588 Machines only (regardless of type of 
programmers installed)

Only PS588 Machines with (at least one) FlashCORE 
Programmers

Only PS588 Machines with (at least one) OPTIMA 
(Universal) Programmers 

Only Laser Marking Systems, or PS Machines with 
Marking Systems

Only Tape Output Systems, or PS Machines with 
Tape Output Systems

Only TF20 Tray Feeders, or PS Machines with Tray 
Feeders

Only Label Marking Systems, or PS Machines with 
Label Marking Systems.

A lead, 3D inspection system by ICOS detects bent 
leads on devices. It includes a PC and hardware.

This symbol 
means . . .
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Contacting Data I/O
Contact Data I/O for technical assistance by visiting the Data I/O Web 
site and completing a Web form, by sending an e-mail, or by calling.

To help us give you quick and accurate assistance, please provide the 
following information:
 • PS Machine serial number
 • TaskLink and AH500 software version numbers
 • Detailed description of the problem you are experiencing
 • The event log from the FlashCORE programmer site
 • Error messages (if any)
 • Device manufacturer and part number (if device related)

Data I/O Customer Support

Worldwide: www.dataio.com

China: www.dataio.cn

Germany: www.dataio.de

Other Countries 
Data I/O Customer Support offices around the world are staffed with 
factory-trained technicians to provide prompt, quality service. For 
warranty service, contact Data I/O Customer Support at the numbers 
listed at our Rep Search on our Web site.

For Serial Number location 
see page 1-11

Data I/O Corporation
Redmond, WA USA 98052

Telephone: +1 425-881-6444
in USA:  1-800-3-DATAIO
Fax: +1 425-867-6972
E-mail: support@dataio.com

Data I/O Co. Ltd E-mail: support@dataio.com

Data I/O GmbH E-mail: support@dataio.com

To find your local Data I/O representative, use the Representative 
Search feature at:

www.dataio.com/contact/repsearch.asp

The best way to contact technical support is by using our online 
form: at www.dataio.com click on the Technical Support button.

Want to contact Sales?
USA–
salesDIOAmerica

@dataio.com

China–
ChinaSales@dataio.com

Germany–
salesgmbh@data-io.de

http://www.dataio.com
http://www.dataio.com/contact/repsearch.asp
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Warranty Information
Data I/O Corporation warrants this product will be free from defects 
in materials and workmanship for one (1) year from delivery.
 
This warranty and any third party warranties are in lieu of all other 
warranties, expressed, implied, or arising under law, including, but 
not limited to, the implied warranties of merchantability and fitness 
for a particular purpose.  

Repair Service
\

After the warranty period expires, repair services are available at 
Data I/O Service Centers on a time-and-materials basis, or through a 
fixed price basis. The fixed price basis is an annual agreement that 
covers all parts and labor needed to correct normal malfunctions and 
includes semiannual performance certification.

For more information or to order a Service Contract, call Data I/O 
Customer Support at the numbers listed on the previous page.

Change of Address
If your address has changed, please notify Data I/O Customer Sup-
port via e-mail.  This ensures that you receive information about 
product enhancements. Be sure to include the PS Machine serial 
number.



Preface  •  Repair Service

xii Data I/O • 981-0424-002

back



PS Series Owner’s Manual 1—1

Chapter   1

1Introduction
This chapter covers PS Machine description and components, 
software, safety and room considerations.

The PS288, PS388 and PS588 Automated Programming Sys-
tems (PS System) are versatile production programmers that 
handle and program devices in traditional and fine-pitched 
packages. These include 
BGA, FPGA, µBGA, QFP, TQFP, CSP, 
TSOP, SSOP, SON, WSON, S OIC, and other tech-
nologies supporting memory and microcontroller devices. 

Note: This manual applies to the PS288, PS388 and the PS588, 
unless otherwise noted, and will be referred to as the PS System or 
PS Machine.

The PS System refers to the machine, accessories, the software and, 
more generally, the interactions of all these parts. The PS Machine is 
used to mean the physical machine, not the software. For example, 
you might connect an air supply hose to the PS Machine, but adjust 
the actuation air pressure of the PS System.

The modular design of the PS Machine creates flexibility, allowing 
you to optimize to the level of production required by your facility. 

definition of terms: 
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Snapshot of the PS Machine

Figure 1-1:  Features of the PS Machine. (PS588 shown.)

Many software 
options such as the 
Automotive 
Performance Pak

Support for 
label or laser 
marking

Modular design 
for a wide range 
of applications

Adjustable feet for 
leveling and 
wheels for relocat-
ing ease

Touch screen monitor 
displays real-time pro-
cesses and online Help

Light tower makes 
machine status avail-
able from a distance

Good visibility of the work-
space and easy access.

Flexible options for input & 
output: • static tray (shown), 
• automatic tray feeder, 
• tube, • tape

Uses FlashCORE program-
mer modules offering the 
latest industry technology

Keyboard in a drawer

Supports Tape 
Feeder tape input

Optical Vision 
System for 
precise device 
placement
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Comparison of the PS288, PS388 and 
PS588

The table below compares features among the different models of 
PS Machine.

Setting the Language
Several other languages are available for the User Interface. To 
change the language, edit the WinAH400.ini file as follows:

1. Find “Language Settings” section.

2. Remove the semicolon from the line for desired language.

3. Add a semicolon to the line that initially didn’t have one.

Figure 1-2:  Sample from the WinAH400.ini file. The language in this
sample is set to English.

4. Restart AH500 Software for the changes to take effect.

Feature PS288 PS388 PS588

Maximum number 
of Programmers

4 4 12

Type(s) of Program-
mer 

FlashCORE II FlashCORE III FlashCORE II, FlashCORE III 
and 
OPTIMA (Universal) 
programmers

Socket Actuation by ribs on the PNP 
head

by ribs on the PNP 
head

Integrated into the program-
mer on FlashCORE pro-
grammers, and 
performed by ribs on the 
PNP head for OPTIMA pro-
grammers 

Size 90 cm by 80 cm 90 cm by 80 cm 140 cm by 81 cm 

Weight 364 kg 364 kg 600 kg

;-------- Language Settings------------------------
;Default language is English 1000
;LangId=0       german
LangId=1000    english
;LangID=2000french
;LangID=3000spanish
;LangID=4000danish
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System Description
The PS System moves devices from input media through a program-
ming and optional marking process to output media for delivery to 
the next phase of the production process. The PS System combines a 
device programming system and a high-speed pick and place head 
(PNP head) to provide rapid programming of standard pitch devices, 
as well as ultra-fine pitched devices.

TaskLink™ software and Automated Handler software (AH500) run-
ning on the system’s Handler Computer direct the PS System to per-
form a series of processes, including automatic handling, 
programming, marking, and placement of devices to the output 
media of choice. 

Safety Systems
The PS System has several safety systems to prevent personal injury 
and system damage. These systems include E-Stops and Safety 
Shields. If your system has a Laser Marker, it comes with a fume 
extractor.

Emergency Stop (E-Stop) Buttons
Two large, red Emergency Stop buttons are located near the top of the 
PS System, one on either side of the machine. The buttons are easily 
reached in an emergency. When an E-Stop button is pressed, the 
gantry stops moving immediately. The PNP head Z-axis motion is not 
stopped.
.

Figure 1-3:  Emergency Stop (E-Stop) buttons on the PS288 (not shown)
and PS388 (top). They are different from the PS588 (bottom).

Far
Side

Far
Side
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WARNING:  Shock hazard. Pressing an E-Stop button stops 
motion of the gantry only. It does not remove electrical power 
from the PS Machine or the Option Bay (if installed). Switch the 
main power off for safety. 

Pinch hazard. The E-Stop does not shut off air. On PS588 only, 
Socket Actuators can still move down.

Safety Shields with Interlocks
During operation, when the high-speed PNP head is processing 
devices, the clear plastic shields around the workspace are closed to 
protect operators from injury. Each shield has a safety interlock 
which stops gantry movement if the operator forgets to first park the 
PNP head.

Normally, if the power is ON, the PNP head should be stopped in the 
park position prior to opening a Safety Shield.

WARNING:  Possible collision hazard. The high speed and force of 
the gantry can seriously harm  anyone working inside the operat-
ing area. When working within the PS Machine workspace, mov-
ing the PNP Head must be the responsibility of only one qualified 
individual. All other personnel must stay clear of the PS Machine 
controls to prevent injury to the person working within the system. 
Never operate the system with any interlock bypassed.

WARNING:  Shock hazard. Opening the Safety Shields stops 
motion of the gantry only. It does not remove electrical power 
from the PS Machine or the Option Bay (if installed). Switch the 
main power off for safety. 

Pinch hazard. The E-Stop does not shut off air. On PS588 only, 
Socket Actuators can still move down.

CAUTION:  Possible product damage. Do not use solvents such as 
acetone, lacquer thinner, mineral spirits, isopropyl alcohol, or any 
type of abrasive compound on the safety shields. Use of these 
products will damage the safety shield surfaces and reduce visibil-
ity of the work area.

DEFINITIONS
Park Position:
The spot in the workspace 
(back edge, left of center) 
where the head stops when 
a job is paused or ended.

Home Position:
The far, right corner of the 
workspace (0, 0) where 
the head travels to before 
each job is started.
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Electrostatic Discharge (ESD) Precautions
Devices processed on the PS Machine are very sensitive to static, and 
could be damaged by unintended electrostatic discharge while being 
handled. The most effective way to prevent damage from ESD is to 
make sure a common electric potential (ground) exists between a 
static-sensitive device or component, its environment, and the oper-
ator. 

Operators should wear an antistatic wrist strap connected to the 
grounding connection on the front of the PS Machine. The wrist strap 
should contain a 1–10 M-ohm current limiting resistor. 

Handling Devices Safely
To prevent damage to device pins, use a vacuum tool, also called a 
vacuum tweezer, to pick up devices. The vacuum tool is designed to 
handle devices without damaging them.

CAUTION:  Possible device pin damage. Do not touch devices 
with your hands or any implement other than the vacuum tool. 
Damage to devices with fine-pitched leads may result.

To pick up a device using the vacuum tools use an squeezable air 
bladder for suction. There are a variety of models, sizes and tips. 
Some tips are replaceable. 

A Vacuum Tweezer: Data I/O PN 565-8000-001.                                                                                                                                                                              

[Laser Marking only] Fume Extractor
Used with the Laser Marking option, the laser fume extractor 
removes harmful smoke and hazardous materials from the marking 
area and safely stores them for proper disposal.

Note: See Laser Safety on page 1-24 for more information.
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Machine Axes
The PS System gantry operates on three primary axes: X, Y, Z. An 
additional axis, called the R-axis (theta), is used by the PNP head to 
change device orientation (rotation).

Figure 1-1: These axes are used throughout this manual to describe
motion or direction of components of the PS System. They are the

same for all PS Machines. (PS388 shown.)

Four Basic Operations
The PS System performs four basic operations when processing 
devices:

1. Pick devices from the input media—
The pick and place head (PNP head) unloads devices from the input 
tube, tray, or tape module. These devices are placed into program-
ming sockets in all cases except when Ignore Programmers is selected, 
in which case the head may take devices directly to a different media 
(repackaging only) or to the shuttle pedestal for marking only.

2. Process devices—
Devices in the programming sockets undergo any or all of the fol-
lowing processes as determined by the job. These processes are set in 
TaskLink. 

• Continuity check

There’s a glossary (just 
before the index) of 
terms related to pro-
gramming with the 
PS System.
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• ID check
• Erase
• Blank check
• Program
• Verify programming
• Read
• Illegal-bit check
• Functional verification operations 
• Secure device
• Verify options such as voltage

3. (Optional) ICOS System device inspect
Inspection system by ICOS detects bent leads on devices prior to fur-
ther processing.

4. (Optional) Mark devices—
When marking is selected, devices that pass the programming and 
verification operations are moved to a pedestal on the Shuttle 
Transfer Assembly which delivers them to a Label Marker or Laser 
Marker where they are marked for identification.

5. Load devices into the output media—
Devices are moved by the PNP head from the programming socket or 
the marking pedestal and placed in output media: trays, tubes, or 
tape. Devices that failed the programming operation or subsequent 
verification are delivered to a dedicated Reject Bin or other reject 
module where they are held for failure analysis or other disposition.

Input and Output Options
PS System input and output options are: static tray (manual), tray 
feeder (automatic), tube, and tape.
Any combination of input and output options may be used. For 
example, the PS System can be configured with input as static tray 
and output as tube, or input as tape and output as static tray.
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PS588 Specifications
Specifications are without optional equipment. 

1 Since the monitor arm rotates, length and width dimensions can be 
adjusted inversely, up to 13 cm (5 inches). For example, if you sub-
tract 13 cm from length, then add 13 cm to width.

FACILITIES

Air Pressure clean, dry, oil-free air at 621-827 
kilopascals (90 to 120 PSI)

Air Flow 85 liters/minute (3 SCFM) constant

AC Input Voltage 208–240 VAC, single phase

AC Input Frequency 50–60 Hz

AC Input Power (max) 10 Amps

PS588 DIMENSIONS  

Length (including monitor)1 178 cm (70 inches)

Width (including monitor)1 114 cm (45 inches)

Height + [light tower] 163 cm (64 inches) [56 cm, 22 in.]

Weight 600 kg (1330 lbs)

ENVIRONMENT

Operating Temperature  +13° to +30° C (+55° to +86° F)

Relative Humidity  35% to 90% non-condensing



Introduction  ■  System Description

1—10 Data I/O • 981-0424-002

back

PS288 & PS388 Specifications
Specifications are without optional equipment. 

1 Since the monitor arm rotates, length and width dimensions can be 
adjusted inversely, up to 13 cm (5 inches). For example, if you sub-
tract 13 cm from length, then add 13 cm to width.

FACILITIES

Air Pressure clean, dry, oil-free air at 621-827 
kilopascals (90 to 120 PSI)

Air Flow 85 liters/minute (3 SCFM) constant

AC Input Voltage 208-240 VAC, single phase

AC Input Frequency 50–60 Hz

AC Input Power (max) 10 Amps

PS288/PS388 DIMENSIONS

Length (including monitor)1 127 cm (50 inches)

Width (including monitor)1 112 cm (44 inches)

Height + [light tower] 163 cm (64 inches) [56 cm, 22 in.]

Weight 364 kg (800 lbs)

ENVIRONMENT

Operating Temperature  +13° to +30° C (+55° to +86° F)

Relative Humidity  35% to 90% non-condensing
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Machine Components
The PS System has many components, or subassemblies, that work 
together. Refer to the figure below to locate primary components. 

Figure 1-2:  Primary components of the PS588. Other PS Systems are
similar. Some optional assemblies are also shown.

1. Light Tower • page 1-12
 page 3-25

2. E-Stop  page 1-4
3. Gantry • page 1-12
4. PNP head • page 1-12
5. Workspace
6. Option Bay • for Marking 

System or Tape Output
7. Tape Input • page 1-17

 page 2-16
8. Automatic Tray Feeder 

• page 1-16   page 2-10
9. Tape Output • page 1-17

 page 2-19
10. ESD Strap Connection1 

• page 1-15
11. Handler Computer • page 

1-14
12. Safety Shields   page 1-5
13. Programmers • page 1-13
14. Vision System 

• page 1-14
15. Power Panel • page 1-17
16. Socket Opener air pres-

sure   page 4-8
17. Circuit Breakers • page 

1-18
18. Ethernet connection  

 page 2-4
19. Main air   page 2-2
20. Power switch   page 2-3
21. Serial Number

•brief description,   more detail
1 A ESD Strap connection is on the back, 
also. On PS588 it’s on the right corner 
post. On other models, it’s in the center.

1

23
4
5

6

7

8

9 12

13

14

15

Far side

Back of machine, lower right corner

Programmers (not visible here)

16 18
1917
20

21

11
10
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Component Descriptions

Light Tower
Allows monitoring the status of the PS System from a distance while 
the system is processing devices. See Light Tower Interpretation on page 
3-25 for a complete description of lamp colors and significance.

Gantry
Travels along X- and Y-axes moving the PNP head to different loca-
tions within the work envelope.

Pick and Place Head (PNP Head)
The PNP head is responsible for moving devices to and from their 
respective stages within the workspace. It moves devices in four axes, 
X, Y, Z and R. 

The PNP head uses different sized probe tips to accommodate the 
great number of device types that are available. See Installing the Cor-
rect Probe Tip on page 3-7. During operation, vacuum at the probe 
holds a device. A vacuum sensor detects presence of a device or not.

Figure 1-3:  PNP heads: The new J-Head (top) and the IntellePro Head
(bottom).

SideFront

SideFront
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The PNP head picks up the device and moves it to the Vision System 
camera where it compares the device position on the probe to a dig-
ital image. It corrects for misalignments before the device is placed 
into the programming socket. To place a device at a target location, 
the probe lowers, vacuum is turned off and blow-off air is momen-
tarily turned on. 

The PNP head carries the Socket Opener. The exception to this is the 
PS588 with FlashCORE Programmers (no Optima Program-
mers)—actuators on the programmers open sockets versus openers.

WARNING:  Collision hazard. The gantry system and associated 
components move with great speed and force, and have the 
potential to cause great bodily harm. Do not bypass the safety 
interlocks or operate the PS Machine with the safety shields open 
or removed.

Programmers 
Optima Programmers (also called Universal Programmers) are an 
earlier design and support the most Flash devices including logic 
devices and many microcontrollers. Optima programmers can be 
mounted only on PS588, even alongside FlashCORE programmers. 
An Optima Support Kit is available for PS588 customers needing to 
replace their Optima programmer. PS588 customers without an 
Optima programmer who wish to install one should contact Data I/O.

Figure 1-4:  An Optima Programmer for PS588 only. This programmer
requires an Optima adapter.

Data I/O’s FlashCORE programming modules are the fastest pro-
grammer architecture available. Modules come in single, dual, or 
quad units. PS588 FlashCORE programmers have socket actuation 
built in. 

An Optima Programmer installed, with 
a Socket Adapter on it.
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Figure 1-5:  A FlashCORE Programmer with a Socket Adapter and
Actuator Plate installed on it.

Vision System
The camera and associated components of the Vision System provide 
fine alignment of devices removed from the input media before 
inserting them into the programming sockets or marking pedestal.

Static Tray Mount
Using positioning pins and magnetic L-shaped brackets (or thumb 
screws on some models), JEDEC and non-JEDEC standard trays are 
held firm for the PNP head to pick devices and return them after pro-
cessing.

Figure 1-6:  Static tray mount on PS288.

Handler Computer
The computer that hosts TaskLink software and the AH500 software, 
monitors all sensors. It also hosts the Vision System and in some 
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models hosts the Laser Software if applicable. The computer contains 
a CPU that runs Microsoft Windows XP Operating System (at time of 
release). 

CAUTION:  Possible machine damage. The PS System should 
never have software added unless instructed to do so by Data I/O 
Customer Support. Adding software to the PS System can cause 
damage and/or cause the system to operate improperly. Adding 
software without specific instruction from Data I/O Customer Sup-
port will void the warranty and may incur service charges. 

Keyboard and Track Pad
Used for operation. Can be used instead of the touch screen monitor. 

ESD Strap Connection
When operators plug an antistatic wrist strap into the ESD strap con-
nection, it reduces the risk of damage to devices and Socket Adapters 
from electrostatic discharge (ESD).

Touch Screen Monitor
The display screen (user interface) on the PS System, accepts input 
when touched or tapped with a finger. The touch screen may be used 
instead of the keyboard and track pad. 

Note:  Throughout this Owner’s Manual, the term click is also 
used to mean tap when using the touch screen monitor.

Safety Shields
Designed to protect against injury and damage from the PNP head 
movement, the safety shields are an important safety feature, stop-
ping the gantry when they are opened. For more information see 
Safety Shields with Interlocks on page 1-5.

(Optional) Marking System
A Label Marking or Laser Marking System is used to mark devices 
for identifying at a later time. Either marking system is installed in 
the Option Bay at the back of the PS System.

The marking systems use the Shuttle Transfer Assembly to move 
devices to and from the marking stage. The shuttle transfer is a 
belt-driven shuttle system that has two pedestals for holding devices.   

If the Tape Output System is selected in addition to a marking 
system, then only one of the pedestals is used since both marking and 
the tape output systems are in the Option Bay. 

Label Marking
The Label Printing System only uses one pedestal.
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Figure 1-7:  Paper Labeler. (Your labeler may look different.)

Laser Marking 
The Laser Marking System uses a CO2 laser to mark parts. The laser 
applies a user-defined mark. The laser marking system operates as a 
Class 1 laser system (CDRH classification), and therefore uses inte-
grated interlocks to prevent the laser from firing while any cover is 
open. The laser should never be operated without safety covers in 
place.

WARNING:  Blindness hazard! When servicing, always wear eye 
protection when the laser access doors are open. Direct or diffuse 
laser radiation can damage eyes. Goggles must block 10.57 to 
10.63 μm laser radiation. Goggles protect against scattered 
energy but not against direct viewing of the laser beam or reflec-
tions from metallic surfaces.

WARNING:  Serious burn hazard!  Laser radiation, whether direct 
or diffuse, can cause serious burns. When servicing, keep hands 
and other parts of the body out of the path of the laser beam.

WARNING:  Toxic fume hazard! Laser marking generates vapors, 
fumes, and particles that may be noxious, toxic, or even fatal. Fol-
low maintenance procedures on the fume extractor. Use proper 
ventilation.

For additional safety information, see Laser Safety on page 1-24.

(Optional) Automatic Tray Feeder
Designed to automatically supply devices in trays to the PS System, 
the TF20 Automatic Tray Feeder accepts thin or thick JEDEC trays. 
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Figure 1-8:  TF20 Tray Feeder.

(Optional) Tube Input and Output Modules
The input tube holds blank devices and the output tube collects 
devices after programming. Vibration mechanisms keep devices 
sliding freely by gently vibrating the tubes to reduce the likelihood of 
device jams. Vibration adjustment controls are located on the front of 
the PS System.

(Optional) Tape Input Module
The tape input module is a chip feeder which provides devices for 
programming. Each device is picked from a carrier tape pocket and 
placed into a programming socket. 

(Optional) Tape Output Module
The tape output module, mounted on the Option Bay, uses a reel of 
empty carrier tape to hold devices after they are programmed. Pro-
grammed devices are placed into empty pockets on the carrier tape. 
The carrier tape advances through either a heat seal or pressure seal 
unit that applies cover tape to the carrier tape. 

Power Panel
The Power Panel is on the back of the machine at the lower, right 
corner.

Connections
The Power Panel allows for the attachment of AC power and air. 
Optionally, you can connect an ethernet cable for internet connection.

Controls
Mounted on the Power Panel are the main power switch and the 
main air regulator and filter. There is a second regulator with a sepa-
rate gauge for adjusting socket opener pressure. See Adjusting the 
Socket Actuator Air Pressure on page 4-8.
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Figure 1-9:  Power Panel on the back of the PS Machine.

Circuit Breakers
There are three circuit breakers on the Power Panel.

Programmers 230 V 10 A

Servos 230 V 10 A

Main 230 V 15 A
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Software
Software resides in the Handler Computer. The primary logon for the 
Handler Computer is Microsoft Client. The current operating system 
(at time of this publication) is Windows XP.

CAUTION:  Possible machine damage. Adding software to the 
PS System can cause damage and/or cause the system to operate 
improperly. Adding software without specific instruction from 
Data I/O Customer Support will void the warranty and may incur 
service charges.

CAUTION:  Possible machine damage. Microsoft Windows system 
parameters and network parameters should not be changed 
unless instructed to do so by Data I/O Customer Support. Chang-
ing parameters can cause failure and/or damage to systems or 
cause improper programming.

Customer-Supplied Software
The PS System should never have other software added without con-
sulting with Data I/O Customer Support. 

Antivirus Software
Customer-supplied antivirus software can be installed on the Han-
dler Computer. 

CAUTION:  Check with Data I/O Customer Support to ensure that 
your software is compatible with the PS System, otherwise the 
warranty may be voided. Ensure that the antivirus software does 
not scan during a job run. 

Statistical Process Control Software
Customer-supplied Statistical Process Control software can be 
installed on the Handler Computer. See Statistical Process Control Soft-
ware on page 3-55 for more information. 

TaskLink
TaskLink™ for Windows® is Data I/O’s versatile application for cre-
ating jobs to run on the PS System. TaskLink resides on the Handler 
Computer.
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Figure 1-10:  TaskLink’s main window displays the selected
programming system for which it creates jobs.

TaskLink online Help is available by clicking Help > Help Topics. It 
offers procedural steps as well as domain information.

Figure 1-11:  TaskLink online Help. It includes update instructions.

Updates and Algorithm Support
Updates to TaskLink (includes algorithm updates) are generally 
acquired through our APS Agreement (Annual Programmer Sup-
port). See APS Agreement on our Web site under the SUPPORT tab. 

CAUTION:  Customers with PS Systems with Windows 98 OS — 
take note of special instructions due to limited support. TaskLink 
Version 7.31 is the last supported update for Windows 98. Limited 
device support may be installed as noted in each release.
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For more information, see TaskLink online Help.

AH500 Application
Data I/O’s Automated Handler software is a Microsoft® Win-
dows®-based application for setting up and programming microchips 
(devices) on PS Systems. It offers a selection of many PS System 
options such as input/output configurations, labeling options, and 
statistical feedback methods. The AH500 resides in the Handler Com-
puter. 

For updates to AH500 Software see PS Series Firmware Download on 
our Web site under the SUPPORT tab.

Figure 1-12:  AH500 Start-up Window. The Serialization button only
appears if Serialization was selected in TaskLink for this particular job.

(PS388 shown.)

Laser Software
The Laser software is a Windows®-based application that allows cre-
ating parameters required for laser marking jobs as well as initiating 
laser marking. In some PS models, the software resides on the Laser 
Computer located in the Option Bay. In other models, the software is 
in the Handler computer. 

Note: The touch screen does not work while in Laser Computer 
mode. 

When the Laser Marking System is set up and initialized, it receives 
commands from the AH500 which starts the marking sequence. 

The presence of some 
features are deter-
mined by the 
winAH400.ini file.

For more information 
about the Laser Sys-
tem, see Setting Up the 
Laser Marking System on 
page 2-27 and 
(Optional) Creating a 
Laser Marking File on 
page 3-62.
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Switching Between Computers
Some PS models have a separate computer for the Laser software. 

To switch between the laser computer and the Handler computer:
1. On the keyboard, press Ctrl twice. A list of all computers is dis-

played on the touch screen monitor. 
2. Use the up and down arrows to select a computer.
3. Press Enter on the keyboard.
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Precautions for Safe Operation
The PS Machine has many safety features designed to make the 
system safe and efficient to operate. The system can be dangerous if 
the safety precautions and features are ignored.

Precaution List
To avoid possible personal injury or damage to the equipment, 
observe the following practices:

General Precautions
 Do not use the PS System for any purpose other than its 

intended use.
 Do not operate the system if the safety shields are not in their 

normal operating positions.
 Do not operate the system when any of the cabinet panels (sheet 

metal) are removed.
 Do not operate the PS System unless you have been thoroughly 

trained and have read and understand the instructions in this 
manual, particularly those that describe the system’s safety fea-
tures (Safety Systems on page 1-4).

 Do not disable or attempt to defeat any of the safety features of 
this system. Serious personal injury and equipment damage can 
occur if any safety systems are disabled. If you suspect that a 
safety feature of the system is damaged or malfunctioning, stop 
using the PS System immediately and contact your local 
Data I/O Support representative. 

 Do not place any part of your body near or in the direct path of 
moving parts.

Repair Precautions
 Only qualified personnel trained by Data I/O should install, 

maintain, repair, or troubleshoot the PS Systems.
 Do not operate a system while servicing, replacing, or adjusting 

any component unless directed to do so in this manual. Make 
sure that the system is properly shut down before servicing, 
replacing components, or adjusting components.

 Disconnect the external air before servicing pneumatic parts.

Optional Media and Equipment Precautions
 Use extra caution when using the tape input media (feeder), the 

tape output media, or the device marking option. The 
PS System safety shields do not cover or fully enclose these 
modules. It is possible that hands, body parts, or loose clothing 
could get caught or pinched in these mechanisms.

 Read and heed the laser vacuum filter disposal requirements 
described later in this section (Laser Safety on page 1-24). Always 
dispose of any other hazardous or residual by-products of the 
production process in accordance with governing laws and reg-
ulations.

WARNING:  

  
Pinch hazard. 
The E-Stop 
does not shut 
off air. On 
PS588 only, 
Socket Actua-
tors can still 
move down 
when an 
E-Stop is 
pushed— and 
even when 
Safety shields, 
are open.

Use caution.
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Laser Safety
The laser marking system, located in the Option Bay attached to the 
PS Machine, has been designed in accordance with the following 
safety guidelines:
 • Operates as a Class 1 laser (CDRH classification).
 • Fume extractor traps marking fumes and other by-products of 

the laser marking operation.
 • System designed to comply with OSHA guarding standards.
 • Integrated safety interlocks prevent the laser from firing while 

any interlock is activated.
 • Refer to and follow laser and safety precautions in ANSI 

X136.1-1993, American National Standard for the Safe Use of 
Lasers. Procedures listed under the Standard include: appoint-
ment of a Laser Safety Officer, operation of the product in an 
area of limited access by trained personnel, servicing of the 
equipment only by trained and authorized personnel, and post-
ing of signs warning of potential hazards.

WARNING:  Blindness hazard! When servicing, always wear eye 
protection when the laser access doors are open. Direct or diffuse 
laser radiation can damage eyes. Goggles must block 10.57 to 
10.63 μm laser radiation. Goggles protect against scattered 
energy but not against direct viewing of the laser beam or reflec-
tions from metallic surfaces.

WARNING:  Serious burn hazard!  Laser radiation, whether direct 
or diffuse, can cause serious burns. When servicing, keep hands 
and other parts of the body out of the path of the laser beam.

WARNING:  Toxic fume hazard! Laser marking generates vapors, 
fumes, and particles that may be noxious, toxic, or even fatal. Fol-
low maintenance procedures on the fume extractor. Use proper 
ventilation.
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Laser Specifications
Specifications for laser Model 48-1(S) installed in the Option Bay: 
.

Laser Safety Interlocks
The Option Bay has five safety interlocks that prevent the laser from 
firing when any cabinet panel on the Option Bay is removed. To 
physically enable the laser, all panels must be closed. A laser safety 
interlock is shown in Figure 1-13.

Figure 1-13:  Laser safety interlock is visible when an access panel is
removed.

WARNING:  Safety hazard—Never leave the PS Machine unat-
tended with a safety shield removed. 

(S) O f (

Weight

Model 48-1(S) 48-1(S)W

Output Power

Mode Quality

Ellipticity

Rise Time

Beam Diameter

Beam Divergence (full angle)

Wavelength

Power Stability, from cold start (guaranteed)

Polarization
Cooling Air Water
Heat Load (max)

Flow Rate, Air 250 CFM x 2 N/A
Flow Rate, Water (18-22ºC) N/A 0.5 GPM

Input Voltage / Current

Dimensions (in)

                   (mm)

3.5mm

4mR

10.57-10.63μm

Linear (Vertical)

±10

429 x 71 x 107

9 lbs / 4.1 kg

16.9 x 2.8 x 4.2

30 VDC / 7A

10W

300W

TEM00, 95% Purity

M2<1.2

<1.2

<150μsec
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Serious burn hazard—Direct or diffuse laser radiation can cause 
serious burns. 

Blindness hazard—Direct or diffuse laser radiation can damage 
eyes.

Disposal of Laser Vacuum Filters
The laser marking system uses a vacuum to remove the smoke and 
other by-products of the laser marking process. The smoke fumes 
pass through a series of filters designed to remove airborne particles 
from the operating environment. Material Safety Data Sheets (MSDS) 
for materials being processed should be thoroughly evaluated and 
the adequacy of provisions for fume extraction, filtering, and venting 
should be carefully considered.

The exact composition of the materials trapped by the filters depends 
upon the materials used by the semiconductor manufacturer to create 
the device package. Dispose of the filters in accordance with the 
facility’s hazardous waste policy and in a manner that meets all appli-
cable government (local, state, and federal—or equivalent) regula-
tions.

Review the following references for further information regarding 
exposure criteria:
 • ANSI Z136.1-1993, Standards for the Safe Use of Lasers, section 7.3.
 • U.S. Government’s Code of Federal Registers: 29 CFR 1910, 

subpart Z.
 • Threshold Limit Values (TLVs) published by the American Confer-

ence of Environmental Industrial Hygienists (ACEIH).

Determining Hazardous Contents
The company contracted to dispose of your facility’s hazardous waste 
may be required to perform a profile of the filter contents to deter-
mine the specific composition of the particulate matter. The manufac-
turer of the semiconductor devices being marked may be able to 
provide a profile sheet describing the composition of their packaging 
material.

Standard plastic device packages typically contain antimony hydroxide 
as a fire retardant, the source of the antimony in the vacuum filters. 
Other hazardous materials may also be present depending upon the 
type of device packages that are laser marked.

After the initial profile is performed and on record with the company 
that disposes of the facility’s hazardous waste, additional testing of 
contaminated filters should not be needed unless the contents of the 
device packages or type of device packages being marked changes 
significantly.

The licensed hazardous waste disposal company can provide the nec-
essary information to label the bags containing the filters and paper-

Analysis of filter con-
tents obtained following 
marking a representa-
tive variety of devices 
has revealed a sufficient 
level of hazardous 
materials, such as anti-
mony and other heavy 
metals, to require that 
the filter be treated as 
hazardous waste.
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work required for transportation and disposal in a manner that meets 
applicable government (local, state, and federal—or equivalent) haz-
ardous waste regulations.

Filter Handling and Storage
The procedure for replacing the laser vacuum filters is described in 
the Fume Extractor manual and repeated in Laser Marking Filters on 
page 4-41.
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Room Considerations
When planning the space and environment for a PS Machine installa-
tion, consider ventilation and access for maintenance and repair.

Ventilation
Summary— Regarding ventilation, the minimum room size for any 
PS System is 3 x 3 meters x 2.4 meters high (10 x 10 x 8 feet). However, 
access space for a some machines require a larger room; see Access 
Space below.

The PS System, and its optional components such as a Label or Laser 
Marking System, contain mechanical components and electrical sys-
tems that generate heat and extremely low levels of particulate 
matter.

The room should have suitable levels of general room heating, venti-
lation, and air conditioning. For an occupied office area, the Amer-
ican Society of Heating, Refrigeration, and Air Conditioning 
Engineers, Inc. (ASHRAE) Standard 62-1992 specifies a minimum of 
15 cubic feet/minute (CFM) (0.424 cubic meters/minute) of air per 
occupant. This level of ventilation is intended to provide the occu-
pants of the room with sufficient air movement to provide a comfort-
able environment. 

However, because the PS System generates heat, an additional 85 
CFM (2.40 meter3/minute) is recommended, bringing the total room 
air exchange rate to 100 CFM (2.83 meter3/minute). In a room with 
dimensions of 10 feet by 10 feet, with an 8 foot ceiling (800 cubic feet 
of total interior area), 100 CFM would provide approximately six 
room air changes per hour. (Metric room: 3.0 M x 3.0 M x 2.4 M 
ceiling equals 22.65 cubic Meters of total interior area).

Based on industrial hygiene monitoring performed during the worst 
case operating scenario of a PS System with Laser Marking, this rate 
of air movement is sufficient to provide a safe and healthy work envi-
ronment regarding air quality.

Access Space
The PS System should be located in a room with adequate space to 
allow easy access to all enclosures. A minimum of one meter (36 
inches) of clearance on all sides is required for removal of system 
components.

The table below lists recommended, minimum envelope size deter-
mined by the 1 meter access space required on each side: 

The air movement is 
intended to dissipate 
heat, odors, and other 
exhalation products 
from respiration such as 
carbon dioxide and 
water vapor.
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For example, a PS588 with laser marking equipment (Option Bay) 
requires a minimum area of 3.5 meters long x 3.1 meters wide for 
easy access.

Figure 1-14:  Maximum envelope of PS388 with Option Bay and Tape
Output (approximate; to scale).

Envelope, L x W  
PS Machine  PS only PS + Option Bay PS + Tape Out

PS288 / PS388 Use min. ventilation 
size; see previous 
heading Ventilation.

3.0 x 3.1 m 3.3 x 3.5

PS588 Use min. ventilation 
size; see previous 
heading Ventilation.

3.5 x 3.1 m 3.8 x 3.5

Keyboard

PS288 / PSS388

Option Bay

Tape Out
(max. size)
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Chapter   2

2Setup
This chapter covers setting up the PS machine as well as set-
ting up equipment on the machine. This includes optional 
equipment such as the Option Bay and Tape Output equip-
ment, as well as the various device media choices for running 
jobs, such as setting up Static Trays or an Automatic Tray 
Feeder. 

Installation of the PS Machine is performed by Data I/O service per-
sonnel or an authorized distributor. After the PS Machine arrives, 
ensure that there is no damage to the exterior of the crate. Remove the 
PS machine from the crate and inspect for damage that may have 
occurred during shipping. If  no damage is evident, unbolt the 
PS machine from the shipping pallet. 

The intended area for PS installation must: 
 • allow at least one meter (36 inches) of clearance on all sides of 

the PS machine for opening access panels as well as repairing 
and replacing subassemblies,

 • provide a solid foundation (for example, a concrete floor). The 
PS machine contains a fast-moving gantry with much mass. The 
area for it must be stable, solid, and mostly level prior to installa-
tion. If this is not achievable, consider installing the system at 
another location.

When at the desired location, adjust the feet to level the PS Machine.

WARNING:  Possible machine damage or personal injury. Instabil-
ity such as vibrating, walking, or rocking, may occur if fewer than 
four of the installed feet make suitable contact with the floor, or if 
the leg locknuts are not tightened against the frame. 

Only the adjustable feet provided on the PS machine should be 
used for leveling. Do not use shims to assist in leveling. 

The information in this 
Manual applies to the 
PS288, PS388 and 
the PS588, (referred 
to as PS System) 
unless otherwise noted. 
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Connecting Facilities
The PS System requires two external services: pressurized air and 
electrical power. It also allows one optional connection to an Internet 
via a Network connection. These services connect to the PS System at 
the Power Panel located on the back of the machine. With the two 
required services, the PS System creates all the unique electrical volt-
ages needed as well regulating pneumatic pressure for all systems 
within the machine.

Connecting Air
The PS System requires clean, dry, oil-free air from an industrial 
grade compressor. The compressor’s tank should be of sufficient size 
to maintain constant air pressure at 85 liters per minute (3 Standard 
Cubic Feet per Minute).

Note: If the compressor cannot maintain the correct air pressure, 
system performance will be affected.

Figure 2-1: The Power Panel on the back of the machine.

Connect the air to the PS System at the main regulator and filter. 

Note: The PS System air filter is a secondary filter only. Install a 
main 10 micron filter/regulator between the factory compressor and 
the PS System.

The external air line should be at least 3 meters (10 feet) long to allow 
the supplied air to cool sufficiently so that water vapor contained in 

8P8C Ether-
net connec-
tion

Air connec-
tion: main 
regulator 
and filter

Power cable
(doesn’t discon-

nect here)

Power 
Switch

Socket Actua-
tion pressure 
regulator & 
gauge [PS288 
& PS388 and 
Optima only 
on PS588]

Circuit 
Breakers:
See Circuit 
Breakers on 
page 1-18 for 
more informa-
tion.
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the air condenses and can be extracted. See Figure 2-1 for the location 
of the external air line connection.

CAUTION:  Possible air system damage. Oil, excessive moisture, or 
poorly filtered air will obstruct the system’s internal air pathways, 
affect performance, and void the warranty related to air system 
failure. If oil or excessive moisture is detected, contact Data I/O 
Customer Support or a local Data I/O approved service represen-
tative.

Main Air Pressure Gauge
The main pressure regulator is set at 5.5 ±0.7 Bar (80 ±10 PSI) as 
shown on the regulator. This is set in the factory and cannot be 
changed. 

When air pressure is within range, the regulator readout is green. If 
air pressure is above or below the acceptable range, the readout dis-
plays red. If it is red (out of range), contact Data I/O Support or a 
qualified service technician.  

Socket Opener Pressure
[PS288, PS388, Optima only on PS588] This regulator controls the air 
pressure which lowers the Socket Opener that opens sockets. Set the 
pressure now using instructions found at Adjusting the Socket Actuator 
Air Pressure on page 4-8.

Connecting Electrical Power
Required power is provided through a supplied 3-wire power cable 
with one end terminated in an electrical plug as required by the cus-
tomer’s facility. For power specifications, see PS588 Specifications on 
page 1-9 or PS288 & PS388 Specifications on page 1-10.

If there is low air pressure 
the monitor may display a 
message reading No air.
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Figure 2-2:  Electrical power cable and plug. The machine end of the
cable is not removable.

(Optional) Connecting to a Network
A Network connection is on the Power Panel. 

CAUTION:  Possible virus hazard. The PS System has no antivirus 
software installed from the factory. Prior to connecting to a net-
work, Data I/O recommends installing antivirus software.

To connect to a network, plug in an ethernet cable. Refer to Figure 2-1 
on page 2–2. See the next heading, Applying Power, prior to setting up 
a network connection. 

After starting up and logging on, at the monitor, click My Computer > 
Tools > Map Network Drive.

IP Address and Port Number
If you need the IP Address for communicating with other Data I/O 
software, they are available via TaskLink. The Port numbers are also 
displayed. (Port numbers are the same for all programmers on a 
PS Machine.) 

Addresses and Port numbers can be found as follows.
1. Start TaskLink on the target PS System. (Closing AH500 will 

return to TaskLink.)
2. Click System > Options, and then the Communication tab. The IP 

Address and site numbers are listed in the lower left corner.
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Figure 2-3:  TaskLink Communication Tab displays IP Addresses and
site numbers.

Applying Power for the First Time
Before the PS System is turned on for the first time, ensure the fol-
lowing:
 The external air line is connected, and the main air valve is open.
 All E-Stop buttons are in the released (operating) positions (refer 

to Emergency Stop (E-Stop) Buttons on page 1-4 for location).
 All safety shields and access panels are closed.
 The circuit breakers on the Power Panel on the back of the 

PS System are in the ON (UP) position.
 The power switch on the Handler Computer is set to the ON 

position.
 [PS588 Only] (Optional) If you want to change the type of pro-

grammers, see Removing a Programmer on page 4-30.
 (Optional) The Socket Adapters required for the job have been 

installed on all necessary programmer sites. See Installing Socket 
Adapters – FlashCORE on page 3-3 for more information.
[PS588 only] See Installing Socket Adapters – OPTIMA on page 3-6 
for more information. 

When satisfied, rotate the main power switch on the Power Panel (at 
the back of the PS Machine) to the ON position (clockwise). 

 After power is applied, verify that no obvious failures or electrical 
anomalies occur. Verify that the Handler Computer starts properly 
and displays a network log-on dialog. 

Normal operating pro-
cedure never requires the 
Handler Computer 
power switch to be 
turned off manually.
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Note: If electrical or mechanical problems are noted, turn off the 
PS System and notify Data I/O Customer Support.

At the Microsoft XP Log-on Window, click the user profile to (usually 
labeled MFG to complete the startup procedure). 

Figure 2-4:  Windows XP Log-on Window.

(Optional) To connect to a network see (Optional) Connecting to a Net-
work on page 2-4.

(Optional) Installing Antivirus Software
The PS System has no antivirus software installed from the factory. It 
is highly recommend that customers install their own antivirus soft-
ware. The software should be set to run virus scans manually rather 
than at a scheduled time unless you are sure that the PS System will 
not be running jobs at that time. 

Note: An antivirus program may affect performance.

The PS System runs Windows XP Professional operating system. 
Follow instructions for your antivirus software. Contact Data I/O 
with specific questions.

Setting Up Input and Output Media
There are many options for device input and output. One option for 
input and one for output must be set up on the PS Machine for your 
target job. Further, the  setup must correspond with the current soft-
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ware, such as Job file, WinAH400.ini file, and printer file. These 
input/output media are described in this section:
 • Static Tray (below)
 • Automatic Tray Feeder
 • Tube Input/Output (vibratory)
 • Tape Feeder Input
 • Tape Output

Setting Up Static Tray Input and Output
The standard configuration for the PS System is static tray input and 
static tray output media. The latest tray mounting configuration uses 
a spring-loaded thumb screw for holding the tray in place, while the 
earlier configuration uses magnetic angle brackets. 

Note: Ensure that blank devices are loaded into the tray with the 
correct pin 1 orientation. If pin 1 orientation doesn’t match pin 1 
on the sockets, the correct rotation must be taught in the Package 
file. 

Pin 1 on Data I/O sockets is almost always toward the far side of 
the adapter (the back of the PS Machine). Some BGAs and PLCCs 
are marked.

Tray Orientation
IF THE TRAY MOUNT IS ORIENTED with the long side parallel to 
the Y-axis:
 • The input tray goes on the left. Orient the 

trays with the beveled corner to the far 
left.

IF THE TRAY MOUNT IS ORIENTED with 
the long side parallel to the X-axis:
 • The input tray goes nearest to the opera-

tor. Trays can be oriented with the bev-
eled corner on the left or right. However, 
with Automatic Tray Feeders it must be to the right.

Static Tray Mount with Thumb Screw
To set up the static Thumb Screw Tray input and output:

1. Preparation—
1a. Ensure the PNP head is parked.
1b. Open the front safety shield.

2. Install the Trays—
2a. Set the tray onto the mounting plate inside the indexing blocks.
2b. Use the thumb screw to secure the tray by rotating it 1/2 revolu-

tion past contact with the tray.

Any output media can 
be used with any input 
media.

Tray mounts can be ori-
ented along the X-axis 
or the Y-axis. 
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Figure 2-5:  To remove a tray, unscrew the thumb screw and lift the tray
out. A second method is NOT RECOMMENDED: pulling the thumb screw

back and holding it away from the tray while lifting the tray out; if the
thumb screw is released too soon, devices may be knocked out of the

tray.

Static Tray Mount with Magnets
To set up the static tray input and output with magnetic brackets:

1. Preparation—
1a. Ensure the PNP head is parked.
1b. Open the front safety shield.

2. Install the Trays—

Figure 2-6:  Push trays snug against index pins (circled). Extra pins are
for larger trays. Push the magnetic bracket snug against the tray.

2a. Set the tray onto the mounting plate and snug against the index 
pins on two sides. 

2b. Place the ‘L’ shaped magnetic bracket against the corner adjacent 
to the un-indexed sides. 
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Remember that
 •  the Setup Window > Options tab must be set to match the work-

space setup. This is covered in Chapter 3, Set Media and 
Options—the Setup Window.

 • The Package File must be taught the Tray locations.

CAUTION:  Temporarily removing trays has consequences. Sensors 
register a tray’s presence. 

If a tray is removed and then returned to the mount while a job is 
Paused, the software proceeds as if:  [Input tray] the tray is full 
and all devices are unprocessed, and [Output tray] the tray is 
empty.

Install Reject Bin
Install a reject container for devices failing any process. Many work-
space layouts are possible. Generally, a Reject Bin or box is placed 
near the back center area of the workspace, just to the right of pro-
grammer 2 as shown in Figure 2-7. However, it can be placed wher-
ever there is room for it as long as its location is taught in the Package 
File.

Figure 2-7:  Common locations for the Reject Bin, PS588 (left) and
PS288 & PS388 (right).

Note: On the Gantry Window, the Reject Bin or Tray is repre-
sented by the yellow position label that reads RTr.

A tray may also be used as a Reject container. Possible layouts are 
shown in the following diagram.
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Figure 2-8:  Four possible Input/Output layouts with one and two
Automatic Tray Feeders. Only one layout uses a tray for the rejected

devices.

Remember that 
 • the Setup Window > Options tab must be set to match the work-

space setup. This is covered in Chapter 3, Set Media and 
Options—the Setup Window

 • The Package File must be taught the location of the Reject con-
tainer.

Setting Up an Automatic Tray Feeder
The PS System can be configured with a TF20 Automatic Tray Feeder. 

The Tray Feeder must be level and square to the PS Machine. For gen-
eral information about setting it up, see the Tray Feeder Owner’s 
Manual that came with your system. Look for the heading Installation.

TF
20

TF
20

TF
20

TF
20

TF
20

TF
20

Rej

+ Easy to reprocess rejected devices
– Trays may not get completely filled
– A tray jam can cause ambiguity if no 
   device marking is employed

In/Out

In/Out

Aux. Static
Input

Input

In/Out

In/Out

Output

TRAY ARRANGEMENTS WITH AUTOMATIC TRAY FEEDERS

TIME

Q
TY

Highest
Throughput

Lowest
Throughput

Output Advantages and Disadvantages

Rej

Rej

Rej

Tray Configurations
�

Throughput

+ Best programmer utilization
– A tray jam can cause ambiguity if no 
   device marking is employed

+ Fail-safe separation of programmed/unprogrammed devices
– Requires the most trays

+ Best throughput with one Automatic Tray Feeder
– A tray jam can cause ambiguity if no 
   device marking is employed
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Note: Due to variations, detailed instructions are supplied with 
each mounting kit.

Figure 2-9:  Two TF20 Automatic Tray Feeders on a PS588. Arrows
point to the connections for one of them.

The winAH400.ini file requires editing prior to using an Automatic 
Tray Feeder if your PS Machine has not already been set up for Auto-
matic Tray Feeders at the factory. See the on-screen Help file for topic 
Editing the WinAH400.ini file.

Note: On some models, your Setup > Options Window does not 
indicate whether Tray 1 and/or Tray 2 are Static Trays or Auto-
matic Tray Feeders. 

Note: When your winAH400.ini file is set to run Automatic Tray 
Feeders, before you can run static trays again, the file will need to 
be changed back to ModelTray1=STD.

Basic operating instructions are covered in Chapter 3 of this manual.

Spare Tray Configurations
You can use a static tray with an Automatic Tray Feeder (ATF). When 
tray 2 is designated as a spare static tray, the devices from that spare 
tray are used to replace rejected devices. They are also used as a 
buffer during a tray change. This allows the Tray Feeder to exchange 
trays only when full. (Without the spare tray, the Tray Feeder will 
exchange trays with empty pockets.)  For possible configurations, see 
the chart on the following page.

Air hose 
quick-connect

Electrical 
connection

Prior to editing the 
winAH400.ini file, make a 
backup copy.
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Figure 2-10:  Possible Spare Tray configurations in the Setup > Options
Window. Only Tray 2 can be designated as a spare tray.

Setting Up the Tube Input and Output 
Media

As an option, the PS System can be configured with tube input and 
tube output media. Prior to starting this procedure, turn off the 
machine; see Turning Off System Power on page 3-27.

Note: The Data I/O Tube Feeder Option, which includes two 
motors and different front panel with control knobs, must already 

If your ATF(s) is 
set up as 

configurations 
possibilities 

 Tray 1 is ATF 
IN

Tray 1 as ATF 
OUT

Tray 1 as ATF 
IN  & OUT

Spare tray as OUT  X X

Spare tray as IN   X

Spare tray as 
Reject

  

Spare tray as IN & 
OUT

X X X

If you wish to set 
Tray 1 as ATF 
FAIL, contact Data 
I/O Customer 
Support or a local 
Data I/O 
approved service 
representative.
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be installed in the PS System. If it is not, contact Data I/O Cus-
tomer Support or a local Data I/O approved service representative. 

To set up the tube input and tube output media:

1. Determine the size of the devices to be programmed and select 
tubes and platform that match device size.

Figure 2-11:  Input tube loader platform. (The tubes are not installed).

Note: You can perform Step 3 before Step 2 if it is more convenient 
for you.

2. Install the loader platform—
2a. Open the front safety shield and install the input tube loader 

platform onto the input Vibrator Motor 1 (Vib1) on the left side 
of the workspace. See Figure 2-12. 

2b. Tighten the two screws using a 9/64 inch hex key.

Rear tube guide Front tube 
guide

Tube elevator

Lanes

Pick location 
(staging area)
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Figure 2-12:  Vibrator motors Vib1, on the left, and Vib2, right. Arrows
point to screws for attaching tube platforms.

3. Adjust the tube guides on the input tube platform—
3a. Temporarily insert empty tubes in the first and last lanes of the 

input tube loader platform. See Figure 2-13.
3b. Adjust the tube guides so the tubes are attached to the platform 

snugly but are not compressed out of shape. 

Figure 2-13:  Adjust the front and rear tube guides with two empty
tubes installed. Platform mounting screws are circled. Tray mounts

(with thumb screws) need not be removed from the work surface.

3c. Remove the empty tubes from the input tube loader platform.

4. Adjust the output tube unloader platform tube guides as 
described in Step 3 above.

 Front & Rear 
Tube Guides

 Tubes
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Figure 2-14:  Output tube unloader platform.

5. Install output tube unloader platform—
5a. Install the output tube unloader platform onto the output Vibra-

tor Motor 2 (Vib2) on the right side of the workspace. Vibrator 
Motor 2 is shown in Figure 2-12.

5b. Tighten the two screws using a 9/64 inch hex key.

6. Insert tubes—
6a. Insert full tubes into the input tube loader platform. 
6b. Insert empty tubes into the output tube unloader platform. 
6c. Close the safety shield.

Note: Ensure that blank devices are loaded into the input tubes 
with the correct pin 1 orientation. If pin 1 orientation doesn’t 
match pin 1 on the sockets, the correct rotation much be taught in 
the Package file. 

Pin 1 on Data I/O sockets is almost always toward the far side of 
the adapter (the back of the PS Machine). Some BGAs and PLCCs 
are marked.

7.  Edit the winAH400.ini file for tube feeders—
7a. Using Windows Explorer, locate  C:\AH500\winAH400.ini 

and make a backup copy, for example, WinAH400backup.ini.
7b. Open the original file with Microsoft Notepad.
7c. Locate the line

TubeFeeder1=FALSE
and change to
TubeFeeder1=STDIN

7d. Locate the line
TubeFeeder2=FALSE
and change to
TubeFeeder2=STDOUT 

7e. Save the winAH400.ini file and exit Windows Explorer.

If you have previously 
used Tube Feeders you 
may already have saved 
a winAH400.ini file spe-
cifically for a Tube 
Feeder setup.

See the on-screen Help 
for more ini file infor-
mation.
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8. Adjust vibration controls—
8a. If devices do not travel freely in either tube, adjust the vibration 

using the Amplifier and Frequency controls on the front panel of 
the PS Machine.  

Remember  
 • The Setup Window > Options tab must be set to match the work-

space setup. This is covered in Chapter 3, Set Media and 
Options—the Setup Window. 

 • The Package File must be taught the Tube locations.

Setting Up the Tape Feeder Input
The PS System can be configured with an optional tape feeder for 
input media. The tape feeder is installed on the front of the 
PS Machine.

To install a Tape Feeder for input:

1. Preparation—
1a. At the monitor, stop any job that is running and exit the AH500 

Application.
1b. Remove the two screws holding the small safety shield that cov-

ers the tape input feeder slot at the front of the PS Machine.
 

Figure 2-15:  Two screws holding the small safety shield. [PS588
shown.]

On the Gantry Window, 
the Tube Feeders are rep-
resented by the yellow 
position labels that reads 
Vib1 and Vib2.

Tape input feeders are 
available in sizes to 
match common device 
tape widths. The last two 
digits of the tape input 
feeder part number indi-
cate the tape width.
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1c. Remove the small safety shield and set it aside with the screws. 
It is not used when the tape input feeder unit is installed.

2. Edit the winAH400.ini file for Tape Feeder Input—
2a. Using Windows Explorer, locate  C:\AH500\winAH400.ini 

and make a backup copy, for example, WinAH400backup.ini.
2b. Open the original file with Microsoft Notepad.

Locate the line
TapeAdvanceInstalled=FALSE
and change to
TapeAdvanceInstalled=TRUE

2c. Save the winAH400.ini file and exit Windows Explorer.

3. Mount the feeder unit—
3a. Align the rail on the bottom of the feeder with the channel on the 

PS Machine base plate.
3b. With the feeder in the channel, slide it toward the back. When 

the feeder reaches the spring latches, lift it over to the far side of 
the latches and push down to secure. 

If tape is already loaded on the feeder, ensure it gets started 
down the chute in the workspace. See Figure 2-16.

Figure 2-16:  The channel and spring clamps on the PS Machine.

Figure 2-17:  Push the mounting block of the Feeder into the spring
clamp.
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4. Connect cable—
4a. Insert the communication cable part way into the socket on the 

PS Machine and, while pushing lightly, rotate until the connec-
tor is oriented correclty—it will stop and even make a slight 
click sound.

4b. Push the rest of the way on. The Status lamp should light if the 
PS System is on.

4c. Install the device reel if it is not already. 

Note: For more information about loading a reel of devices onto the 
feeder, see the documentation that came with your tape feeder.

Figure 2-18:  The Tape-Input cable is plugged into the front of the
PS Machine. (PS288 shown.)

5. Thread the carrier tape through the feeder.

Note: For more information about threading carrier tape, see the 
documentation that came with your tape feeder.

5a. Pull the carrier tape forward to start it into the carrier waste tape 
chute. See Figure 2-18. 

The empty device carrier tape will come out of the slot below the 
mounting latch. Place a box on the floor to contain empty carrier 
tape.

6. Thread cover tape through the tape window and onto the 
feeder’s cover tape roller.

To remove the Tape 
Feeder communication 
cable, grasp the collar 
and pull out.

Carrier tape 
waste chute on 
the PS Machine.
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Note: For more information about threading cover tape, see the 
documentation that came with your tape feeder.

7. Adjust pitch—
7a. Count the number of sprocket holes in the carrier tape between 

the center of one pocket and the center of the next pocket.
7b. On the feeder control panel, set the pitch index to the number of 

guide holes. For example, if there are four guide holes from 
pocket center to pocket center, enter 4 in the pitch index. Use the 
[-] and [+] buttons to lower or raise the pitch index. See Figure 
2-19.

Figure 2-19:  Setting the Tape Feeder pitch index.

8. Align the pick point—
8a. Close all safety shields and release E-Stop buttons.
8b. Start the AH500 Software via TaskLink. 
8c. On the Gantry Window, press Park.
8d. Advance the carrier tape (holding down the center button while 

pushing the Forward button) until the pick point mark on the 
tape window aligns with the center of a pocket.

8e. Release the center button. Press the forward button once to 
index the device tape forward one pocket.

Before running a job with the tape input feeder in place, it is neces-
sary to: 
 • Teach locations to the PNP head. For information, see Teaching 

the Package File on page 3-40.
 • Select tape input setting in the AH500 software. For information, 

see (Optional) Preselecting Programmers on page 3-13.

Setting Up the Tape Output System 
The PS System can be configured with an optional tape output 
system. 

Lower pitch index

Raise pitch index

Pitch index display

Remember to remove 
cover tape from the 
cover tape reel when 
full. For more informa-
tion, see your Tape 
Feeder documentation.
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The tape output system receives programmed devices from the 
PS System via a second PNP head on the output frame. With this 
head, the Tape Output System places devices into empty carrier tape 
pockets, advances the carrier tape through a mechanism that seals the 
tape (using heat or pressure), and rolls the filled tape onto a reel for 
delivery to the next stage in the manufacturing process.

Figure 2-20:  Tape Output System.

Note:  For additional information, refer to the TM-50 SMD Taping 
Module User’s Guide that came with your Tape Output System. 

CAUTION:  Excessive Heat. Improper routing of the device tape 
may cause enough heat to melt the tape. Ensure the correct rout-
ing path is followed. See the TM-50 SMD Taping Module User’s 
Guide.

Note: The Tape Out System includes the Option Bay, the shuttle 
transfer, and the Tape-Out-PNP head. These must already be 
installed on the PS Machine before following the setup instructions 
below. If it is not, contact Data I/O Customer Support or a local 
Data I/O approved service representative. 

To set up the Tape Output System:

1. Edit the winAH400.ini file for Tape Output—
1a. Using Windows Explorer, locate  C:\AH500\winAH400.ini 

and make a backup copy, for example, WinAH400backup.ini.
1b. Open the original file with Microsoft Notepad.
1c. Locate the line:

TapeOutPutInstalled=FALSE

and change it to True:
TapeOutputInstalled=TRUE

1d. Save the winAH400.ini file and exit Windows Explorer.

2. Preparation—

The information that 
follows is adapted from 
the TM-50 SMD Tap-
ing Module User’s 
Guide that came with 
your Tape Output Sys-
tem.

If you have previously 
used Tape Output, you 
may already have saved 
a winAH400.ini file spe-
cifically for a Tape Out-
put setup.

For more ini file infor-
mation, see the 
on-screen Help.
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2a. The Tape Output System gets power and compressed air from 
the PS System. Ensure the PS System air is connected and power 
is On.

2b. Switch the Tape Output System ON by pulling out its 
Power/E-stop  button.

2c. Turn the take-up reel tension adjust knob counterclockwise to 
zero. (Black knob on the controller.)

2d. Set the taping job parameters at the controller. For more infor-
mation see the TM-50 SMD Taping Module User’s Guide, chap-
ter 3, Controller.

3. Pull the nearest half of the track (table) out to the desired track 
width. It stops at detents set to specific tape widths.

4. Mount the carrier tape reel—
4a. Remove the carrier tape quick lock from the carrier tape spindle.

Figure 2-21:  Removing the spindle QuickLock.

4b. Mount the bulk carrier tape reel on the right spindle so the tape 
unwinds from the top. 

4c. Replace the quick lock.
4d. Trim the end of the carrier tape so it is clean and straight.

5. Route the carrier tape—
5a. Guide the carrier tape into the loading track. It should feed right 

to left through the loading track easily. 

Note: Lowering the feed reel support arm can reduce drag if the 
angle at which the carrier enters the loading track is too steep.

5b. Bring the end of the carrier tape past the sealer and engage the 
sprocket holes on the teeth of the drive sprocket. 

If the carrier tape does not feed to the sprocket easily, see the 
TM-50 SMD Taping Module User’s Guide, Chapter 4, Setup, 
Route the Carrier Tape for items to check.

6. Mount the cover tape—
6a. Place a reel of cover tape of the correct width to match the carrier 

tape on the cover tape spindle. The tape should unwind to the 
right from the bottom of the reel.

For more information 
about these steps, see the 
TM-50 SMD Taping 
Module User’s Guide.
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6b. Set the width of the cover tape guide assembly for your size 
tape. 

6c. Use the Cover Tape Position Adjuster if needed. Turning it clock-
wise moves the cover tape position toward the sprocket side of 
the tape.

6d. Using blue tabbing tape, attach the cover tape to the carrier tape. 
Thread both through the cover tape Guide Sealer Assembly. Run 
the machine to advance the carrier and cover tapes through the 
sealer.

Prepare the Seal Method
For heat seal, complete Step 1 below.
For pressure seal (PSA), complete Step 2 below.

1. To prepare the heat seal—
1a. Turn the heat seal toggle switch ON.

Note: Disable the pressure seal by loosening the seal roller pressure 
screws until the seal rollers are no longer in contact with the cover 
tape.

1b. Set the temperature controls to the appropriate temperature.  See 
the table below.

Figure 2-22:  Tape Output suggested temperature and pressure
settings. The temperature of each shoe can be increased or decreased

according the results of a peel force test.

1c. Adjust the heat shoe air pressure to the appropriate setting. This 
setting controls the amount of force applied when the sealer 
shoes drop. 

Note: The recommended starting point for heat shoe air pressure is 
50 PSI. Turning the heat shoe adjuster clockwise increases the pres-
sure. 

1d. After the heat sealer reaches operating temperature, set the con-
troller parameters, if not already set. 

Heat Seal only

Carrier Tape Type Cover Tape Type Temperature Air Pressure Dwell Time 

3m Type 3000 
Conductive Carrier 3m Type 2675 Static 

Dissipative Cover

135-155°C 40-60 PSI 250-400 ms

3m Type 2701/2703 
Non-conductive

Advantek Conductive Advantek Type AA

Advantek 
Non-conductive

 Advantek Type S 
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Note:  For additional information, refer to the TM-50 SMD Taping 
Module User’s Guide, Chapter 3, Controller.

1e. Set the Controller to RUN mode.
1f. Advance the tape using the foot switch.
1g. Check the sealed tape for the desired sealed position.
1h. If necessary, adjust the inner seal position by turning the inner 

seal adjuster (thumb wheel) clockwise (to move the seal away 
from the operator) or counterclockwise. Tighten the position 
lock to secure it.

1i. If necessary, adjust the outer seal position by turning the outer 
seal adjuster (thumb wheel) clockwise to move the seal toward 
the operator or counterclockwise (to move the seal away from 
the operator). Lock the adjuster into place using the position 
lock knob.

2. To prepare the pressure seal—

Note: If the heat sealer is On, turn it OFF.

2a. Set the controller for Pressure Sensitive Adhesive (PSA) opera-
tion. Refer to the Chapter 3, Controller of the TM-50 SMD Taping 
Module User’s Guide. Then set the controller to RUN mode.

Note: When RUN is selected, the controller is ready to operate. The 
parameters which have been entered are displayed on the screen 
along with the running devices count. The controller will begin to 
advance and seal tape when the foot switch is pressed.

2b. Advance the tape using the foot switch.
2c. Adjust the inner and outer seal roller position. Align the roller 

position over the strip of adhesive on either side of the PSA 
cover tape. Both thumb screws have locking devices.

2d. Adjust the pressure at both sealer wheels to free spinning and 
then 1/8 revolution tighter. Use a 2 mm hex key. 

2e. Advance the tape using the foot switch. Re-adjust the seal roller 
pressure until the PSA adhesive is firmly adhered to the carrier 
tape.

Note: Excessive roller pressure may cause carrier tape advance 
problems or elongation of sprocket holes in the carrier tape.

Checks to Perform Prior to Running 
1. Mount an empty take-up reel on the spindle.

2. Perform a Peel Force Test
Perform as many peel force tests as needed while adjusting the 
sealer controls to obtain the required seal strength.

Pressure Seal
only
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3. Create the Trailer and Leader
Before beginning a production reel, determine how long the 
trailer and the leader should be. Run out enough sealed empty 
pockets to make the trailer that is required for the current job.

4. Check Carrier Tape Alignment
To ensure an accurate count, select a spot on the loading track as 
a reference point for the first and last devices counted. 

5. Set the Counter
Set the counter STOP value in the controller menu to zero. 

Note: Use the counter on the TM-50 if desired. However, we rec-
ommend setting this counter to zero and using the pass quantity on 
the PS System to monitor quantity.

Preparing the Tape-Output-PNP Head
It is necessary to accurately position the Tape-Output-PNP head over 
the carrier tape so that devices are placed properly. 

1. Adjust location of PNP head—
1a. On the PLC Controller:
 • Flip the Transfer toggle DOWN
 • Flip the Long Stroke toggle DOWN
 • Flip the Short Stroke toggle DOWN

Figure 2-23:  Toggle switches in DOWN position

1b. On the Tape Output Controller select 6 for Jog. This advances 
the carrier tape in 0.04 mm increments. 
Continue to press 6 for Jog until the center of the empty pocket 
is directly beneath the PNP head.

1c. On the PLC Controller, press the black reset button located on its 
left side.

Remember, when the 
reel is being taped on 
the TM-50, the trailer is 
the first length of empty 
carrier tape run before 
the first device is taped, 
and the leader is the 
length of empty carrier 
tape run after the last 
device is taped.
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Figure 2-24:  The Reset button on the PLC Controller.

1d. On the front of the controller, flip all toggles UP. 

Figure 2-25:  Toggle switches should be in UP (normal) position

1e. On the Tape Output Controller, press ESC to enter RUN mode.

The Tape Output System is now ready for programmed devices.

Placing Devices
Devices are placed by the Tape-Out-PNP head when your PS job is 
run. 

Ending a Taped Run
When all components have been taped or the batch size has been 
reached, perform the following:
1. Reset the counter to zero and run out the amount of empty car-

rier tape needed to make the leader.  
2. Cut the carrier tape and cover tape. 

Replacing a Full Take Up Reel
1. Leave job-specified number of empty pockets on the carrier tape.
2. Cut the carrier tape.
3. Roll carrier tape onto take up reel and remove reel.
4. Install empty take up reel.
5. Continue job.
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Set Up for Camera Contrast
If you are programming light colored devices, such as white, silver or 
beige, then it may be necessary to flip over the Vision Background 
Plate. The Vision Background Plate is located on the Data I/O J-Head 
only. One side is white and one side is black. Since most devices are 
black, the plate is installed from the factory with the white side down.

To flip the Vision Background Plate over:
1. If the PS Machine power is On, send the head to the Park posi-

tion and then push the E-Stop.

If not, Push the E-Stop and move the head by hand to a location 
with easy access.

2. Locate the plate at the bottom of the PNP head. 

Figure 2-26:  The Head Vision Background Plate (arrow) can be
reversed for better vision contrast with light colored devices. This view

is from the back, right side of the J-Head.

3. Remove four SHCS with a 1.5 mm hex key. 
4. If the head has a Socket Opener mounted on  it:
4a. Turn off the main air supply at the Power Panel.
4b. Pull the Socket Opener down, away from the probe tip.
5. Carefully remove the plate and turn it upside down. 
6. Reinstall.
7. Close all Safety Shields, reset the E-Stop, and switch the main air 

back on  as applicable.
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Setting Up the Laser Marking 
System

The PS System that is ordered with a Laser Marking System requires 
no additional set up at a customer’s site. All software is installed and 
all mechanical connections are complete—the laser marking system is 
ready to use.

Your job file, created in TaskLink, determines whether or not devices 
get marked. 

Note: To use the laser marking system, a laser marking file must 
first be created and added to a job file. For more information, see 
(Optional) Creating a Laser Marking File on page 3-62.

If, for some reason, your winAH400.ini file requires changes, you can 
set up the Laser Marking System as follows:

1. Edit the winAH400.ini file for Laser Marking—
1a. Using Windows Explorer, locate  C:\AH500\winAH400.ini 

and make a backup copy, for example, WinAH400backup.ini.
1b. Open the original file with Microsoft Notepad. 

Locate the heading:
;------- Marking System Selection -----

1c. There is a list of marking system names. Remove the semicolon 
from the Laser System corresponding to the one installed on 
your PS System.  Only one line should be without a semicolon.
;Markersystem=NONE
;Markersystem=LASERMARK
;Markersystem=SYNRAD
Markersystem=SYNRAD_DIGITAL
;Markersystem=ROFIN_SINAR

1d. Locate the heading:
;----- Laser System Definitions & Options ------

and set this line as follows;

for PS Models whose option bay has its own computer (and con-
nects to the PS with a serial cable) set
LaserRemoteConnection=TRUE

for PS Models whose option bay does NOT have its own com-
puter (and connects to the PS with a USB connection) set
LaserRemoteConnection=ETHERNET 139.138.240.31

1e. Save the winAH400.ini file and exit Windows Explorer.

If you have previously 
used a Marking System, 
you may already have 
saved a winAH400.ini 
file (with a modified 
name) specifically for 
that marking system 
setup.

For more ini file infor-
mation, see the 
on-screen Help.



Setup  ■  Setting Up the Label Printing System

2—28 Data I/O • 981-0424-002

back

Note: If you have other options such as a remote laser system or 
Serialization, contact Data I/O Customer Support or a local 
Data I/O approved service representative.

Setting Up the Label Printing 
System

If your PS System has the optional Label Printing System, it was 
installed by Data I/O. If you need to remove, repair, or reinstall your 
Label Printer, refer to the Label Printer Owner’s Manual that came 
with your PS System.  For questions and service contact Data I/O 
Customer Support or a local Data I/O approved service representa-
tive. 
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3Operation
Two primary levels of operation of the PS288, PS388, PS588 
(PS System) are • Operator functions, and • Administrator 
functions.

Operators generally follow this sequence to process devices:

Figure 3-1: Operator Functions (begin on the next page).

Administrators generally follow this sequence to create jobs: 

Figure 3-2:  Administrator Functions (begin on page 3-31).
Shaded boxes are activities that are performed once per package type

(except possibly for very small devices).

Start TaskLink  Select Task and 
Load Job  Set PS media 

and options

 Install media 
and options  Run Job on 

PS System

(Optional)
Create PS Sys-
tem security pro-
files

 Create a Task
in TaskLink 

(Optional)
Test First 
Article


Teach the Ref-
erence Vision 
File, page 3-34


Teach the Pack-
age File, page 
3-40


(Optional) 
Monitor statis-
tics

Check green rectangle locations:

•Quick Vision File Test (Page 39)
•(Optional) recommended check 
(Page 41)
•Setting Input Media Rotation 
(Page 42) It’s a master page 
border.
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Operator Functions
Operator functions include setting up hardware, turning on the 
PS System, starting TaskLink, loading a job, and running a job. 

Requirements prior to running a job on the PS Machine:
 • You have a Task for your target device. This is generally an 

administrator function. Refer to Creating a Task in TaskLink on 
page 3-31.

 • All assemblies needed for the target job, such as the Automatic 
Tray Feeder, a Marking System and the Tape Output System, are 
installed (or ready to be installed) on the PS System and ready. 
See Chapter 2- Set Up.

Operators, please read Safety Symbols on page viii of the Preface and 
Precautions for Safe Operation on page 1-23, (if you have not already). 
You should generally be familiar with the PS System as described in 
Chapter 1.

Running a Job on PS Systems

List of Steps to Run a Job
Operator functions appear in chronological order as follows:
1. Check the System on page 3-2
2. Installing Socket Adapters – FlashCORE on page 3-3
3. (Optional) [PS588 only] Installing Socket Adapters – OPTIMA on 

page 3-6
4. Installing the Correct Probe Tip on page 3-7
5. Turning System Power On on page 3-10
6. Starting AH500 via TaskLink (Selecting a Job) on page 3-10
7. (Optional) Preselecting Programmers on page 3-13
8. Adjust Socket Opener Ribs on page 3-14 if you’ve changed Socket 

Adapters.
9. Adjust Two Items After Changing Socket Adapters on page 3-15 for 

special adapters only
10. Set Media and Options—the Setup Window on page 3-16
11. Install Media and Options—the Workspace on page 3-20
12. Start Programming on page 3-21
13. Stopping the System on page 3-22
14. Light Tower Interpretation on page 3-25
15. (Optional) Changing Programmer Status on page 3-25
16. Turning Off System Power on page 3-27
17. (Optional) Operating the TF20 Automatic Tray Feeder on page 3-29

Check the System 
Before you set up for your job, check that:
 • All side panels are closed and no one is working on the machine.

PS Machines must be 
level and at room tem-
perature before running 
a job.
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 • The external air line is connected. 
 • If the air pressure switch is ON, the pressure indicator number is 

green.
 • If the power is ON, the PNP head is stopped in the Park position. 

Installing Socket Adapters – FlashCORE
Socket Adapters can be installed before or after the AH500 Software 
has been started. Note that after installing different Socket Adapters, 
there are generally three items to adjust: adjusting the socket opener 
ribs, adjusting the actuator air pressure, and adjusting the socket 
actuator sensors on the air cylinder if necessary. 

To install or change a Socket Adapter on a FlashCORE programmer:

Note:  To find the correct Socket Adapter part number for your 
device/job, 1) Open TaskLink, 2) Select your target job, 3) Click 
Edit then Footnotes.

1. If a job is running, click Finish on the Run Window and wait for 
the PNP head to empty the sockets, move to the Park position 
and stop.

2. Open the safety shield that offers the easiest access to the target 
programmer(s).

CAUTION:  Electrostatic discharge (ESD) hazard. To prevent 
damage to Socket Adapters and devices from ESD, always wear 
an antistatic wrist strap. 

The wrist strap should be connected to the grounding socket on 
the front of the PS Machine and should contain a 1 M-ohm to 
10 M-ohm current limiting resistor. 

3.  [PS588 FlashCORE only]  Remove the Actuator Plate— 
3a. [Standard sockets only] Type-A (see Figure 3-3): Slide the plate 

toward the front of the PS Machine until the notches on the plate 
align with the cutouts on the Actuation Bracket. Then lift the 
actuator plate up. 

Type-B: Slide the plate out toward the front of the PS Machine.

A job can be continued 
later even after clicking 
Finish.
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Figure 3-3:  [PS588 FlashCORE only] Actuator Plates for Standard
Sockets. Align Actuator Plate Type-A notches with the Actuation

Bracket notches, and then lift up to remove.

3b. [HIC Adapters only] Slide the plate out toward the front of the 
PS Machine. See the figure below.

Figure 3-4:  Special Actuation Plate for HIC Adapters.

4. Remove the Socket Adapter—
4a. Unscrew the two captive, SHCS with a 4 mm hex key and open 

the Adapter Bracket.

Type-B       Type-A
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Figure 3-5:  Removing the Socket Adapter from the programmer.
(PS388 shown.)

4b. Lift the Socket Adapter up off the dowel pins.

Note:  Do not touch the gold contact surfaces on the bottom of the 
Socket Adapter.

5. Install the Socket Adapter—
5a. Insert the correct Socket Adapter for your target device, making 

sure that it seats on the dowel pins.
5b. Screw in the two screws. 

6. [PS588 FlashCORE only] Install the correct Actuator Plate—
6a. Type-A (see Figure 3-3): Install the Actuator Plate by setting it 

into the notches on the bracket and sliding back until it snaps 
into place.

Type-B: Reinstall the Actuator Plate by placing it into the slot 
and sliding it back until it snaps into place.

7. [HIC Socket Adapters only on PS388] Install the correct Socket 
Opener for the HIC adapter onto the PNP head.

Figure 3-6:  [PS388] Most HIC openers have a radius on the contact
area. Each HIC Socket Adapter may have a its own opener plate.

Matching Socket Adapter part names are on the ends of the opener
plate (not shown here).

Installing the Socket 
Adapters and Actuator 
Plates can be done later, 
after setting media 
options in the SETUP Win-
dow.
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CAUTION:  Collision hazard on PS388. HIC Socket Openers can hit 
some standard Socket Adapters. Remove standard Socket 
Adapters from all programmers before using HIC Openers.

CAUTION:  Collision hazard. On PS288 and PS388, the Socket 
Opener can possibly hit some Socket Adapters with large clamp-
ing arms such as the G491. After installing a Socket Opener, 
always check clearance at all the Socket Adapters. 

8. [PS288, PS388] Adjust the Socket Opener Ribs prior to opera-
tion. See Adjust Socket Opener Ribs on page 3-14.

To restart the same job, click Run in the Run Window. 

If starting a new job, at the Run Window, click Exit, click Exit again at 
the Setup Window, and Exit again to quit the AH500 software. Then in 
TaskLink’s Task Manager dialog. select the desired job and click Run. 
Follow the on-screen instructions.

Note:   If starting a job that uses Tape Output, pull the red 
E-Stop/On  button on the taping machine to start it.

Installing Socket Adapters – OPTIMA
To change a Socket Adapter on an OPTIMA/Universal Programmer:

Each TOP (Socket Adapter) is connected to Universal programmer 
base connectors which are attached to the work surface of the PS588.
1. If a job is running, click Finish on the Run window and wait for 

the PNP head to empty the sockets and move to the park posi-
tion.

2. Remove the existing Socket Adapter by holding the sides of the 
case and gently rocking and lifting.
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Figure 3-7:  Align Socket Adapter and programmer base connectors

3. Holding the new Socket Adapter above the base, align the pins 
with the base connector and press down.

4. Adjust the Socket Opener ribs to fit the new sockets. See Adjust 
Socket Opener Ribs on page 3-14.

Installing the Correct Probe Tip
Different sized devices require a different size probe tip. Install the 
recommended tip onto the probe for your type of PNP head as shown 
below. 

If the AH500 Software is already started, open the Gantry window 
(Start  Setup Window > System > Gantry) and click the Tool label to 
move the PNP head to a spot where it is accessible. It is okay to move 
the probe/opener down in this position without affecting the set 
travel height.

Figure 3-8:  The Tool position in the Gantry window allow easy access to
the probe tips. The Tool position can also be set by the customer.
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Intellepro Head (std on machines prior to March 2009)*
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

Data I/O ‘J-Head’ (std on machines March 2009 and later)*

If processing this 
device type:

 Breakaway Tip (or stem)/ Nozzle/ Cup or Tip
               (Data I/O Part Numbers)

 probe tip 
size

FBGA
 μBGA

288-0100-001 288-2500-001   288-0017-001

641-0110-001 288-2500-001  288-0017-001

2 mm cup

300 mil DIP
20 PLCC
32 TSOP

288-0100-001 288-2500-001   288-0018-001

641-0110-001 288-2500-001  288-0018-001

4 mm cup

28 PLCC or greater
40 TSOP or greater
QFP
600 mil DIP 288-0100-001 288-2500-001   288-1000-001

641-0110-001 288-2500-001  288-1000-001

6 mm cup

Small devices such 
as QFN20

288-0100-001 638-0007-001   288-0020-001

641-0110-001 638-0007-001  288-0020-001

3.05 mm tip

Small devices such 
as QFN40

288-0100-001 638-0007-001   288-0019-001

641-0110-001 638-0007-001  288-0019-001

4.57 mm tip

* What PNP head do I have? See Figure 1-3 on page 1–11.
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The Breakaway Stem on the J-Head 
The Breakaway Stem for the Data I/O J-Head has a set screw for 
attaching it. It requires a 1.5 mm hex key. Ensure that the O-ring on 
the head doesn’t get damaged when installing the stem. The flats on 
the stem accept a 5 mm wrench.

Installing the Correct Shuttle Cups
On systems with Laser Marking or Tape Output, the shuttle cup (and 
o-ring) must match the device size for proper suction. Devices with 
flat bottoms such as qfp, tsop, and ssop require shuttle cups with 
o-ring diameters smaller than the shortest edge of the device. BGA 
devices most likely use shuttle cup part numbers 615-0070-001, 
615-0063-001 or 615-0067-001. Occasionally, balls on BGA devices will 
be on the inside the o-ring and some outside it. Refer to Figure 3-9 
below.

To remove and install shuttle cups:

1. Preparation—
1a. Shut off the PS System power and ensure the main power switch 

is in the OFF position.

2. Access the shuttles—
2a. Open the nearest safety shield, or remove the laser shuttle cover 

as necessary (1/8 inch Hex Key).

3. Replace the shuttles—
3a. Unscrew the two knurled shuttle cups by hand.
3b. Screw in the appropriate sized shuttle cup for your device. See 

the chart below.
3c. Replace the laser shuttle cover, if applicable.

Hint: Select a shuttle 
cup size that will work 
with the largest selec-
tion of your frequent 
target devices.



Operation  ■  Operator Functions

3—10 Data I/O • 981-0424-002

back

Figure 3-9:  O-ring ID and OD dimensions and Part Numbers are shown.

Turning System Power On
Before you turn on power, check that:
 • All safety shields are closed.
 • The external air line is connected, the air pressure switch is in 

the ON position, and the pressure indicator number is green.

Turn the power on at the back of the machine by rotating the large 
switch to the ON position.

Note:  Turning power on does not start the PS Application Soft-
ware (AH500). Although the AH500 icon on the monitor can be 
double-clicked, the best way to start the application is by first start-
ing TaskLink. See the heading below.

Starting AH500 via TaskLink (Selecting a Job)
TaskLink automatically starts AH500 Application Software when  
Run is clicked. TaskLink is Data I/O’s software for creating program-
ming jobs by guiding customers through selection of data file, and 
programming parameters and processes.
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To select a job and start AH500:
1. On the monitor, double-click the TaskLink icon.

Figure 3-10:  TaskLink icon

2. Open the Task Manager Dialog, select your target Task from the 
list and click Run.

.

Figure 3-11:  Select a Task and click Run to run a job on the PS
Machine.

3. A Footnotes Dialog displays. Note the Socket Adapter and 
Actuator Plate part numbers required. Click OK to close the dia-
log.

4. (Optional) Enter the number of devices to be processed in the 
Pass Limit field (0 is the default for an unlimited number of 
devices). Enter a description. 

5. Click OK.
. 

Figure 3-12:  Both a pass limit and a description are optional.

For devices supported by 
Universal programmers, 
the Footnotes dialog dis-
plays a Universal Top and 
a FlashTop Top required.
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.

Figure 3-13:  TaskLink displays job transfer progress.

6. When job setup is complete, TaskLink displays the calculated 
checksum and confirms launching the AH500 software if Dis-
play Checksum option is checked in TaskLink. Click Yes.

.

Figure 3-14:  Click Yes to launch AH500 Software (if message displays).

7. On the AH500 main window under Current Job, the name of the 
job just loaded is displayed.
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.

Figure 3-15:  The AH500 main window opens with a job loaded and its
name displayed (arrow).  (PS588 shown.)

(Optional) Preselecting Programmers  
The PS288 & PS388 can be configured with up to four FlashCORE 
programmers. The PS588 can be configured with up to 12 program-
mers, which can be a mix of FlashCORE and Universal OPTIMA pro-
grammers. 

To improve efficiency, shut off programmers that are not used for a 
particular job as follows:
1. On the AH500-PS System main window, click Preselect Program-

mers. Refer to Figure 3-15.
2. Click I (green side) of the Unlock Cnf button to allow changes.
3. For each programmer, click I (green side) of the button to enable 

it or the O (red side) to disable it. See Figure 3-16. 

Note:  If a programmer does not have a Socket Adapter, or an incor-
rect Socket Adapter is installed, the programmer will automatically 
be disabled.
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Figure 3-16:  Preselecting programmers. In this image, programmers 1
and 2, are disabled. (PS588 shown.)

4. Lock the configuration again only if you wish to keep this setting 
the next time the system is turned on: click the O (red) side of the 
Lock Cnf button

Adjust Socket Opener Ribs
[PS288, PS388, and Optima on PS588 only]

1. Adjust the Socket Opener Ribs—

Note:   It is necessary to adjust the Socket Opener after installing 
different Socket Adapters. 

1a. On the Power Panel, turn the main air valve OFF. (It is off when 
the lock rings line up: some models.)
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Figure 3-17:  Main air valve on the back of the machine.

1b. By hand, adjust the Socket Opener so that the ribs open the 
socket as the probe descends and so the opener does not inter-
fere with the device as it is picked up by the probe.

Figure 3-18:  Adjusting the Socket Opener on PS288 and PS588
Optima. (Optima programmer shown.)

1c. On the Power Panel, turn the main air valve ON.

Adjust Two Items After Changing Socket Adapters

Adjust the Socket Actuatro Air Pressure
[PS288 & PS388 only when switching between special Socket 
Adapters] 

CAUTION:  Possible damage to Socket Adapters. If the actuation 
air pressure is incorrect, Socket Adapters might get damaged, or 
throughput could suffer.

Ribs

Socket
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If you run a job witch requires a change between a HIC Socket 
Adapter and a Standard Socket Adapter, or vise-versa, then THE 
ACTUATOR AIR PRESSURE MUST BE CHANGED. See Adjusting 
the Socket Actuator Air Pressure on page 4-8.

Adjust the Socket Actuator Sensors
[PS288, PS388 and Optima Programmers only on PS588] 
Check the stroke to ensure the socket is opening and closing com-
pletely. If not see Adjusting the Socket Actuator Sensors on page 4-5.

Set Media and Options—the Setup Window

1. Configuring—
1a. On the AH500-PS System main window, click Start.
1b. On the Options tab of the Setup Window, select the desired Input, 

Output, and Reject media. Refer to Figure 3-20.
1c. If marking is On, and vision is On, and you need better place-

ment accuracy, check the box Moving To Shuttle: the probe will go 
to the camera before going to the shuttle. See upper left corner of 
Figure 3-19. 

1d. [Tube Input/Output only] Optional: When the box 1st + last 
2/tube  item is checked, the Vision System checks only the first 
and last devices in a Tube. Use this with the Vision System toggle 
Off.

If you want the Vision System to check every device, set Vision 
System to ON (and uncheck 1st + last 2/tube.) Refer to the fig-
ure below.

For all of step 1, refer 
to Figure 3-20 on page 
3–18.
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Figure 3-19:  Tube Input and Output are selected here. (Vibrator
input/output are Tubes.) Common setups will not display all the

optional features shown here. The left image shows the ICOS
inspection System settings.

1e. [Laser Marking System only] Turn the Laser Marker On (green) 
or Off (red).

1f. [Label Marking only] Turn the Labeling toggle On (green) or Off 
(red).

1g. [If the ICOS Inspection System is installed] the settings will 
appear as shown in the image on the left side of Figure 3-19 
above. It can be turned On or Off with the toggle switch. The 
Comp-ID number defines the inspection job and is read from the 
PS System Package file. The two check boxes below it allow 
selecting when to inspect the devices. Both can be selected.
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Figure 3-20:  The SETUP Window requires input, output, and reject
selections (boxed here) on the Options tab. Only options set in the

WinAH400.ini file will display. Common setups will not display all the
optional features shown here.

Enhanced Yield Programming
1h. (Optional) In the Continuity Retries field, enter the number of 

times the system should retry continuity failures before rejecting 
the device.

1i. (Optional) In the Fail Retries field, enter the number of times the 
system should retry programming failures (excluding over-cur-
rent and continuity) before rejecting the device.

1j. [Automotive Performance Pak only] Optional: Start any of the 
five utilities available with the AP Pak. 

1k.  If Ignore Programmers is On (green), the PNP head will not stop 
at the programmers and will effectively transfer devices from 
input media to output media with no programming, and with or 
without laser marking. The default is Off.

Note:  Only installed options are available for selection on the 
Options tab.  If different input media (tube, tape, or tray) is desired, 

For more information on 
the AP Pak, see the AH500 
online Help. 
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the winAH400.ini file may need to be edited. See the online Help for 
instructions editing the WinAH400.int file or contact Data I/O 
support or an authorized technician.

2. Verifying—
2a. At the Setup Window, click the Job Info tab.
2b. Verify that all the information displayed for this job is accurate. 

See Figure 3-21 below.

Figure 3-21:  The Job Info Tab is a read-only review of information, with
the exception of the Pass Limit field, which is editable.

3. (Optional) Change the Pass Limit —
3a. On the Job Info tab, click the in Pass Limit field and enter the new 

Pass Limit value and click OK. 



Operation  ■  Operator Functions

3—20 Data I/O • 981-0424-002

back

Figure 3-22:  The Keyboard dialog opens after clicking in the Pass Limit
field. The  <<<<  button erases the right-most digit. Exit cancels any

changes.

Install  Media and Options—the Workspace

CAUTION:  Electrostatic discharge (ESD) hazard. Wear an ESD 
strap or discharge static against a common ground to prevent 
damage to Socket Adapters and devices.

CAUTION:  Safety hazard. Always make sure that the PNP head 
is stopped in the Park position before opening any access doors.

Regardless of input media used (trays, tape, or tubes), all devices 
should be installed right-side-up (live bug orientation), with the 
device leads pointing down and identifying marks visible on the top 
of the device. 

1. Install hardware—
1a. If Socket Adapters have not yet been installed for the job on all 

programmers to be used, do it now. See Installing Socket Adapters 
– FlashCORE on page 3-3 or Installing Socket Adapters – OPTIMA 
on page 3-6.

Note:  If you have already started AH500 and do not know the cor-
rect Socket Adapter Part Number for your device, you can find it 
two ways without having to exit AH500: A— On our Web site: 1) 
Click Support > Device > Search for Support, 2) Type your device 
PN into Device PN field, 3) Click Begin Search for Devices. See 
the PNs in the right, results column; and method B— If you 
already have a Vision or Package file and you’ve named it after the 
Socket Adapter, see the last two fields of the Setup > Job Info Win-
dow (refer Figure 3-21).

For instructions on how to 
set up input/output Media, 
see:
 • Static Tray, page 2-7
 • Automatic Tray Feeder, 
page 2-10
 • Tube, page 2-12
 • Tape Input, page 2-16
 • Tape Output, page 2-19.
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1b. Install the correct probe tip for your device if it has not yet been 
installed. See Installing the Correct Probe Tip on page 3-7.

1c. Install input and output media. (For more, see Chapter 2.) Pin 1 
on most Data I/O Socket Adapters is away from the operator 
(toward the back of the machine.)

CAUTION:  Possible socket and device damage. If the incorrect 
Package file was selected during Task creation, or if device rota-
tion was taught incorrectly, devices or socket contacts may get 
damaged.  If you have any doubts about the Package file, con-
tact your system administrator. 

1d. (Optional) Install marking or labeling options as desired.  (For 
more, see Chapter 2.)

2. (Optional) Set up for Sort-On-Error-Code—
2a. Install a second Reject Bin 50 mm (2 inches) to the right of 

Reject 1.

Start Programming
After setting up the machine hardware, input/output media and 
options, the job is ready to be run.
1. At the Setup Window, click Run. 
2. On the Run Window, click Run. 

Figure 3-23:  Run on the Run Window starts programming. (PS288
shown.)

3. A message appears announcing that Tray 1, Tray 2, and Fail Tray 
have been found. Click OK.

The PNP head begins its movements. The Run Window tracks  
head movement (white square), and displays device placement. 
Socket status indicators appear inside the programmer outlines. 

Your system adminis-
trator generally has 
information on pin 1 
orientation for tray 
and tape input as 
defined by your facil-
ity. 

For setting 
Sort-On-Error-Code in the 
winAH400.ini file, see the 
on-screen Help.

If a different device type 
is to be programmed, a 
different job must be 
selected in TaskLink.
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Note:   If the input/output media are tubes, tube vibration might 
need adjustment if devices do not move easily. Use the vibration 
controls on the front of the PS System to adjust tube vibration.

Stopping the System
There are three methods for stopping the PS System:
 • Emergency Stop— Stop the movement of the head immediately.
 • Pause a Job— Pause a job to stop the head at its next destination. 

Devices finish programming if started but are not removed from 
sockets. The programming session can be continued.

 • Finish a Job— Stop picking blank devices, finish the current 
programming cycle, and remove devices from all the sockets  
placing them into appropriate media. The programming job can 
be resumed.

Emergency Stop
To prevent bodily injury or damage to equipment in an emergency, 
press the red Emergency Stop (E-Stop) button located on the upper 
sides of the machine. Pressing an E-Stop button immediately stops 
motion of the PNP head and the gantry.

WARNING:   Electric shock and collision hazards. In an emergency, 
do not use the on-screen Pause button to turn off power. PRESS-
ING PAUSE DOES NOT REMOVE POWER to the system. In an 
emergency, press the Emergency-Stop button.

The Pause button has an 
image of a stop sign on 
it (red octagon).
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Figure 3-24:  Emergency Stop (E-Stop) buttons on the PS288 (not
shown) and PS388 (top). They are different from the PS588 (bottom).

To restart the system

1. Rotate the E-Stop button clockwise until it springs back to its full 
height. The monitor displays the message Check doors/E-stop! 

2. Click OK. The system resumes the interrupted operation.

Pausing a Job
To pause a job (stopping the Gantry) click Pause on the Run window. 
Devices being programming will finish programming. This is the pre-
ferred method of pausing the system in a non-emergency situation.

CAUTION:  Personal safety hazard. Do not open Safety Shields 
until all movement of the machine has stopped.

To resume, click Run. See Figure 3-25.

Far
Side

Far
Side
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Figure 3-25:  Click Pause to stop a job you wish to continue next. After
clicking Pause, the Tower Lamp changes to yellow. In this image,

Programmers 1 and 2 have programmed devices in them (green).
(PS588 shown.)

Note:  When restarting a job that uses Tape Output, pull the red 
E-Stop/On  button on the taping machine to start it.

To remove all devices that are currently in programmers:
Click Clear on the Run Window. All devices will be removed from the 
programming sockets and placed in the Reject Tray.

Ending a Job
To end a job prior to programming the preset number of devices, click 
Finish on the Run Window. This completes the current programming 
cycle. No more blank devices are picked from the input media, and 
all devices in the sockets are removed and placed in the appropriate 
output or Reject container. 

The job can be resumed by selecting it again in TaskLink and clicking 
Run. A message offers the choice to finish a previously terminated job 
or start from zero.
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Light Tower Interpretation
During operation of the PS System, you can monitor the light tower 
to reduce system down time. The light tower displays the following 
conditions:

Changing Programmer Status
The PS Machine may automatically disable a programmer for various 
reasons, for example, if there are repeated continuity errors or 
vacuum issues. The operator may also choose to disable a pro-
grammer, or otherwise change the status of a programmer.

Light Condition Action Required Possible Causes
PS Machine 

Status

Red Major 
error 

Operator intervention 
is mandatory to con-
tinue. 

It is likely that tools 
and troubleshooting 
skills will be required 
to resolve issues.

-Actuator error 
-Gantry collision 
-Input shutter error
-Insufficient air pressure;
-Laser not ready
-Motion Control System 
error
-Socket opener sensor error
-Software exception
-Vacuum sensor malfunc-
tion

Stopped

Yellow/
Red
(alternating)

Error Operator intervention 
is mandatory to con-
tinue.

Correction may be 
through Handler 
Computer software 
(AH500) or through 
minor hardware 
adjustment.

-File read/write error
-Labeler error
-Laser error
-No programmer can be 
used
-PNP error
-Serialization errors
-Setup related errors
-Tape input error
-Unprogrammed devices 
on Input/Pass tray

Stopped

Yellow Normal 
stop

Operator intervention 
is mandatory.

Output media is full or 
input media is empty. 

Stopped

Yellow/
Green 
(alternating)

Normal Operator intervention 
is suggested.

-End of job
-Some sockets are disabled 
-Vacuum errors are present 
on some programmers

Processing or 
Stopped (end 
of job)

Green Normal No operator action 
needed.

Processing devices, or 
clearing sockets to output.

Processing
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Disabling Programmers
If programmers are not performing and the error cannot be cleared, 
disable those programmers and continue to use the other sites to pro-
cess devices. 

To disable a programmer:
1. At the Run window, click Pause.
1a. Right-click on the target programmer and select All => DIS-

ABLED. All sockets on this programmer change to black and are 
disabled. See Figure 3-26. 

Note:  To disable a single socket, right-click the socket and select => 
DISABLED.  The socket changes to black and is disabled.

2. Resume job—
2a. To resume a job click Run.
2b. Manually remove any devices from the disabled sockets after 

the job finishes. 

Clearing a Programmer Disabled Status
If the status indicator on the Run Window disappears from any of the 
programmer outlines, or the PNP head skips a programmer, the pro-
grammer may be disabled. It may be possible to correct the problem 
by simply clearing the programmer disabled status using the fol-
lowing procedure.
1. At the Run window, click Pause.
1a. Right-click on the target programmer and select All => EMPTY. 

This DOES NOT CLEAR THE SOCKETS, only changes the sta-
tus.

CAUTION:   Unprogrammed devices can get placed into the PASS 
output. Since this does not clear the sockets, there is a possible risk 
of double-stacking devices in the sockets. Open the Safety Shield 
and manually remove any devices in the sockets on the target 
programmer with a suction tool.

All sockets on this programmer change to grey and are re-enabled. 
See Figure 3-26. 

An optional method of 
changing programmer 
and socket status is with 
the Programmer Inter-
face Window. (Setup 
Window > System > 
Programmers) See the 
on-screen Help for more 
information.
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Figure 3-26:  Right-click a programmer in the Run Window to change
the status of the programmer, empty the sockets, toggle the vacuum,

or perform various other functions. (PS588 shown.)

Note:  To re-enable a single socket, right-click the socket and select 
=> EMPTY.  The socket changes to grey and is re-enabled.

2. Resume the paused job—
2a. Manually remove any devices from sockets whose status you 

have enabled.
2b. To resume a job click Run.

After a Job Completes
After a job completes:
1. Wait for the PNP head to park.
2. (Optional) If Sort-On-Error-Code was employed, record the num-

ber of devices in Reject 1, (FailBox1).
3. Empty the Reject Bin(s).
4. Remove programmed devices.

Turning Off System Power
When the PS System will not be run overnight, or before performing 
a service procedure, turn off the power.
1. Finish or end the job if one is running.
2. Remove all devices from the workspace.

This right-click pro-
cedure allows 
changes to one 
socket or one pro-
grammer, while the 
Clear button on the 
Run Window clears 
all sockets on the all 
programmers in use.

Always Pause a job 
prior to opening a 
workspace access door.
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3. Exit the Laser Marker software (if open), and turn off the Laser 
Computer from the Windows Start menu (if this option is 
installed). Later PS models with Laser Markers may not have a 
Laser Computer.

4. Exit AH500 and TaskLink, and turn off power to the Handler 
Computer with the Windows Start menu.

5. Rotate the main power switch to the OFF (vertical) position (on 
the back Power Panel). 

6. (Optional) Padlock the main power switch so that it cannot be 
rotated back on while the lock is in place.
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Automatic Tray Feeder
There is an automatic Tray Feeder option available for the PS System. 
Chapter 2 discusses setting it up; operation is discussed here.

Operating the TF20 Automatic Tray Feeder 
[TF20 only]  As an option, the PS System can be configured with an 
Automatic Tray Feeder. Only basic operation of the TF20 Automatic 
Tray Feeder is described here. 

To start the TF20:
1. Plug the TF20 power cable and air line into the PS System. Refer 

to Figure 2-8 on page 2–11.

2. Manually initializing the Tray Feeder—
2a. After power up, four LEDs on the feeder operator interface light 

up. Initializing the feeder enables a choice between normal 
(Fast) mode and slow mode. 

To enable slow mode, momentarily press the INDEX 1 and INDEX 2 
buttons simultaneously. 

To enable normal mode, momentarily press the ELEV button. Once 
the speed is set in this way, the LEDs dim and the run mode will 
be maintained until the power to the feeder has been removed.

3. Verify that the Thick/Thin switch correctly matches the type of 
JEDEC trays used: thick trays or thin. 

Note:   If the Thick/Thin switch is set incorrectly, the feeding mech-
anism will jam and cause an error condition (blinking orange 
LED).

CAUTION:  Trays or devices might get damaged and the Tray 
Feeder might be difficult to restart if an orange LED error occurs 
and the feeder is not stopped immediately. Press the Stop button 
immediately if the orange LED illuminates.

 • If the blue LED (indicating Full or Empty) is illuminated and 
steady (not blinking), the lower input stack is out of trays. Open 
the tray access door and place one or more trays in the lower 
input stack. Close the door. The elevator automatically begins to 
move up to a normal run position.

 • If the blue LED is illuminated and blinking, the TF20 upper out-
put stack is full of trays. Remove the trays from the upper out-
put stack.

 • If the yellow LED is illuminated and not blinking (indicating an 
inhibit condition), the elevator access door might be open: close 
it.

Note:  The TF20 can be reloaded with trays at any time.

For detailed information, 
see the Tray Feeder 
Owner’s Manual that 
came with your 
PS System.
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Loading Trays when the Stack is Empty
When the last tray is moved to the pick/place position, the lower 
input stack is empty and the blue LED illuminates steady. The ele-
vator then drives down to its lower limit. It is best to reload the TF20 
at this time or earlier.

If you do not reload the TF20 and the PS System continues to operate, 
the last tray is returned to the upper output stack and the TF20 and 
the PS System automatically stop.

Loading Trays before the Stack is Empty

1. If the TF20 is not empty, press the Elevator Down button. The 
TF20 automatically goes to an inhibit mode, and the elevator 
begins driving down toward its lower limit.

2. Open the elevator access door and insert one or more trays.
3. Close the elevator door and the elevator begins moving up to a 

normal run position. Once the elevator has reached the normal 
run position, the TF20 starts automatically.

Unloading Trays
When the upper output stack reaches its maximum capacity, the TF20 
stops automatically and the blue LED begins blinking. Unload the 
TF20 at this time (earlier is okay). Once the trays have been removed, 
press the Inhibit button to resume normal operation. If you do not 
unload the TF20 it goes into idle mode.

If the blue LED is steady (not blinking), the upper output stack has 
room to accept more trays. If you wish to remove trays anyway, press 
the Inhibit button and wait until the yellow LED illuminates.

Note:   The inhibit mode prevents the TF20 from cycling a tray 
while you are removing trays.

The TF20 can be 
unloaded without inter-
ruption to the operation 
of the PS System. 

For more detailed infor-
mation, see the Tray 
Feeder Instruction Man-
ual that came with your 
system.
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Administrator Functions
Administrators are responsible for creating Tasks in TaskLink™ and 
other functions not performed by operators. Administrators would 
likely perform these functions:
 • Creating Security Profiles, below
 • Creating a Task in TaskLink, below
 • (Optional) Do a First Article Test on page 3-32
 • (Optional) Set TaskLink to Operator Mode on page 3-33
 • Teaching the Reference Vision File on page 3-34
 • Teaching the Package File on page 3-40
 • Get Movetimes/Optimize Movetimes on page 3-51
 • Monitoring Statistics on page 3-52
 • Maximizing Programming Yields on page 3-57
 • (Optional) Creating a Data File from a Master Device on page 3-58
 • (Optional) Creating a Label Printer File on page 3-60
 • (Optional) Creating a Laser Marking File on page 3-62
 • Automotive Performance Pak on page 3-69

These functions are discussed in this section.

Creating Security Profiles
The Security Dialog in AH500 manages user profiles to control secu-
rity by allowing different rights to be assigned to each profile. 

To create a new profile:
1. In the Security Dialog, use the drop-down arrow to select Super-

visor.
2. Enter the password.
3. Click Edit Users.
4. Type a name into the Name field.
5. Type a password into the Password field.
6. Check the box next to each stated right (privilege) for the new 

user. For example: if the new user is to create new Vision Files 
for jobs, check Teach Vision.

7. Click Save (the diskette image).

Creating a Task in TaskLink 
Task is the TaskLink term for a set of instructions to complete a pro-
gramming job. Tasks, which are stored in a Task database file (*.TSK), 
contain all the information necessary for programming and testing 
specific devices with a specific algorithm. Information contained in a 
Task includes:
 • Device settings - identifies a specific device (or family of devices 

to select from)
 • Data settings - Data file name

The Security Dialog 
opens above the SETUP 
Window after clicking 
Start on the AH500 
Startup Window.
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 • System settings - Package file name and Vision file name
 • Process settings - Continuity check, electronic ID check, blank 

check, erase, verify, program and device marking information.

For complete instructions on how to create a Task, see TaskLink’s 
online Help Topics. 

Files Selected in TaskLink
In addition to containing all device-specific settings, a Task references 
these files:

(Optional) Do a First Article Test
Prior to programming hundreds of devices, a newly created TaskLink 
Task is tested. Follow your company’s First Article Test Plan. 

Test Prior to Creating Vision and Package Files
Outlined below is a suggested test process using Data I/O’s desktop 
programmer called FlashPAK. This method allows testing without 
having to create a Reference Vision File or a Package File required for 
the PS Machine.

1. Create a new Job for FlashPAK—
1a. In TaskLink, set the Programming System to FlashPAK; System 

> Select Programming System > FlashPAK.
1b. Open Task Manager and create a new Task with the Add button.
1c. Create the Task as usual in the Edit dialog.

2. Test the new Job on FlashPAK—
2a. Using the Load button, send your new Task to a PC Card, or, if 

the FlashPAK is on a network, select it.
2b. Test the Task on the FlashPAK by programming a device and 

verifying the results. 

3. Duplicate the Job for your PS System—

File Information

Reference Vision 
File (*.vpp)

For instructions on creating a Reference Vision 
File, see Teaching the Reference Vision File on page 
3-34.

Package File (*.txt) For instructions on creating a Package File, see 
Teaching the Package File on page 3-40.

Data File (*.hex or 
*.bin, for example)

The data file contains your data to be pro-
grammed into the devices.

Laser Marking File This optional file resides on the Laser PC or Han-
dler PC depending on mode. See (Optional) Creat-
ing a Laser Marking File on page 3-62. 

Label Marking File 
(generally .bmp)

This optional file resides on the Handler com-
puter. See (Optional) Creating a Label Printer File on 
page 3-60.

Definition: A Task is a set 
of instructions for process-
ing devices. Once a Task 
is selected and a Pass 
Limit is set, the Task is 
referred to as a job to run 
on the PS System. The 
same Task can be used for 
many Jobs. 

For help with FlashPAK 
see the Operator’s Guide.
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3a. If the job passed the tests, in TaskLink Task Manager, select the 
Task and click Duplicate. Enter a name and click OK.

3b. Edit the Task so that it can be used on your PS System as follows: 
1) Select the Task, 2) Click Edit, 3) On the Task tab, use the Pro-
gramming System Type drop-down arrow to select PS Series 
FlashCORE, 4) On the Handler Files tab, select (or create) a Pack-
age file name and a Vision file name, 5) Click OK.

4. Run the duplicated Task on the PS System—

Note:  If you have the option selected to Automatically Switch Pro-
gramming Systems, (System > Options > Automatically Switch . . 
.) then you can skip the next step.

4a. Close Task Manager and change the programming system to 
PS System (System > Select Programming System). Re-open the 
Task Manager.

4b. Select the duplicated job and click Run.

Note:  The Vision File and Package File must be taught if they are 
new.

Test After Creating Vision and Package Files
After a Reference Vision File and a Package File are created 
(described in the next few headings) or they already exist for this 
package type and job, then this first article test method is quickest if 
your job includes Laser Marking or Labeling.

1. Create the PS job—
1a. In TaskLink, create a new job for PS Systems.
1b. Click Run (or Load) in TaskLink to start the AH500.

2. Run one device—
2a. In AH500, click Start.
2b. In the Setup Window, select media options as usual.
2c. At the PS workspace, set up the input and output media as 

usual.
2d. Click Run > Run One. 
2e. Verify that the job passed the tests.

(Optional) Set TaskLink to Operator 
Mode

Options to add, remove, and edit Tasks are found in TaskLink’s Task 
Manager dialog when in Administrator Mode (the default). You can 
set TaskLink to Operator Mode which allows running jobs from the 
Operator Dialog but not adding, removing or editing them.

To switch between Operator Mode and Administrator Mode, see 
TaskLink on-screen Help.

For more information 
on Vision File and 
Package File creation 
see Teaching the Ref-
erence Vision File on 
page 3-34 or see 
videos in the 
PS System online 
Help.
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Teaching the Reference Vision File
A reference vision file stores a photo image of a specific device to 
verify proper alignment of devices picked from the input media. 
Therefore, each new device type must have a reference vision file cre-
ated and vision images made (taught). 

Note:   If the vision camera needs calibrating, it must be done 
BEFORE creating the Vision file for your device. 

Calibrate the Vision Camera first if any of the following are true:
 • The PS Machine has been moved
 • The camera has been replaced, moved, refocused, or contrast 

changed
For instructions on recalibration, see Calibrating The Vision System on 
page 4-50.

To teach the Vision File:

1. Creating the Vision File (and Package File) for Editing—
1a. Start TaskLink by double-clicking its icon.
1b. Select a job in the Task Manager. 
1c. Click Edit. 
1d. Click the System Files tab.
1e. Click the Package File Browse button, then copy the PS Package 

Template.txt file and paste it into the same folder, renaming 
the copy. Hint: use the Socket Adapter name, for example 
PAG007.txt.

1f. Click the Reference Vision File Browse button, then copy the PS 
VisionTemplate.vpp file and paste it into the same folder, 
renaming the copy. Hint: use the Socket Adapter name, for 
example PAG007.vpp.

Note:  The required Socket Adapter ID number can be found in 
Tasklink Task Manager. 
Highlight your target Task and click Edit.
Select the Task tab and click FootNotes.

1g. Click OK.

2. Run a Job; Start AH500; Create a User and Password—
2a. With the same job selected, click Run. OK the Pass Limit. Note 

the Socket Adapter Board Name on the Footnotes dialog and 
then OK to close it. 

2b. At the AH500 (PS System Software), click Start. 
2c. At the Setup Window > Options tab, select the desired input, 

output, and reject media. 

Note:  The WinAH400.ini file may require editing to display your 
desired setup configuration. Then in the AH500 Application, the 
desired options will be available in the Setup Window. See the 

Videos of Vision File cre-
ation are available in the 
online Help. Creating a 
Reference Vision File is 
listed under the Setting 
Up and Teaching booklet 
in the Table of Contents.

We will work with the 
Package File later; how-
ever, it is convenient to 
copy it now, also.

Package Files reside in the 
Handler Computer in folder  
C:\AH500\Package.

Copy & paste tip: Right 
click the file and select 
Copy from the popup 
menu. Right click on blank, 
white space for the same 
popup menu and click 
Paste.
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online Help for instructions editing the WinAH400.int file. For an 
image of the Setup Window, see Figure 3-20 on page 3–18.

2d. Click System. If asked to enter password, click OK. Open the 
Security Dialog and enter your password. 

Note:  If you don’t have a user profile, either have a supervisor 
enter the correct password, or have them create a new User and 
Password for you. Use the drop-down arrow, select your new user. 
Click System and enter your password. See Creating Security Pro-
files on page 3-31.

2e. Click Gantry.

3. Center the probe over the device: rough-in and then more 
accurately—

3a. [PS288, PS388, PS588 Optima] Ensure that the Socket Opener 
ribs are adjusted for the current Socket Adapter. For instruc-
tions, see Adjust Socket Opener Ribs on page 3-41.

3b. Click Park (a yellow label).
3c. Manually place a device into socket 1 of the programmer closest 

to the Vision camera. (We'll call it Pv, where v is the programmer 
number closest to Vision.) 

3d. Click label Pv.
3e. If necessary, adjust the position of the probe so that it is centered 

over the device in Pv. Use the X and Y-axis arrows (along the bot-
tom and right side of the black work area) so the probe is cen-
tered over the device. 

3f. Save, and click Yes to overwrite the previous values. 

Figure 3-27:  The Arrow Buttons (circled) on the Gantry Window: From
the center working outboard, the arrow buttons adjust the probe

position ±0.001, 0.010, and 0.100 inches respectively. (PS388 shown.)

A Gantry Window posi-
tion label blinking RED & 
YELLOW indicates the 
location of the PNP head.

Your model may display 
the yellow labels differ-
ently than shown here.
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4. Teach the Z-value (pick height)—
4a. Click Z AutoFind: the probe lowers to the device (to set the vertical 

distance) and then click Yes.
4b. Right-click on Pv (using the Track Pad buttons) to pick up the 

device and visually verify center.
4c. If it is not centered, right-click again to replace the device. Then 

repeat the centering process with the X and Y-axis arrows. Click 
Save.  Pick the device again to recheck center.

If it is centered, right-click again to replace the device. 

Figure 3-28:  The ZAutoFind button is on the Actuator tab of the Gantry
Window. It uses the probe to determine the Z-value, or height, of a

component. (PS388 shown.)

5. Teach the vision system—
5a. With a device still in socket 1 of the programmer nearest the 

vision camera (we’ll call it Pv), right-click label Pv to pick up the 
device.

5b. Click the Go To tab.
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Figure 3-29:  The Go To Vision button on the Go To tab.

5c. Click Go To Vision: opens the Vision System dialog. Verify your 
new file name in the file name field.

Figure 3-30:  The Vision System dialog displays the name of the current
vision file (arrow).

5d. Click Setup.
5e. Click the blue box in the image to select it. Click one of the cor-

ners and drag it to fit around the device.
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Figure 3-31:  The Vision System dialog. Resize the blue box by dragging
the handle.

5f. Click Teach.

Figure 3-32:  The Vision System dialog. The Tolerance is set to 75%
(circled). Click Teach.

5g. Click Find.
5h. Verify that the device is within the green box and that the ‘V’ 

value is greater than the tolerance percentage. The V value 
should be between 0.900–1.000. For QFPs or very small devices, 
the V value may deviate from this range.
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Figure 3-33:  The Vision System dialog. Verifying the Position V value
after having clicked Find. In this sample, the V value is 99.6%.

5i. Click Inspection.
5j. In the Results field, verify that it reads PASS, and that X, Y and A 

are all 0 (zero).

Figure 3-34:  The Vision System dialog. Click Inspection and check
Results

5k. Click Exit.
5l. Click Park and remove the device from the programmer.
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This completes the process of teaching the Reference Vision File.

Teaching the Package File
The Package File is a text file containing calibration information that 
the PNP head uses to properly pick, rotate and place devices.

After your new Package File is taught, it will contain information 
about the physical dimension of a specific device package and Socket 
Adapter as well as the location of all programmers, input and output 
media, and the shuttle transfer (if marking or labeling is done).

A Package File must be created for each device that uses a different 
Socket Adapter.

Note:   The Vision File must be taught first. See Teaching the Refer-
ence Vision File on page 3-34.

A new Package File was created (but not taught) in the previous 
topic, Teaching the Vision File, to be used for this procedure. Refer to 
Step 1 on page 3-34.

To review: 
• You created a Package File from the Package Template
• Used the Socket Adapter number for the name
• Selected the job in TaskLink that uses this new Package File
• Clicked Run
•  In the AH500 Application, clicked Start.
• At the Setup Window, you made setup selections
• and clicked System > Gantry)

(Optional) Quick Vision File Test
1. At the Gantry Window, pick a device: right-click a programmer 

label.
2. Send it to the Vision Camera: click Vis.
3. Navigate to the Vision System Window: from the Gantry Window 

click  Go To tab > Go To Vision.
4. At the Vision System Window, when you see your device in the 

on-screen image, click one of the rotate buttons and verify that 
the device rotates the correct direction. If not, there is a problem 
with the Vision file.

Package Files reside in 
the Handler Computer in 
folder  
C:\AH500\Package.
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Adjust Socket Opener Ribs

Note:   Adjust the Socket Opener only if the socket fails to open or 
if devices are dropped. It is necessary to adjust the Socket Opener 
only once while teaching a package file. 

Adjust the Socket Opener Ribs as described at Adjust Socket Opener 
Ribs on page 3-14.

WARNING:  Possible collision hazard. Stay clear of the operating 
envelope while teaching PNP head locations except as directed. 
The PNP head can move without notice.

Setting  Programmer Rotation

1. Setting Programmer Rotation to Zero
1a. At the Gantry Window click Park.

CAUTION:  Pinch Hazard. Sockets can actuate even with an 
Access Door open. Push the E-Stop prior to working near the 
actuators.

1b. Manually insert a device into the first and last sockets of all pro-
grammers intended for use with this job. 

To open the sockets on PS588 FlashCORE programmers:
1) Click the label for the programmer, 2) Click the Actuate Socket 
toggle to ON (on the Actuate tab), 3) Click the next programmer 
label, and repeat. 

1c. Click P1.
1d. Click the Rotation button, enter 0.0, press Enter on the keyboard.
1e. Click Save and Yes.
1f. Click Z-AutoFind, then Yes.
1g. Click P1 and then click X,Y AutoFind. 

If the resultant values are less than the absolute value of 5, then 
click NO. Otherwise click Yes and repeat from Step 1d.

1h. Click the Go To tab.
1i. Click [Go] Last Socket, then the X,Y AutoFind button next to it.

If the resultant values are less than the absolute value of 5 click 
NO. Otherwise Yes and repeat.

1j. Repeat step 1a–1i for all programmers.

If an error button appears 
on the Gantry window 
while teaching the pack-
age file, see Errors on 
page 3-50
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3. Set Vision Rotation to Zero
3a. Click the Vis label.
3b. Click the Actuator tab and then the Rotation button.
3c. Enter 0.0, press Enter on the keyboard.
3d. Click Save and Yes.

2. (Optional) recommended check—
2a. Right-click the yellow label for label P1 again. 
2b. Press X,Y AutoFind. 
2c. When the results appear, note the new values for X and Y. Click 

No (to keep the previous values).
2d. Repeat Step 2b two more times and watch the results. Click No 

each time to keep the previous values. If the resulting values 
gradually increase to more than ±5, the camera may need cali-
bration. See Calibrating The Vision System on page 4-50.
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Setting Input Media Rotation
When a device is inserted into a socket, pin 1 must match pin 1 loca-
tion of the socket.

CAUTION:  Possible socket and device damage. Devices and sock-
ets can be damaged if the devices in the input media are not 
delivered to the sockets with the correct pin-1-orientation defined 
in the job (via the Package file). Visually ascertain that rotation 
information in the Package file is accurate. If it is not, do not start 
the job until you either modify the Vision file or re-orient the 
devices in the input media. See the steps for setting input media 
rotation in the Package File below.

Rotation Values
When teaching the Package File, you are asked to enter the R-axis 
rotation value for input media (such as devices in a tray) so that 
pin 1 on the device will match pin 1 on the socket; use the fol-
lowing chart. 

For example, if a device must be rotated a quarter turn in the clock-
wise direction as it goes from the input media to the socket, set the 
R-axis at the socket to -0.250. 

Figure 3-35:  R-axis values for amount of rotation (not position) from
input media only. Output media is usually the same as the input media.

 

Pin 1 on most Data I/O 
Socket Adapters is 
away from the operator 
(toward the back of the 
machine.)

Pin 1 at my input 
media is 

Set rotation at input media to . . .
(Set rotation at output media the same as input media.)

Far side  .000 .250 .500 –.250

Right side  
–.250 .000 .250 .500

Near side  
.500 –.250 .000 .250

Left side  
.250 .500 –.250 .000

Pin 1 on my 
programmer 
sockets is 

Far side Right side  Near side Left side 
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Setting Values for Trays  
The PS System can have static tray or Automatic Tray Feeder (TF20) 
input and output modules. Teaching tray locations is the same for 
both. 

Note:   If the Automatic Tray Feeder option is installed, trays dis-
played in the Gantry Window are oriented as shown in Figure 3-36. 

 

Figure 3-36:  Gantry  Window shown with an automatic tray feeder
installed. (PS588 shown.)

1. Setting X, Y, Z & R values for Trays—
1a. Click Park. Then manually place a device in each corner pocket 

of the trays. (Devices in other pockets are okay.)
1b. Click Tr1: sends the probe to the left corner device in Tray 1.
1c. If necessary, center the probe over the device. Use the X and 

Y-axis arrows (along the bottom and right side of the black work 
area) so the probe is centered over the device. 

1d. Click Save, and Yes. 
1e. Click Z AutoFind (to set the vertical distance to the device) and 

then Yes to save the value.
1f. Click Rotate icon. 
1g. Type the desired rotation into the rotate field and press Enter on 

the keyboard. See Rotation Values on page 3-43 for more informa-
tion.

1h. Save and click Yes. 
1i. Press X,Y AutoFind. When the results appear, verify that the new 

values for X and Y are less than ±5. If so, click No (to keep the 
previous values). 

If new values are greater than ±5, click Yes to use these new val-
ues. Then recheck (by clicking  X, Y AutoFind again).

On-screen Label 
abbreviations:
Tr1- Tray 1,
RTr- Reject Tray
Vib1- Vibrator 1
Vis-  Vision Camera

If you are using one tray for 
both input and output for 
this job, then only that one 
tray needs to be taught.

X,Y AutoFind sends the 
probe to the vision cam-
era and compares the 
device image with the 
reference vision file.
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Figure 3-37:  After clicking X,Y AutoFind, a confirmation dialog displays
the results. (PS588 shown.)

2. Set location for the opposite corner of tray 1—
2a. Click the Trays tab.
2b. Enter the number of columns and rows for this tray. See Figure 

3-38.

Figure 3-38:  Enter tray rows and columns on the Trays tab of the
Gantry Window. (PS588 shown.)

2c. Click the opposite corner button (the diagonal arrow): The probe 
moves to the opposite corner of the tray. 

2d. If necessary, adjust the position of the probe so that it is centered 
over the device. Use the X and Y-axis arrows (along the bottom 
and right side of the black work area) so the probe is centered 
over the device. 

2e. Click X,Y AutoFind. When the results appear, verify that the new 
values for X and Y are less than ±5. If so, click No (to keep the 
previous values). 

Which are Rows and 
which are Columns?

As tray orientation may 
be different, always enter 
the lines in the X-axis 
direction into the first 
field labeled COL-
UMNS(X).
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If new values are greater than ±5, click Yes to use these new val-
ues. Then repeat the comparison (by clicking  X, Y AutoFind 
again).

Figure 3-39:  The X,Y AutoFind button for trays is on the Trays tab, as
well as Reject (Bin) Tray information. (PS588 shown.)

3. Repeat Step 1 and Step 2 above for Tray 2 if using Tray 2.
Set R-value the same as Tray 1.

Setting Values for the Reject Tray
Teach Reject Tray location—
1. Click RTr.  If necessary, adjust the probe location using the X and 

Y-axis arrows (along the bottom and right side of the black work 
area, respectively) to align the probe with the far left corner of 
the Reject Tray. 

2. Click Save and Yes.
3. Click the Trays tab.
4. In the Dimensions Reject Tray fields, enter a value for 

Columns (X) and Rows (Y) for the Reject Tray. These values set 
the maximum number of devices that can be sent to the Reject 
Tray before the displaying the message Reject is Full. In Figure 
3-39, the message will display after 12 (6 x 2) devices are placed 
in the Reject Tray. 

5. Click the diagonal arrow. The PNP head moves to the nearest 
right corner of the Reject Tray. If necessary, adjust the probe loca-
tion using the X and Y-axis arrows (along the bottom and right 
side of the black work area, respectively) to align the probe with 
the nearest right corner of the Reject Tray.

6. Click X-Y AutoFind (in the Dimension Reject Tray field) and then 
Yes to overwrite values if within ±5.

Setting Values for Tubes

1. Center the probe at Vib1 and set Z—
1a. At the Gantry window, click Vib1.

From the inside working 
outward, the axis arrow 
buttons adjust the probe 
position ±0.001, 0.010, 
and 0.100 inches respec-
tively. 

For information on select-
ing Vibrator Tube media 
in the Setup Window, see 
Set Media and 
Options—the Setup Win-
dow on page 3-16.
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Figure 3-40:  The white rectangle (representing the PNP head) is at
Vib1 location. (PS388 shown.)

1b. If necessary, adjust the position of the probe so that it is centered 
over the device in the staging area of the left-most tube of Vibra-
tor 1. Use the X and Y-axis arrows (along the bottom and right 
side of the black work area) to center the probe over the device.

1c. Click Save and Yes.
1d. Click Z AutoFind (to set the vertical distance to the device) and 

then Yes to save the value.

2. Set Rotation at Vibrator (Tubes)—
2a. Click Rotate button. 
2b. Type the desired rotation into the rotate field and press Enter on 

the keyboard. See Rotation Values on page 3-43 for more informa-
tion.

2c. Save and click Yes. 
2d. Click X,Y AutoFind. When the results appear, verify that the new 

values for X and Y are less than ±5. If so, click No (to keep the 
previous values). 

If new values are greater than ±5, click Yes to use these new val-
ues. Then recheck (by clicking  X, Y AutoFind again).

3. Identify and center probe over the right-most tube—
3a. Click the Tubes tab.
3b. In the Columns (X) field, enter the number of tubes in Vibrator 1. 
3c. In the Chips/Tube field, enter the number of devices per tube. 
3d. Click the Diagonal Corner button to move the probe to the 

right-most tube in Vibrator 1.
3e. If necessary, adjust the location of the probe so that it is centered 

over the device in the staging area of the right-most tube. Use 
the X and Y-axis arrows (along the bottom and right side of the 
black work area) to center the probe over the device. 

3f. Click X,Y AutoFind (adjacent to the Diagonal Corner button).

X,Y AutoFind sends the 
probe to the vision cam-
era and compares the 
device image with the 
reference vision file.
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3g. If the new values for X and Y are greater than ±5, press Yes and 
repeat Step 3e to Step 3f. 
If the new values for X and Y are less than ±5, press No.

4. Teach Vibrator 2 locations—
4a. At the Gantry window, click Vib2.
4b. Repeat these steps (1b–3g) for Vibrator 2.

Set R-value the same as Vibrator 1.

Setting Values for the Shuttle

1. Positioning the Shuttle—
1a. Exit the Gantry Window.
1b. At the System Window click Shuttle/Options.
1c. Click Home.
1d. After the head stops moving, click the first Go button (adjacent 

to the Ped 2 Load Pos). 
1e. Click Exit. Then at the System Window, click Gantry. 

2. Teach locations—
2a. At the Gantry Window, click Shu to move the PNP head to the 

marking shuttle.
2b. If necessary, adjust the location so the probe is centered on Ped-

estal 2. Use the X and Y-axis arrows (along the bottom and right 
side of the black work area) to center the probe on  the pedestal. 

2c. Click Save and Yes.

3. Placing a device on Shuttle 2—
3a. Click Park to move the PNP head to the Park location.
3b. Click the Shuttle/Options tab. (In some machines/configurations, 

this tab may say Laser.) 
3c. Turn the Vacuum button to ON if it is not already.
3d. Manually place a device on shuttle Pedestal 2.
3e. Click the Actuator tab.

4. Set Z & R values—
4a. Click Shu.
4b. Click ZAutoFind and Yes.
4c. Click Rotate button. 
4d. Type the desired rotation into the rotate field and press Enter on 

the keyboard. See Rotation Values on page 3-43 for more informa-
tion.

4e. Save and click Yes. 

5. Remove the device from Shuttle 2—
5a. Click Park. 
5b. Click the Shuttle/Options tab. 
5c. Turn the Vacuum button to OFF. 
5d. Manually remove the device from shuttle Pedestal 2. 
5e. Click the Actuator tab. 

6. Accurately centering the probe —
6a. Click label Shu to move the probe to the marking shuttle.
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Figure 3-41:  Vacuum switch on the Laser tab (or Shuttle/Options tab).
(PS588 Gantry Window shown.)

6b. Click the Pick Pos button to lower the probe.
6c. If necessary, adjust the location so the probe is centered on Ped-

estal 2. Use the X and Y-axis arrows (along the bottom and right 
side of the black work area) to center the probe on  the pedestal. 

6d. Click Save and Yes.
6e. Click the Pick Pos button again to raise the probe.

Setting Values for Tape-Input
With the chip feeder installed and the pocket pitch set correctly:

1. Advance the chip feeder—
1a. On the chip feeder control panel, while pressing and holding the 

center button, press the forward button. The carrier tape 
advances one guide hole. Advance the carrier tape until the cen-
ter of the device aligns with the pick point mark.

Figure 3-42:  A chip feeder mounted on a PS388.

For more information, the 
Operator Guide that 
came with your Chip 
Feeder.
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2. Teach locations—
2a. At the Gantry window, click Tape to  move the probe to the tape 

input pick position.
2b. If necessary, adjust the location so the probe is centered on pick 

point. Use the X and Y-axis arrows (along the bottom and right 
side of the black work area) to center the probe on  the pick 
point. 

2c. Click Save and Yes.
2d. Click Z AutoFind (to set the vertical distance to the device) and 

then Yes to save the value. 

3. Set Rotation at Tape Input—
3a. Click Rotate button. 
3b. Type the desired rotation into the rotate field and press Enter on 

the keyboard. See Rotation Values on page 3-43 for more informa-
tion.

3c. Save and click Yes.
3d. Click X,Y AutoFind. When the results appear, verify that the new 

values for X and Y are less than ±5. If so, click No (to keep the 
previous values). 

If new values are greater than ±5, click Yes to use these new val-
ues. Then recheck (by clicking  X, Y AutoFind again).

This completes the process of teaching the Package File.

Errors

Axis Limit Error
During the process of teaching the Package File, you will be directing 
the PNP head to move to various locations inside the work envelope. 
If the PNP head is directed to move beyond its X-axis or Y-axis limits, 
you will see a red error button.

To resolve axis limit errors:

1. Record error message—
1a. Note what item was being taught when the error appeared, such 

as Programmer 5 or Tray 1 or Tube 2.
1b. Click the Error button to display the error message.

X,Y AutoFind sends the 
probe to the vision cam-
era and compares the 
device image with the 
reference vision file.
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Figure 3-43:  Error messages don’t display unless you click the red Error
button to open the Alarm dialog. (PS588 Gantry Window shown.)

1c. Write down the axis (in this case, Y-axis), whether the min-
imum or maximum position has been exceeded (in this 
case, the minimum position), and the “Tried” and “Limit” 
values (in this case, Tried = 2.982 and Limit = 3).

1d. Click OK.

2. Contact Data I/O Service or your nearest authorized represen-
tative—

3. The item that was being taught when the error occurred (tray, 
programmer, reject bin, etc.) needs to be re-taught. See Teach-
ing the Package File starting on page 3-40.

Get Movetimes/Optimize Movetimes
When the Package File and Reference Vision File are taught, you can 
optimize the movement of the PNP head in the work envelope by get-
ting movetimes. This command calculates the best PNP path, espe-
cially when some programmers are not used, and considers 
programming times versus head travel time.

To get movetimes:

1. Gantry—
1a. On the Gantry Window, click Optimize Movetimes (older versions 

read Get Movetimes.

For contact 
information see 
Contacting Data I/O 
on page ix.
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Figure 3-44:  Click Get Movetimes (or Optimize Movetimes—some
models) to optimize head travel. (PS588 Gantry Window shown.)

1b. Click Yes when prompted to save positions.

Monitoring Statistics
Occasionally, the system administrator may require statistics for a 
group of devices for a given job. This is easily accomplished using 
any of three statistics tools described on the next pages:
 • TaskLink’s Session Data Logging feature
 • AH500’s Statistics Window
 • (Optional) Statistical Process Control Software (user-supplied)

In addition, there is our optional Enhanced Statistic Process utility. This 
utility graphs the data collected on the PS Machine using Microsoft 
Excel spreadsheet (if available on your PC). 

The Enhanced Statistic 
Process utility is avail-
able with the PS Remote 
Monitor Software pack-
age.
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Figure 3-45:  PS Remote Monitoring is optional software which
includes the Enhanced Statistic Process utility.

TaskLink Session Data Logging
For complete instructions on enabling and using TaskLink’s Session 
Data Logging option, see TaskLink online Help.

 AH500 Statistics Window
The PS System statistics include such items as devices programmed 
successfully, continuity failures, and verify failures. 

To view programming statistics using the AH500 software:
1. At either the Setup Window or at the Run Window, click Statis-

tics.
2. Select either Package Type or Job Statistics from the drop-down 

field in the upper left corner.
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Figure 3-46:  At the Statistics Window, the Job Statistic file can be
viewed (Jobname.stx) as shown. When Job Statistics is selected,

Pass/Fail criteria are logged for each individual socket and
programmer listed in the left column.

Figure 3-47:  At the Statistics Window, statistics files by Package Type
(PackageType.sts) are shown here.

Resetting Package Statistics
The Package statistics displayed correspond to the Package File and 
therefore to the Socket Adapter used. When a Socket Adapter is 
replaced on a FlashCORE programmer, statistics for that Socket 
Adapter must be reset. 

To reset Package statistics:

At Run or System Window
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1. Select Package Statistics in drop-down field in the upper left 
corner.

2. Click Reset in the right-most column corresponding to the 
FlashCORE programmer on which the Socket Adapter was 
replaced. 

 • If a Socket Adapter was replaced, reset all rows for that pro-
grammer.

 • If an individual socket was replaced*, reset only the row corre-
sponding to the replaced socket. 

The R-date (reset date) is set to the current date and statistics are 
reset to all zeroes.

Figure 3-48:  Resetting Package statistics.

Statistical Process Control Software
Most SPC (Statistical Process Control) Software (customer-supplied) 
can import a comma-delimited file. AH500 can be set to generate a 
comma-delimited file whose fields are described on the next page.

To generate a comma-delimited output file:

1. Enable file generation for SPC software—
1a. On the Handler Computer, navigate to C:\AH500 and open 

winAH400.ini with Microsoft Notepad (or IDM Computer Solu-
tions’s UltraEdit). 

1b. Locate the section for SPC Logging. It will look like this:
[SPC Logging]
LoggingEnabled=FALSE
MaxFileSize=10485760
TempLogFile=C:\spcout.txt

1c. Set the second line (LoggingEnabled) to TRUE.
1d. Save and close winAH400.ini.

*Only HIC Socket 
Adapters and HPS 
Socket Adapters are 
designed to accommo-
date replacement of 
individual sockets on 
the adapter board. 
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Note:   In the above example the SPC logging file is saved to C:\ 
directory. It can, however, be saved anywhere on the Handler Com-
puter hard drive, or on a networked drive if the PS System is con-
nected to a network.

The SPCOut.txt file contains 19 semicolon-delimited fields, as fol-
lows:

The SPCOut.txt Field Descriptions

01 DevicesInputsystem - number of devices picked from Input 
media

02 DevicesInspected - number of devices inspected by Vision system

03 InspectionQuality - as percentage, compared with reference 
vision 

04 InspectionYield

05 DevicesInsertedSocket - number of devices inserted into socket

06 SocketYield

07 ProgrammerYield

08 ProgSysYield - Yield of all programmers together

09 DevicesProcessedMarker

10 MarkingYield

11 SystemThroughputExcWait - starts with first device placed, 
excludes wait times.

12 SystemTotalThroughputIncWait - starts when Run starts, 
includes wait times

13 SystemYield

14 AreaID - Programmer #1 = “17”, Programmer #2 = “18”, …, Pro-
grammer #24 = “40”)

15 PosID - that is Socket #

16 TimeStamp - Date/Time of SPC log entry

17 OrderNumber - Job Name and or number

18 Package - Package File used for the job

19 VisionVPP - Reference Vision File used for the job
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Maximizing Programming Yields
Occasional declines in system yields may occur during day to day 
operation of the PS System. While overall yield levels can vary 
depending on device manufacture, any steep change in yields is suffi-
cient reason for investigation of an immediate cause of variation. 
These changes in yield can be attributed to a number of causes, 
including device quality control, socket issues, system maintenance, 
and process errors.

Quality Control of Devices
Variations in the manufacture of devices may affect yields in an auto-
mated system, such as:
 Variation in dimensions from different manufacturing lots or 

facilities can cause devices to fit improperly in the sockets or 
require reteaching the Package File to be placed successfully.

 Presence of residual plastic on the edges of the devices (flashing) 
can cause devices to rest improperly in the sockets.

 Die changes (shrinks, process improvement for improved wafer 
yield, etc.) require new algorithms. Data I/O tracks these 
changes with vendors and recommends all customers subscribe 
to the algorithm update program.

 Die processes contain variability. Programming yields can some-
times vary on a normal die. Device families recently introduced 
to the market tend to have more fluctuations in yields as the 
semi-vendor's manufacturing process stabilizes.

 Multiple fabrication sites often produce the same devices. Per-
formance characteristics, including programming yield, can 
vary from location to location. 

 Lead oxide accumulating on device leads is an issue for some 
devices. This can vary with age and the conditions with which 
the devices are stored.

 Programming yields decrease with the number of programming 
cycles. Devices that are processed more than once are more 
likely to experience problems.

Socket Issues
The programming sockets are perhaps the most important and vul-
nerable element of the PS System. They are subject to residue 
buildup, damage from mis-inserted devices (perhaps due to poor cal-
ibration of the placement system), and general wear and tear. 

Socket conditions that cause varying yields include the following:
 Debris of any type can prevent sockets from closing completely. 

Sometimes the debris may not be visible. Simple actuation may 
clear debris, or it may be necessary to clean sockets with low 
pressure air. 
Blow out sockets every day with clean and dry air at 6.2 Bars (90 
PSI) or less. Press down on the opener to blow out debris from 
beneath the contacts. More frequent cleaning is recommended in 
a dirty environment.

 Bent or distorted contact pins can cause intermittent socket fail-
ures.

Socket life is generally 
rated by the manufacturer 
as the number of inser-
tions per socket after 
which yields may drop 
significantly.
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System Maintenance Affecting Yield
System maintenance is critical to maintaining high yields. Periodic 
cleaning, adjustment and replacement of worn elements ensures the 
best possible performance. These periodic procedures are outlined in 
Maintenance Schedule on page 4-2 and should be followed closely.

Part of regular maintenance is ensuring that the system hardware is 
in good working order, and that settings are accurate. To check pro-
grammer hardware see FlashCORE Programmers Diagnostics on page 
4-29. For accurate settings, ensure that Reference Vision Files and 
Package Files are taught accurately. To perform a Vision File check, 
see (Optional) recommended check— on page 3-42. If throughput is 
down, perform Get Movetimes again: see Get Movetimes/Optimize 
Movetimes on page 3-51.

Process Errors
Finally,  some process errors can result in reduced yield. While an 
automated approach eliminates most human error during produc-
tion, errors in system setup or maintenance programs can result in 
reduced yield:
 Using old algorithms may affect programming yields. 

PS System algorithms are updated weekly at 
http://www.dataio.com/algorithms/ and are available depending 
on your maintenance plan.

 Selecting the wrong device part number in a job, thus using the 
wrong algorithm (selected in TaskLink).

 Changing programming parameters in TaskLink (sector protec-
tion, security options, verify options, continuity testing, blank 
checking).

 Measuring yields too infrequently, so that a drop in yield rates is 
not detected until a large number of devices have failed.

 Using the wrong data file (selected in TaskLink).
 Socket abuse, such as digging failed devices out with sharp 

instruments. 
 Changing to second or third vendor source. Lower quality 

devices tend to produce lower yields.

(Optional) Creating a Data File from a 
Master Device  

The PS System can read data from a master device and create a data 
file that can then be used in programming jobs. 

For complete instructions on creating a data file from a master device, 
see TaskLink online Help.

http://www.dataio.com/algorithms/
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Figure 3-49:  TaskLink’s online Help includes steps for creating a
computer file from a master device. (PS FlashCORE Series Help only.)
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Printer Options
There are two main printing options with the PS System. One prints 
paper labels and the other is a Laser printer by WinMark which 
marks the surface of the devices. Both are described in this section, 
and each has a separate Operation Manual which came with your 
PS System if it has the option.

Figure 3-50:  Manuals for the Label printer and the Laser printer.

(Optional) Creating a Label Printer File  
If devices are to be labeled using the optional label printing system, a 
label printer file must be created. Follow these steps to create a label 
printer file.

1. Preparation—
1a. Open the label printing software by double-clicking the applica-

tion icon on the monitor or by navigating to the file, MRPRT.exe, 
and double-clicking it.

LaserLabel

The Label Printer Setup 
Window is separate from 
the AH500.
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Figure 3-51:  The Label Printer–Setup Window. Each label type has
different values for dimensions a to j. Up to four lines can be used per

label. All values are in millimeters.

2. Select label type—
2a. Select the label type to use when this job is run. The MRPRT soft-

ware allows up to six sizes of labels called types  (abbreviated as 
Typ).

3. Set values in millimeters—
3a. Enter the values for fields a to j. For an explanation of each 

value, see the table below.

dimen-
sion Description

a Left margin: the offset in X-axis of the text from the edge of the label.

b Top margin: the offset in Y-axis of the text from the edge of the label.

c The label size in the X.

d The label size in the Y (must be less than value for f).

e Not used on the PS System and should be set to 0.

f The distance from the front of the label to front edge of the next label.

g Not used. 

h Label advance. This is the distance to advance the label toward the tamp 
applicator after printing. (Use only for small adjustments. The Tamp 
head should be in the correct position first.)

i Text centering in X direction. 0= Auto and 1= All the way to the left of the 
label. Normally set to 0.

j Text centering in Y direction. 0= Auto and 1= All the way to the top of the 
label. Normally set to 0.
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4. Set text lines—
4a. Select the first (left) box and type the text to be printed on the 

label. Each box represents one line of text. 
4b. Repeat for the remaining text boxes: Label: Line 2, Label: Line 3 

and Label: Line 4.

5. Set labels per roll—
5a. Type 1 into the Lbls per Roll field.
5b. Click Save to save and exit the printer setup.

Note:   For information on selecting label printing during Task cre-
ation, see TaskLink online Help.

(Optional) Creating a Laser Marking File
Laser graphics used to mark devices are generated using  
WinMark Pro software. It may be on the Laser Computer located in 
the Option Bay (some models) or on the Handler Computer. 
Any style of marking (whether text-based, graphic-based, or both) 
can be generated and used for marking devices. The only limitation is 
the size of the device to be marked.

Creating an Image File for the Laser System
To create an image file for the laser system to use in laser marking 
devices:

1. Preparation—
1a. Select the Laser Computer by pressing the  Ctrl key twice— a list 

of all computers is displayed on the monitor. If you don’t have a 
Laser computer skip this step.

Note:  The touch screen does not work while viewing the Laser 
Computer. Use the keyboard and track pad.

1b. Navigate to and copy the file Template.mkh (or copy the .mkh  
file from an existing job).

1c. Paste it and rename it to the name you gave the laser marking 
(drawing) file in the job creation process, for example, Ver7.mkh.

1d. Start WinMark Pro by double-clicking the WinMark icon on the 
desktop. 

2.  Load the file—
2a. Select File > Load.
2b. Select your laser marking file from the list, or navigate to the file 

and select it. 
2c. Click Open to load the file.

Are you using Serial-
ization with a laser or 
label marker? See 
TaskLink Help for more 
information.

Newer PS models may 
not have Laser Com-
puter. 

On older PS models, 
select the Laser Com-
puter by pressing button 
14 on the KVM switch 
box.
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Figure 3-52:  Selecting a laser marking file. (WinMark software is not
part of AH500.)

3. Format—
3a. Click Drawing on the right side of the Properties Window.
3b. Click the Format tab. 

Figure 3-53:  The Synrad WinMark Window with the Format tab on the
right.

3c. On the Format tab, set the Optimal Field Width and Optimal Field 
Height to the approximate width and height (in inches) of the 
device to be marked. 

CAUTION:  Do NOT change values in the Automation tab. These 
values are set in Template.mkh. 
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4. Create text—
4a. On the tool bar on the left side of the window, select the Text 

tool .

4b. Click anywhere in the drawing area and type the desired text.

Note:   The center of the drawing area is the center of the device to 
be marked and is indicated by the red crosshairs. Ensure that the 
graphics and text fit onto the surface of the device to be marked. Use 
the rulers at the top and left of the drawing area as guides for place-
ment.

4c. Click File > Save from the menu at the top of the window.
4d. Click File > Exit.

Default Settings in Template.mkh
When creating or editing text, use Stroke fonts. These fonts are drawn 
and marked on the devices very quickly using point-to-point vectors. 
If you choose True Type fonts instead of Stroke fonts, marking time 
increases. The table below displays the default setting within the 
Template.mkh file.

The three most important settings are Velocity, Power and Resolution. 
These three settings, plus object delays on the Marking tab, are the 
primary factors that determine the speed and quality of the laser 
mark on devices.

Edit an Existing File
If an image file already exists and you wish to edit the text:

1. Preparation—
1a. Double-click the WinMark icon on the desktop.

Template.mkh settings

Setting Default Value Range

Velocity 30 ips (in./sec) Range 0.01 to 240 ips 
(0.25 to 6,096 mm/sec)

Power 60% Range 0 to 100%

Resolution 600 dpi 200 to 1000 dpi

Pline Start Delay 100 secs 0 to 80,000 secs

Pline End Delay 450 secs 0 to 80,000 secs

Interseg Delay 350 secs 0 to 80,000 secs

Off Vector Delay 300 secs 0 to 80,000 secs

Off Vector Velocity 75 ips
(1,905 mm/sec)

0 to 600 ips

Off Vector Resolution 300 dpi 0 to 600 dpi

For more marking infor-
mation, refer to the man-
ual that came with your 
marking system.
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1b. Click File > Load.
1c. Select your laser marking file from the list and click Open to load 

the file. 

2. Edit text—
2a. Click the Format tab, then click the text-box drop-down at the 

Text Caption field. See Figure 3-54. 

Figure 3-54:  The Text Caption drop-down field on the Format tab.

2b. At the Text Caption Editor Window, edit the text as desired. Click 
OK when finished.

Figure 3-55:  Edit text as desired in the Text Caption Editor.

Loading an Image File
To load the image file and use it to mark devices:

1. Preparation—
1a. If your PS Machine has a Laser Computer, select it. Otherwise 

skip this step.
1b. Start the Serial Marking Interface (SMI) by double-clicking the 

icon on the desktop.

Note:   This completes the process of loading the image file if your 
system has SMI. If your system does not have SMI, continue.

2. Opening a File—
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2a. Start WinMark Pro by double-clicking the WinMark icon on the 
desktop.

2b. Click File > Load.
2c. Select a laser marking file from the list, or navigate to the folder 

and select the file. 
2d. Click Open.

3. The Mark icon—

3a. Click the Mark icon  in the tool bar at the top of the WinMark 
Window: the marking graphic is displayed.

Figure 3-56:  The Synrad WinMark Control Window.

3b. Click the  Start–F1 button on the screen.

The WinMark software is now ready for commands from the Handler 
Computer to begin marking devices.
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Verifying Proper Laser Operation

WARNING:  Toxic fume hazard! Laser marking generates vapors, 
fumes, and particles that may be noxious, toxic, or even fatal. Fol-
low maintenance procedures on the fume extractor. Use proper 
ventilation.

To verify that the laser is marking as expected:
1. At the Run Window, click RunOne. 

Only one device will be processed.
1a. Verify that the marking graphic is centered on the device. If the 

graphic is not centered, adjust the laser file. Refer to Figure 3-53 
on page 3–63.

WARNING:  Blindness hazard! Always wear eye protection when 
the laser access doors are open. Direct or diffuse laser radiation 
can damage eyes. Goggles must block 10.6 μm laser radiation. 
Goggles protect against scattered energy but not against direct 
viewing of the laser beam or reflections from metallic surfaces.

WARNING:  Serious burn hazard!  Laser radiation, whether direct 
or diffuse, can cause serious burns. Keep hands and other parts of 
the body out of the path of the laser beam.

Troubleshooting
If the device is not marked, perform the following USING 
EXTREME CAUTION:

1. Remove the access panel on the right end of the Option Bay 
when viewing it from the back of the PS System. Use a 1/8 inch 
hex key to remove six fasteners.

2. Lay a sheet of white paper in the laser bay over the pedestals.
3. Temporarily disable the panel safety interlock (as with tape).
4. Fire the laser (by clicking Laser Marker on the Shuttle/Options > 

Subsystem tab).
If the mark appears on the paper, make sure the mark is cen-
tered over the shuttle.  If the mark placement needs adjustment, 
change the Mark Position at the Shuttle/Options > Shuttle tab. 
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Figure 3-57:  Adjust the marking position (Mark Pos.)  for either
pedestal at the Shuttle/Options Window if necessary.

If no image appears on the paper:
A) Verify power to the laser marking assembly is connected and 
turned on. 
B) Ensure that the access panel interlock is disabled.

If all appears correct an still no results, contact Data I/O Customer 
Support.
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Additional Features

Automotive Performance Pak
Data I/O offers several utilities that are especially useful to certain 
industries. These utilities, labeled the Automotive Performance Pak 
(AP Pak), are described below. If your PS System does not have this 
feature, it can be ordered for use on PS Series machines that meet 
these requirements:
 • AH500 Version 6.0.0 or higher and TaskLink 7.0 or higher.
 • AH400 Ver 6.0.1 or higher and TaskLink 7.0 or higher.
Contact Data I/O Sales.

Figure 3-58:  The Automotive Performance Pak features appear in the
Setup Window.

AP Pak Utility Descriptions

PS Remote Monitoring
The PS Remote Monitoring window displays Pass, Fail, and Yield 
information of remote, networked PS Systems. Up to ten PS Systems 
can be monitored. 

Enhanced Statistic
This application allows precise tracking of machine behavior such as 
uptime, downtime, yields, and throughput. It produces job log files 
that are readable with Microsoft® Excel and Access software. 

Confirm Input Device
This safety enhancement checks that the input device is the correct 
one for the job each time the input media is changed.
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Label Generator
This separate application is a concise and lean tool for designing 
labels for reels of device tape or other media. Choose size, number of 
fields, and layout. Call up variables from TaskLink or enter new con-
tent. Print on-demand or automatically after each reel of devices.

Ordering and Installing
Ordering the AP Pak involves sending Data I/O a number from the 
Setup Window in AH500 with your purchase order. Data I/O will 
send a security file via return e-mail. Complete instructions along 
with the installation  procedure are in the AH500 online Help: find 
Automotive Performance Pak in the online Help index.
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4Maintenance
Performing the maintenance procedures described in this 
chapter optimizes operation of your PS System and minimizes 
operational malfunctions. 

The manuals that came with the optional equipment on your 
system contain additional maintenance procedures.

Note: Only individuals trained on these procedures by Data I/O or 
its representatives are qualified to perform maintenance on the 
PS System. 

This section describes the preventive maintenance schedule for the 
PS System, with topics appearing in this order:

Maintenance Schedule
Workspace, Head and Gantry on page 4-5
Programmers on page 4-29
The Marking Systems and Shuttle on page 4-34
Handler Computer on page 4-48
The Vision System on page 4-49
Troubleshooting on page 4-58
Tape Output System on page 4-71
Automatic Tray Feeder on page 4-78

The information in this 
Manual applies to the 
PS288, PS388 and 
the PS588, (referred 
to as PS System) 
unless otherwise noted. 

If your PS System was built 
prior to 2011, then we 
strongly recommend creat-
ing a Ghost Image of the 
hard drive for backup. 
There are several configu-
ration settings on the hard 
drive that are unique to PS 
Machines. Also, there are 
several drivers that must be 
loaded onto the hard drive, 
in specific order. Contact 
Data I/O Service.
Systems built after 2010 
include a backup system.
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Maintenance Schedule
This Maintenance Interval Chart below recommends intervals based 
on the PS System processing 100,000 devices per month. Information 
about these procedures and intervals can be found on the pages refer-
enced in the right column.

  

Make copies of this 
chart and post near 
your work area.

Date 
completed
/ initials

Component Action 
(see precautions also, on page listed)

Page

Items to check Every Day

Sockets Clean with dry compressed air. Check for wear; replace if 
necessary.

page 
4-5

Input air pressure Verify input air pressure is  5.5 ±0.7 Bar (80 ±10 PSI). —

Items to check Every Week

General system Clean tops of equipment and all areas in work surface with 
a clean brush, cloth or dry compressed air.

page 
4-11

Vision camera lens Clean with dry compressed air, lens cleaning tissue, and 
isopropyl alcohol.

page 
4-11

Probe tip, on 
• PNP head, 
• Tape Output* PNP  

Head 

Inspect Probe Tip to make certain it can create a good vac-
uum seal on the device. Replace if probe tip is worn, cut, 
or damaged.

Clean the PNP Probe tip.

Note: Do not touch the probe tip. Oils from fin-
gers can cause small devices to stick to the probe.
Note: Do not clean with alcohol.

page 
4-12

Automatic Tray 
Feeder*

Check the Tray Feeder for damaged or broken parts.
Check the conveyor belts for dirt, nicks, or other signs of 
damage.

—

Items to check Every Month

Supply line air filter Check the main air filter and replace if necessary. Drain 
fluid.

page 
4-15

PNP head vacuum 
generator filter and 
silencer

Check; replace as necessary.  page 
4-15

Marking System* Clean the Shuttle Assembly. page 
4-34

Marking System* Clean housing to remove laser marking dust. See The 
Shuttle Assembly on page 4-34.

page 
4-34

 * denotes optional equipment
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Marking System* Clean the O-ring on the Shuttle Assembly. page 
4-40

Marking System* Adjust tension on shuttle belt. page 
4-36

Marking System* 
Fumex Laser Marker 
Fume Extractor

Check the pre-filter and clean if necessary. Replace it if 
marking is performed regularly. 
(The maintenance interval depends on the number of 
devices marked and the amount of text marked.)

page 
4-41

Automatic Tray 
Feeder*

Clean system. Check pinch roller; replace if necessary. page 
4-78

Item to check Every Three Months

Marking System* Check wear on the shuttle belt and replace if necessary.
Check tension and adjust tension.

page 
4-36
page 
4-37

Items to check Every Six Months

PNP head and Gantry 
wiring harnesses

Check; tighten if necessary. page 
4-24

Gantry Cable Carriers Check fasteners; tighten if necessary. page 
4-25

Vision camera Inspect vision camera mount; tighten as necessary. page 
4-49

Marking System* 
Fumex Laser Marker 
Fume Extractor

Replace the pre-filter and pleated filter if marking regu-
larly.
The maintenance interval depends on the number of 
devices marked and the amount of text marked. In gen-
eral, the pre-filter and pleated filter should be changed 
every six months, or more frequently if low air flow is 
detected.

page 
4-41

PS Computer Replace Handler Computer air filter. page 
4-48

Laser Computer Replace Laser Computer air filter. page 
4-46

Items to check Once a Year

Gantry lead screws Clean and lubricate annually, or whenever the gantry 
becomes noisy.

page 
4-27

Marking System* 
Fumex Laser Marker 
Fume Extractor

Replace the HEPA (High Efficiency Particulate Air) filter 
and carbon filter.

page 
4-41

FlashCORE program-
mers

Run conformance verification using Data I/O’s DAB, part 
number 910-2200-003 or higher.

page 
4-29

Date 
completed
/ initials

Component Action 
(see precautions also, on page listed)

Page

 * denotes optional equipment

every 150,000 devices
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Materials Required
To perform preventive maintenance procedures on the PS System, 
you need the following materials:
 • Lens cleaning paper
 • Isopropyl alcohol
 • Antistatic cleaner
 • Silicone lubrication spray
 • Tri-Flow lubricant (Data I/O part number 560-3300-901)
 • Dry, compressed air
 • Safety goggles
 • Disposable protective gloves
 • SAE and metric hex socket wrenches and Hex Keys (Allen  

wrenches)
 • Metric open end wrenches for the probe tips
 • Shop vacuum cleaner
 • Diagnostic Adapter Board (DAB)
 • NSK Grease and Grease Gun MG70 

Turning Off the System
When the PS System will not be used for  several days, or before per-
forming a service procedure, shut off the system.

1. Complete or exit any job that is running.
2. Remove all devices from the system.
3. [Laser Marker only]  Exit the Laser Marker software and shut 

off the Laser Computer from the Windows Start menu.
4. Exit AH500 and TaskLink, and shut off the Handler Computer 

from the Windows Start menu.
5. WAIT UNTIL WINDOWS COMPLETES SHUTTING DOWN, 

then rotate the main power switch (on the back Input Panel) 
counterclockwise to the OFF (vertical) position. 

6. (Optional) Padlock the main power switch so that it cannot be 
turned back on while the lock is in place.

See Chapter 3 for 
more information on 
exiting a job or shut-
ting off computers.



■ Workspace, Head and Gantry ◘ Socket Adapters and Actuation

PS Series Owner’s Manual 4—5

back

Workspace, Head and Gantry
The workspace includes the Socket Adapters and items on the 
working surface, but not the Programmers or Vision System. They 
are covered in separate headings.

Socket Adapters and Actuation
Under this heading you will learn about visually inspecting, cleaning 
and adjusting sensors and air pressure for the workspace items. 

Inspecting the Socket Adapters
The condition of the Socket Adapters has great throughput conse-
quences.

WARNING:  Vision hazard. Always use care and wear protective 
eye goggles when cleaning with pressurized air. Pressurized air or 
debris blown into the eyes or skin could cause bodily damage.

1. Use clean, dry compressed air to remove dirt from the sockets. 
2. Check the sockets for wear and replace if necessary.

Note: The socket replacement cycle depends upon the type of socket 
used and the socket manufacturer. For life cycle guidelines, refer to 
the documentation that came with your sockets.

Adjusting the Socket Actuator Sensors
[PS288, PS388 and Optima Programmers only on PS588]  The Socket 
Actuator sensor reports the position of the Socket Actuator (up or 
down), and therefore controls when a device can be put into a socket. 

Note: Sensors are set at the factory. They need adjustment only if 
experiencing trouble. One possible indicator of needed adjustment 
is an error message such as Socket Opener failed.

A PS588 with Optima Programmer and a Socket Adapter installed 
are necessary for this procedure.

PS288 & PS388 require a FlashCORE programmer with a Socket 
Adapter installed for this procedure.

To adjust the Socket Actuator sensor:

1. Preparation—
1a. Start the AH500 Application.
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1b. At the Setup window, click System > Gantry. You may need to 
enter a password.

Figure 4-1:  The Gantry window (PS588 shown).

1c. Click on any programmer label (P1 through P12) that has an 
Optima (Universal) programer installed to move the PNP head to 
that programmer.

Figure 4-2:  Cylinder Sensors for determining socket actuator positions;
viewed from back of PNP head. The long arrow points to the

adjustment screw for the Up position sensor and the short arrow for the
down sensor (screw partially hidden). Sensors may be radially oriented

differently on the cylinder.

2. Adjust up sensor—
2a. Locate the sensor adjustment screw at the back of the PNP head. 

See Figure 4-2. Loosen the Phillips-head screw on the Up sensor 
bracket.
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2b. Move the up-sensor upwards just until the LED lights.
2c. Tighten the sensor bracket screw. 

3. Adjust down sensor—
3a. On the Gantry window Actuator tab, click the Socket Actuator to 

the ON position; see Figure 4-3. The Socket Actuator opens 
(moves down). 

Figure 4-3:  The Gantry window shows the Socket Actuator air ON (for
programmer 1). PS588 shown.

3b. On the Power Panel, rotate the valve clockwise to shut off the 
input air; it is off when the lock rings line up (some models). See 
Figure 4-4.

Figure 4-4:  The input air regulator/filter on the Power Panel (on the
back of the PS Machine). The air supply to the PS Machine is off when
the lock rings on the valve line up. The air valve on your model may be

different.

If your sensors do not 
have LEDs on them, you 
have a previous PS 
model. Consult the man-
ual that came with your 
PS Machine or contact 
Data I/O Support.

On earlier models the air 
shut off is a slide valve; 
slide the valve down to 
shut off the supply air.
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3c. By hand, move the Socket Opener down until the opener ribs 
open the socket completely. See Figure 4-5.

Figure 4-5:  The Socket Opener ribs contact the top of a Socket.
(Optima Socket Adapter shown.)

3d. Loosen the Phillips-head screw on the down sensor bracket. 
3e. Move the down sensor downward until the red LED on the sen-

sor lights. 
3f. Tighten the sensor bracket screw.
3g. On the Power Panel, rotate input air valve ON (counterclock-

wise).
3h. At the Gantry window on the monitor, click the Actuate Socket 

toggle OFF and ON several times to verify that the LED turns off 
and then on.

Adjusting the Socket Actuator Air Pressure
PS588 FlashCORE is the only programmer with socket actuation built 
into the programmer. Other actuators, commonly called Openers, are 
on the PNP head.

Pressure for Actuators on PNP Head
[PS288, PS388 and Optima Programmers only on PS588]  If the PNP 
head does not properly pick or place a device in a socket because the 
socket is not opening completely, the Socket Actuator air pressure 
might be set too low. 

Note: Prior to adjusting the actuation pressure, the opener ribs 
must be adjusted for proper contact with the socket. See Adjust 
Socket Opener Ribs on page 3-14.

To adjust the Socket Actuator air pressure:

1. Preparation—
1a. Pause any job that is running.
1b. At the Gantry Window, move the head to a programmer by click-

ing P1, for example. 
1c. Click the Actuator tab.
1d. Click the Actuate Socket switch to ON (green).

Ribs

Socket
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2. Power Panel—
2a. Verify that the Socket Actuator pressure regulator (on the back 

Power Panel) is set within this range: 
• Standard Sockets, 1.3 ±.34 Bar (20  ±5 PSI), and for 
• HIC sockets, 2.2 ±.55 Bar (32 ±8 PSI). 

CAUTION:  Possible excessive socket wear. Setting the Socket 
Actuator air pressure too high can cause premature wear of the 
sockets.

2b. If experiencing problems, increase the Socket Opener air pres-
sure slightly to the high end of the range.

2c. Open and close the socket to check that it opens with one stroke 
of the opener.

3. Restart Job—
3a. Restart the job and check the action of the Socket Opener and the 

pick and place performance.

Pressure for Actuators on the Programmers, PS588
[PS588 Machines with FlashCORE] Actuators are part of the pro-
grammer. If Socket Actuators are moving too fast or too slowly, or 
you are experiencing pick or place problems, contact Data I/O sup-
port or a qualified technician. 

Adjusting the Socket Opener Speed
Prior to adjusting the actuator speed, the actuator pressure should be 
set (see the previous heading).

Speed for Openers on the PNP Head
[PS288, PS388 and Optima Programmers only on PS588] 

Note: Prior to adjusting the opener speed, the opener ribs must be 
adjusted for the current socket. If this has not been done, see Adjust 
Socket Opener Ribs on page 3-41.

To adjust the Socket Opener speed:

1. Preparation—
1a. Ensure that power and air are connected and ON, and a Socket 

Adapter is installed. 
1b. At the Gantry Window, click the label for a programmer with 

easy access. The head will stop over socket 1.
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2. Adjust the down speed—
2a. Open the safety door nearest the PNP head and locate the in-line 

air flow control for the upper end of the air cylinder on the head. 
See figure below.

Figure 4-6:  Flow controls for the Socket Opener Speed control. (PS288,
PS388 and Optima only on PS588.) (Your head assembly may not look

like this one.)

2b. Loosen the locking ring and adjust the down flow control as 1/2 
to 1 revolution clockwise for slower or counter-clockwise for 
faster. 

2c. Close the Safety Door, and clear the Safety Door warning on the 
monitor.

2d. At the Actuate tab of the Gantry Window, click the Actuate 
Socket toggle switch to ON while listening and watching the 
opener. 

If it is too fast it will produce a louder thump than optimum 
when it opens the socket. 

If it is too slow it will look slow.
2e. Click Actuate Socket OFF.
2f. Adjust the flow control as necessary and repeat the test. 
2g. Tighten the locking ring when done.

3. Adjust the up speed—
3a. Follow the same procedure as above with the other flow control.
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Adjusting the Socket Actuator Speed on PS588 
Programmers
[PS588 Machines with FlashCORE] 
To adjust the speed of the Actuators on the PS588 with actuators on 
the programmers, perform the same procedure as above, with the fol-
lowing differences:
The flow controls are located inside the cabinet in some models. If 
your PS588 doesn’t have flow controls, contact Data I/O.

Figure 4-7:  Actuator flow controls on PS588.

Cleaning the PS Machine

General Machine Cleaning
General cleaning should be performed on a weekly basis. General 
cleaning includes but is not limited to the following:

1. Remove all dropped devices, debris, and other materials from all 
working areas.

2. With air and power OFF or disconnected, remove all devices and 
materials that may have fallen inside the machine.

3. Use dry, compressed air to remove all dust and debris from the 
work surface and from under the machine.

4. Dust the safety shields, inside and outside, with an antistatic 
cleaner.

5. Wipe the top and side panels to remove grease, fingerprints, and 
dust.

6. Dust the top surfaces of the input/output modules.

Cleaning the Vision Camera Lens
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WARNING:  Vision hazard. Always use care and wear protective 
eye goggles when cleaning with pressurized air. Pressurized air or 
debris blown into the eyes or skin could cause bodily damage.

1. Use dry compressed air to remove all dust and other foreign 
material from the camera lens.

2. Shut off power to the PS Machine. For more information see 
Turning Off the System on page 4-4.

WARNING:  Electrocution hazard! Turn off the main power switch 
before opening any cabinet doors or removing any panels. Servic-
ing the PS Machine involves a risk of electric shock if warnings are 
not followed. 

3. Open the right side access door and clean the lens using a lens 
soft cloth or lens cleaning tissue. If desired, dampened material 
with isopropyl alcohol.

PNP Probe
The workspace PNP head has a Probe which requires periodic main-
tenance. The headings below describe maintenance for this Probe, as 
well as for the PNP head Probe on the optional Tape Output Module 
if this has been installed.

Checking the Probe Tip
Worn or damaged probe tips on the PNP head or on the Tape Output 
PNP head (if installed) can cause dropped devices and placement 
problems.

1. Check the rubber probe tips for cracks or tears in the rubber. If 
necessary, replace with a probe tip of the same size.

2. Test the probe tip—
2a. At the Setup window, click System > Gantry.
2b. Click the Vacuum switch to ON.
2c. Push the E-Stop.
2d. Place a device on the target probe.
2e. If the vacuum does not firmly hold the device, replace the probe 

tip with a probe tip of the same size.

Checking the Probe Assembly 
(2009 and newer models)
Check that it is not loose. Tighten the set screw on the breakaway 
stem. If you suspect or hear an air leak:

1. Remove the set screw on the breakaway stem.

Parts of a probe tip 
are: 
• Steel breakaway tip 
or stem 
• Steel nozzle
• Rubber cup or tip
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2. Pull off the breakaway stem and check the O-ring. Replace if 
necessary. 

3. Reassemble.

Cleaning the Probe Tip
To clean the Probe tip:

1. Move the PNP head to a convenient position by clicking one of 
the yellow labels on the Gantry Window.

2. Push the E-Stop.
3. Wipe the tip with a damp cloth. (Do not use alcohols or sol-

vents.)

Note: Do not touch the probe tip. Finger oils can cause small 
devices to stick.

Adjusting Probe Blow-Off Pressure

Note:  The flow controls are set at the factory and should not 
require adjustment. If adjustments need to be made, they should be 
done in small steps until the desired results are reached. 

Blow-off  is a small puff of air applied at the probe during the device 
drop event to assist in removing a device from the probe. Blow-off is 
produced by a vacuum generator on the PNP head (and at the Tape 
Output PNP head, if Tape Output is present). If set too high, blow-off 
could cause device misalignment during  placement.

To adjust blow-off pressure on any vacuum generator:

1. Preparation—
1a. At the I/O Interface Window (System > Misc. I/O), select the 

desired vacuum generator.

Figure 4-8:  The System Window is a menu to many subsystems
including Shuttle/Options.
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1b. Click Vacuum to the OFF position. 
1c. Click Blow-off to the ON position.

Figure 4-9:  Vacuum (shown OFF) and Blow-off (shown ON) on the
I/O Interface Window.

2. Vacuum generator—
2a. On top of the vacuum generator, locate the blow-off adjustment 

screw above the valve coils (where the wires plug in). See Figure 
4-10. The vacuum generator block at the main PNP head will 
need to be removed for access. 

Figure 4-10:  The Blow-off adjustment screw on PNP head vacuum
generator.

3. Adjust—
3a. Turn the adjustment screw in fully clockwise. This blocks all air 

and there is no blow-off (puff of air) at the PNP probe.
3b. Turn the adjustment screw 1/2 turn counterclockwise.

For instructions to remove the 
Vacuum Generator at the 
main PNP head see Vacuum 
Generator Filters and Silenc-
ers on page 4-15.
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Checking the Automatic Tray Feeder
[TF20 Tray Feeder only]

1. Stop or Pause a job if one is running.
2. Check the automatic Tray Feeder for damaged or broken parts 

and replace as necessary.
3. Visually inspect the conveyor belts for dirt, nicks, or other signs 

of damage. 
4. If the conveyor belts are dirty, clean with dry, compressed air 

and wipe with a dry, lint-free cloth and isopropyl alcohol.
5. Check the urethane pinch roller attached to the tray clamping 

mechanism for signs of wear or damage. Replace as necessary. 
Clean with a dry, lint-free cloth and isopropyl alcohol.

Replacing the Input Air Filter
1. Shut off shop air and disconnect the input air line from the Air 

Filter/Regulator. 
2. Unscrew the air contamination col-

lection bowl housing.
3. Pull off the clear collection bowl. 

Clean out any dirt, oil, or water.
4. Unscrew the black knob below the 

filter.
5. Pull off the filter. Clean or replace 

as necessary.

Reinstall in reverse order being careful 
not to damage the O-ring on the bowl.

Reconnect the shop air supply line.

Figure 4-11:  Replacing the Air Filter/Regulator.

Vacuum Generator Filters and Silencers
This procedure covers removing and cleaning or replacing vacuum 
generator parts for all vacuum generators on the PS Machine. 

For more information see 
the Tray Feeder manual that 
came with your system.

Filter

Knob

Bowl

Bowl 
hous-
ing
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PNP head: A clogged or dirty vacuum filter or silencer at this 
vacuum generator can cause dropped devices and placement 
problems at the PNP head. 
Marking System: [Marking option] Two vacuum generators in 
the Option Bay must be clean to ensure devices stay on the 
marking shuttle.
Tape Output: [Output option] A clogged or dirty vacuum filter 
or silencer at this vacuum generator can cause dropped devices 
at the PNP Taping Head on the Tape Output Module. 

1. Preparation—
1a. Use the Gantry Window to move the PNP head to an accessible 

location.
1b. Shut off the PS System power and ensure the main power switch 

is in the OFF position. See Turning Off the System on page 4-4.

WARNING:  Electric shock hazard. Shut off the PS System by 
switching off the main power switch before working on or near 
the PNP head, before opening any access doors or removing any 
cabinet panels.

1c. Remove the two Vacuum Generator mounting screws with a 
7/64 in. hex key and be ready to support it as it falls free. See Fig-
ure 4-12 below.

2. Check silencer and filter—
2a. Push the silencer out of the vacuum generator block (either 

direction). If dirty or clogged, replace with new silencer 
(Data I/O part number 288 5500 902). See the figure below.

2b. Unscrew the black knob on top the vacuum block and remove 
the filter. It should be white or nearly white. If dirty or clogged, 
replace with new filter (Data I/O part number 288 5500 901). See 
the figure below.

Figure 4-12:  Removing the PNP head Vacuum Generator filter and
silencer. The two small arrows point to the Mounting screws.

Filter knob

Silencer

Filter
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3. Reinstall Vacuum Generator—
3a. Reinstall the generator (after installing a filter and silencer).
4. [Marking System only] Repeats steps 1b through 3a above for 

two more Vacuum Generators mounted inside the Option Bay 
under the laser support plate. See figure below.

Figure 4-13:  Two Vacuum Generators on the Laser Marker. Arrows
point to the filters. Two screws secure both Vacuum block (circled).

Note: The Tape-Output has a Data I/O-installed PNP Taping 
Head.

5. [Tape Out Module only]  Remove the front panel of the box 
supporting the Tape Out Module (1/8 inch Hex Key) and then 
repeat steps 1b through 3a above for the additional Vacuum 
Generator mounted inside the control box. See figure below.

Figure 4-14:  A Vacuum Generator on the TM50 Taping Module. The
front panel has been removed with a 1/8 in. hex key (six SHCS).
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Adjusting the Vacuum Generator 
Sensors

Note:  If you notice consecutive programming pick errors, before 
adjusting vacuum sensors complete the Z-Axis adjustment. For 
instructions on Z-Axis adjustment, see Teaching the Package File 
on page 3-40. If completing the Z-Axis adjustment does not reduce 
or eliminate subsequent pick errors, complete the vacuum sensor 
adjustments described here.

Vacuum sensors on the PS System are adjustable. The I/O Interface 
window displays a list of the sensors in the PS System and the status 
of each sensor. 

Note:  The number of sensors on the PS System depends on the 
options installed. 

To view the status of sensors at the main AH500 Setup window, click 
System > Misc. I/O.

Figure 4-15:  The I/O Interface window reports sensor status and allows
switching options on or off. PS588 shown.

Sensor Locations
 • PNP Head Vacuum Generator Sensor: 

An adjustable vacuum generator sensor on the PNP head con-
trols probe vacuum. See heading below.

 • [Laser Marking or Tape Output only] Shuttle Pedestal 1 and 2 
Vacuum Generator Sensors on page 4-21: 
Either of these options on your PS Machines include adjustable 
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vacuum generator sensors for the Shuttle Transfer System con-
trolling vacuum at the shuttles.

 • [Tape Output only] Tape Output PNP Head Vacuum Generator 
Sensor on page 4-23. The adjustable vacuum generator sensor on 
the Tape Output PNP head controls vacuum at the probe. 

PNP Head Vacuum Generator Sensor
To adjust the PNP head vacuum generator sensor:

1. Gantry Window—
1a. On the Gantry Window, move the PNP head to either the Tape 

or Vision location. 

Note:  To move the PNP head, tap the Tape or Vision label on the 
monitor or use the touch pad and left touch pad button .

1b. Click the Gantry Vacuum switch to ON.
1c. Push the E-stop.

CAUTION:  Collision hazard! The high speed and force behind a 
moving gantry can cause serious bodily injury to anyone working 
inside the work envelope. Ensure that a job is Paused, the Emer-
gency-Stop is pushed, or the power is off prior to opening work-
space doors.

2. Vacuum sensor—
2a. Open the workspace door.
2b. On the vacuum generator sensor, locate the adjustment screws 

labeled HYS and SET. Locate the red sensor light. See Figure 
4-16.



Maintenance  ■  Workspace, Head and Gantry

4—20 Data I/O • 981-0424-002

back

Figure 4-16:  The PNP Probe vacuum generator adjustments. Your
PNP head may not look like this.)

3. Adjust the HYS and SET screws—
3a. Locate the HYS and SET screws on the vacuum generator block. 

Using a small flat screwdriver, turn the hysteresis adjustment 
(HYS) screw all the way counterclockwise.

3b. Then rotate the SET adjustment screw counterclockwise until 
the red sensor light comes on.

3c. Then rotate the SET screw clockwise just until the red light goes 
off. 

3d. Finally rotate the SET screw another 1/8th revolution clockwise.

4. Check adjustments—
4a. Block the hole on the PNP probe with a device. The red sensor 

light should come on immediately.
4b. Unblock the hole. The red sensor light should go off immedi-

ately. 

5. Repeat—
5a. Repeat Step 4 three times to ensure the red sensor light goes on 

and off as described. 
5b. If the red sensor light does not go off and on properly, rotate the 

SET screw slightly clockwise and retry. 

Note: IF the PS System displays a vacuum error, it may be due to 
the vacuum generator’s inability to sense a vacuum within the time 
limits set in the AH500 software. 

The hysteresis delay should be set as short as possible to prevent the 
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SW from timing out. However, if the hysteresis delay is set too 
short, vacuum line pulsations from usage throughout the system 
could inadvertently switch the sensor on when it should be off. 
Adjustments should be made to accommodate both conditions.

Shuttle Pedestal 1 and 2 Vacuum Generator Sensors
[Laser Marking or Tape Output only]

1. Preparation—
1a. On the back of the PS System, turn the SERVOS circuit breaker 

OFF.
1b. Remove the lower right access cover of the Option Bay and set 

aside. See Figure 4-13 on page 4–17.
1c. At the SYSTEM window, click Shuttle/Options.

2. Switch Ped 2 Vacuum ON—
2a. At the Shuttle tab, click GO next to Ped 2 Load Pos. Then click the 

Ped 2 Vacuum to ON. See Figure 4-17.
.

Figure 4-17:  The Shuttle Tab of the Shuttle/Options Window. PS588
shown.

Note:  Refer to Figure 4-18 for Step 3 through Step 5. 

3. Adjust Pedestal [2] HYS and SET screws—
3a. Locate the HYS and SET screws on the vacuum generator block. 

Using a small flat screwdriver, rotate the hysteresis (HYS) screw 
all the way counterclockwise. See Figure 4-18.

3b. Then rotate the SET screw counterclockwise until the red vac-
uum sensor lamp comes on.

3c. Then rotate the SET screw clockwise until the lamp goes off. 
3d. Finally rotate the SET screw another 1/8th revolution clockwise.
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4. Check adjustment—
4a. Block the hole on the shuttle pedestal with a device. The red vac-

uum sensor lamp should come on immediately.
4b. Unblock the hole. The red vacuum sensor lamp should go off 

immediately. 
4c. Repeat check to ensure the red vacuum sensor lamp goes on and 

off as described. 
4d. If the red vacuum sensor lamp does not go off and on properly, 

rotate the SET screw slightly clockwise and retry.

Note: If the PS System displays a vacuum error, it may be due to 
the vacuum generator’s inability to sense a vacuum within the time 
limits set in the AH500 software. 

The hysteresis delay should be set as short as possible to prevent the 
SW from timing out. However, if the hysteresis delay is set too 
short, vacuum line pulsations from usage throughout the system 
could inadvertently switch the sensor on when it should be off. 
Adjustments should be made to accommodate both conditions.

5. Switch Ped 1 Vacuum ON—
5a. At the Shuttle tab, click Ped 2 Vacuum to OFF.
5b. Click Ped 1 Vacuum to ON.

6. Adjust Pedestal 1 HYS and SET screw—
6a. Repeat Step 3 and Step 4 for Pedestal 1.

Figure 4-18:  Pedestal 1 and Pedestal 2 vacuum generator adjust-
ments. Pedestal 1 vacuum generator is on top.
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7. Shuttle tab—
7a. At the Shuttle tab, click Ped 1 Vacuum to OFF.
7b. Click Ped 2 Vacuum to OFF.

8. Reinstall the access cover on the Option Bay.

Tape Output PNP Head Vacuum Generator Sensor
[Tape Output only] 
If your system includes the optional Tape Output System, you will 
also need to adjust the vacuum generator sensor on the Tape Output 
PNP head.

1. Preparation—
1a. On the PLC Controller, switch the Apply Vacuum toggle to the 

ON (up) position. See Figure 4-19.

Figure 4-19:  Apply Vacuum switch: UP is on.

1b. With a 1/8 inch Hex Key, remove the front panel by removing 
the six SHCS (Socket Head Cap screws).

Figure 4-20:  Tape Output vacuum generator adjustments.

2. Adjust the HYS and SET—
2a. Locate the HYS and SET screws on the vacuum generator block. 

See Figure 4-20. Using a small, flat screwdriver, rotate the hyster-
esis (HYS) screw counterclockwise.

A

A

A-A
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2b. Then rotate SET screw counterclockwise until the red vacuum 
sensor lamp comes on. 

2c. Then rotate the SET screw clockwise until the lamp goes off.
2d. Finally rotate the SET screw another 1/8th revolution clockwise.

3. Check adjustments—
3a. Open the plastic cover on the Tape Output System and block the 

air hole at the Tape-Output-PNP head probe wit a device. The 
red vacuum sensor lamp should light immediately.

3b. Unblock the hole. The red vacuum sensor lamp should extin-
guish immediately. 

4. Repeat—
4a. Test several times to ensure the red vacuum sensor lamp lights 

and dims as described. If the red vacuum sensor lamp does not 
go off and on properly, turn the SET screw clockwise a few 
degrees and retry.

5. Complete—
5a. Close the clear plastic cover.
5b. Replace the front panel.

Note: If the PS System displays a vacuum error, it may be due to 
the vacuum generator’s inability to sense a vacuum within the time 
limits set in the AH500 software. 

The hysteresis delay should be set as short as possible to prevent the 
software from timing out. However, if the hysteresis delay is set too 
short, vacuum line pulsations from usage throughout the system 
could inadvertently switch the sensor on when it should be off. 
Adjustments should be made to accommodate both conditions.

Inspecting Gantry Parts

Checking the PNP Head and Gantry Wiring Harnesses

1. Check—
1a. Switch the PS System  main power switch OFF. Verify that the 

main power switch is in the OFF position.
1b. Check the retaining clips on the two DB25 connectors plugged 

into the PNP head. They slide back (away from the operator) to 
release. Make sure they are slid forward. See Figure 4-21.
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Figure 4-21:  PNP head sliding retaining clips.

1c. Check gantry wiring harness plug connections and make sure 
that they are secure. See Figure 4-22.

Figure 4-22:  Three electrical connections on the Vacuum Generator.

Inspecting Gantry Cable Carriers

1. Clean—
1a. Use dry compressed air to remove all foreign material from the 

cable carriers.

2. Check—
2a. Visually check that the cables are  in good condition, and are not 

too loose or too tight.
2b. Check by hand that the upper end of the upper carrier is tight. If 

not, tighten the two mounting screws. Cable ties may need to be 
cut to move the cables out of the way. See Figure 4-23.
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Figure 4-23:  Looking up from the back of the system, the upper end of
the upper cable carrier is screwed to the frame.

2c. Check the two screws on the lower end of the lower cable carrier 
and tighten if necessary. See Figure 4-24.

Figure 4-24:  The lower end of the lower cable carrier: A- from above,
and B-from below.

2d. Check the four screws on the center carrier and tighten if neces-
sary. See Figure 4-25.

A B



■ Workspace, Head and Gantry ◘ Inspecting Gantry Parts

PS Series Owner’s Manual 4—27

back

Figure 4-25:  The two cable carriers meet at a bracket at the back of
the PS System. There are two screws for each carrier end. View looking

upward from the back of the machine.

Lubricating the Gantry Lead Screw

WARNING:   Electric shock hazard. Shut off the PS System power 
(Turning Off the System on page 4-4) — switch off the main 
power switch before removing the lead screw shields.

1. Preparation—
1a. Shut off the PS System power and ensure the main power switch 

is in the OFF position.
1b. Remove the screws that hold the Lead Screw Shield to the gantry 

rails.
1c. Remove the shield.

2. Remove the old grease and dirt build up from the lead screw 
using shop towels.

3. Apply new grease—
3a. Apply NSK Grease (or equivalent) to the lead screw grease fit-

ting using an MG70 (or equivalent) grease gun. See Figure 4-26. 

Note: Too much grease may cause grease to splatter inside the work 
envelope. Do not over-apply the grease. 
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Figure 4-26:  Grease fitting

4. Reinstall the Lead Screw Shield.
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Programmers

FlashCORE Programmers Diagnostics
To optimize programming yields, voltages within the FlashCORE 
programmer need to be calibrated once each year. 

Tools required:
 • Diagnostic Adapter Board (DAB), Data I/O part number 

910-2200-003 (or higher).

This Diagnostic Adapter Board detects problems related to Flash-
CORE programmers hardware failure. The DAB tests the Waveform 
Circuit Board and Backplane Circuit Board. The DAB can also be 
used to locate problems that have not yet shown symptoms. 

Data I/O suggests performing the programmer diagnostic test annu-
ally. This DAB requires a minimum firmware version 03.00.00.C.

The DAB performs these nine tests:
 • Bus Test
 • Adapter ID Test
 • LED Driver Test
 • G Node Test
 • Vcc Overcurrent Test
 • Vpp Overcurrent Test
 • I2C Bus Test
 • DAC Calibration Test
 • Gslew Test

To run diagnostic tests on FlashCORE programmer(s):

1. Preparation—
1a. Switch the programmer circuit breaker at the Power panel OFF 

(down position). 

WARNING:   ESD hazard. To prevent ESD shock, before you touch 
the Socket Adapter, discharge static electricity from yourself by 
touching a common ground or an unpainted metal surface. 

When at the PS Machine, always wear a wrist strap containing a 
1 M-ohm min. to 10 M-ohm max. current limiting resistor. Connect 
the antistatic wrist strap to the grounding socket on the front (or 
back) of the PS Machine. 

What’s the difference 
between a FlashCORE pro-
grammer and a Universal 
programmer? See Pro-
grammers on page 1-13.
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1b. Remove the Socket Adapter from the target programmer and 
insert the Diagnostic Adapter Board, ensuring that it aligns cor-
rectly on the adapter pins. Screw down the two bracket screws.

1c. Switch the programmer circuit breaker at the Power panel ON 
(up position).

2. TaskLink—
2a. Start TaskLink and click Tools  > Run Programmer Diagnostics.
2b. On the Diagnostics Window, select the programmer with the 

DAB installed.
2c. Click Test All.

The pass/fail test results are displayed in TaskLink and are also 
written to /fdrroot/system/diaglog.txt and 
/fdrroot/system/eventlog.txt files on the PC card of the target 
FlashCORE programmer. These files can be viewed in TaskLink and 
saved (on the Handler Computer). 

If any of the tests show Fail in the TaskLink display, contact your 
nearest Data I/O Service Center for repair options. To help our service 
personnel diagnose the problem, please e-mail both the 
eventlog.txt and 
diaglog.txt files.

Sample dialog.txt file:

Diagnostic Pass #1
Run Vpp Overcurrent test.
DUT 1 G1 Vpp overcurrent is sensed at 57 mA.
DUT 1 G2 Vpp overcurrent is sensed at 57 mA.
DUT 1 G3 Vpp overcurrent is sensed at 57 mA.
DUT 1 G4 Vpp overcurrent is sensed at 57 mA.
DUT 2 G1 Vpp overcurrent is sensed at 57 mA.
DUT 2 G2 Vpp overcurrent is sensed at 57 mA.
DUT 2 G3 Vpp overcurrent is sensed at 57 mA.
DUT 2 G4 Vpp overcurrent is sensed at 57 mA.
Error: DUT 3 G1 Vpp overcurrent is not sensed from 50 mA to 70 mA.
Error: DUT 3 G2 Vpp overcurrent is not sensed from 50 mA to 70 mA.
Error: DUT 3 G3 Vpp overcurrent is not sensed from 50 mA to 70 mA.
Error: DUT 3 G4 Vpp overcurrent is not sensed from 50 mA to 70 mA.
DUT 4 G1 Vpp overcurrent is sensed at 57 mA.
DUT 4 G2 Vpp overcurrent is sensed at 57 mA.
DUT 4 G3 Vpp overcurrent is sensed at 57 mA.
DUT 4 G4 Vpp overcurrent is sensed at 57 mA.
Diagnostics failed

Removing a Programmer
The following two headings describe programmer removal: the first 
is for FlashCORE programmers and the second for Optima (Uni-
versal) programmers. For FlashCORE programmers, differences are 
noted between PS288, PS388 and PS588.

How do I tell what pro-
grammer I have? See 
Programmers on page 
1-13.
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Removing a FlashCORE Programmer

Note: Replacing a FlashCORE programmer with a new one 
requires TaskLink to update the firmware to the same version as the 
other programmers and to update the date and time. These steps are 
included below.

To replace an individual FlashCORE programmer assembly:

1. Preparation—
1a. Switch the PS System power off at the main power switch. 

Ensure the switch is in the OFF position.
1b. Open the outer access door closest to the target FlashCORE pro-

grammer assembly.

2. Disconnect—
2a. Disconnect the power cable from the bottom of the FlashCORE 

programmer assembly after cutting the tie wrap. There is only 
one power cable for each assembly whether a single, a dual, or a 
quad assembly.

2b. Disconnect the communications cable from the network connec-
tion on each programmer of the target assembly.

Note:  There are two network connections on the FlashCORE pro-
grammer assembly. Use the one with LEDs.

Figure 4-27:  FlashCORE Programmer connections: the power cable
(arrow) and the communication cables (circled).
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CAUTION:  Pressurized air hazard. The main air line is connected 
and ON. If the wrong air fitting is disconnected, the tube will fly 
about until the main air valve at the back of the machine is 
switched off. For the correct programmer connector, see Figure 
4-28.

2c. [PS588 only]  Disconnect the air hose by unscrewing the pro-
grammer-side of the automatic shut-off union shown in the fig-
ure below. 

WARNING:  Pressurized air hazard. If your model does not have 
the inline, automatic shut-off union shown in Figure 4-28, then 
switch off (or disconnect) the main air supply at the Power Panel 
before disconnecting any air lines.

Figure 4-28:  [PS588 only] Unscrew the black collar on the air fitting as
shown.

3. Remove programmer assembly—
3a. Remove the three mounting screws (single) or five mounting 

screws (dual) that hold the FlashCORE programmer assembly to 
the top plate with a 1/8 inch hex key.

3b. Carefully lift out the FlashCORE programmer assembly.

4. Installing—
4a. Install a new FlashCORE programmer assembly in reverse order 

of removal.

5. Update firmware—
The newly installed FlashCORE programmer assembly must be 
located and assigned a site number with TaskLink. Once the site 
is assigned, firmware on the new FlashCORE programmer 
assembly must be updated from TaskLink. 

6. Update programmer date/time—
This TaskLink feature sets the date and time on each connected 
FlashCORE programmer so that the Log files report accurate 
time and date information. See TaskLink’s on-screen Help for 
information on how to view log files.

Disconnect air 
here . . .

. . . NOT here.
see Caution 
note 

For information about 
updating firmware see 
TaskLink’s on-screen Help. 

For information on setting 
programmer date and 
time, see TaskLink’s 
on-screen Help. 
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[PS588 only] Removing an Optima (Universal) 
Programmer
To replace an individual Optima programmer assembly:

1. Preparation—
1a. Switch the PS588 power off at the main power switch. 
1b. Lift the Socket Adapter off the programmer if there is one.
1c. Open the outer access panel closest to the target programmer.

2. Disconnect—
2a. Remove the parallel cable by unscrewing the two small, captive 

screws. 
2b. Remove the second cable by unscrewing the connector and pull-

ing off.

Figure 4-29:  Optima (Universal) Programmer Cables.

3. Unscrew and remove—
3a. Unscrew the screws mounting the programmer to the work sur-

face (there are four or six, depending on programmer) with a 
1/8 inch hex key.

3b. Carefully lift out the assembly.

4. Installing—
4a. Installation is in reverse order of removal. Orient the program-

mer with the PCB on the outboard side of the PS588 center line.
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The Marking Systems and Shuttle
[Label or Laser Marking only]  Laser Marker and Label Marker Sys-
tems are optional equipment on your PS Programming System. Your 
PS Machine may not have either. Each marking system requires some 
maintenance. Both have a computer with filter, and both have a 
marker Shuttle Assembly. The Tape Out System also uses a Shuttle 
Assembly. In addition, Laser Markers have fume extractors.

The Shuttle Assembly
Whether you have a Laser Marker or Label Marker System, Shuttle 
Transfer Assemblies attached to a belt transport devices to and from 
the marker. The Shuttle Assembly requires periodic maintenance.

Cleaning the Shuttle Assembly
During extended or heavy periods of use, the shuttle assembly may 
become dirty and gummed up by laser dust or other foreign material. 
This situation may cause the shuttle assembly to stall during move-
ment to and from the laser mark position.

WARNING:  Electric shock hazard. Shut off the PS System (Turn-
ing Off the System on page 4-4) and switch off the main power 
switch. 

Hazardous materials: Do not use compressed air to remove laser 
dust. Wear safety goggles and disposable protective gloves. 

To clean the laser marker shuttle assembly:

1. Preparation—
1a. Shut off the PS System power and ensure the main power switch 

is in the OFF position.
1b. Put on safety goggles and disposable protective gloves.
1c. Remove the upper left Option Bay panel (1/8 in. Hex Key) to 

access the laser housing. See Figure 4-30. Remove Option Bay 
panels as needed for cleaning the laser marking system.

The Shuttle Assembly 
information here also 
applies to systems 
with the optional Tape 
Output. Other Tape 
Output information 
can be found later in 
this chapter.
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Figure 4-30:  Left end of the laser housing with lens. The Option Bay left
side panels have been removed.

2. Clean—
2a. Use a damp paper towel and antistatic cleaner to wipe laser 

marking dust and other foreign material from the housing into a 
sealable plastic bag. 

2b. Clean the shuttle track using a lint-free cloth.
2c. Place paper towels, cloth, and protective gloves into a sealable 

plastic bag. Seal the bag and dispose of as hazardous waste. 
Remove safety goggles. 

WARNING:  Numerous government regulations apply to the stor-
age of hazardous waste. Ensure that contaminated filters are 
properly labeled and stored in your hazardous waste storage 
area. Also, make sure that they are not stored on your site longer 
than government regulations allow (the typical limit is 90 days). 
Check your government (local, state, and federal) regulations for 
hazardous waste storage requirements.

3. Lubricate—
3a. Lubricate the bearing block and shuttle track with Tri-Flow 

lubricant. 

Note:  Use a small amount of lubricant, just enough to allow the 
bearing block to move freely on the track. Too much lubricant will 
aid in the build up of contamination and cause stalling.

4. Reinstall—
4a. Reinstall all Option Bay panels.
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Adjusting Shuttle Belt Tension
[Label or Laser Marking only]

CAUTION:  Health hazard. The Laser Marking System should be 
cleaned as described in The Shuttle Assembly on page 4-34 prior 
to performing work.

WARNING:  Electric shock hazard. Shut off the PS System  main 
power switch before removing any panels. 

1. Preparation—
1a. Shut off the PS System power and ensure the main power switch 

is in the OFF position. For more information see Turning Off the 
System on page 4-4.

1b. Remove the upper left Option Bay panel.

2. Check the belt for wear and replace if necessary.

Figure 4-31:  Marker Shuttle belt and motor, with Tape Out (A) and
without (B).

3. Test the tension by pulling lightly on the center of the shuttle 
belt to the right of the motor. See Figure 4-31. If the belt moves 
more than 12 mm (0.5 inch) off its path, loosen the four motor 
mounting plate screws with a 4 mm hex key (see Figure 4-32), 

Test tension here

A

B
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and then push the motor away from the belt until the belt move-
ment is less than 12 mm.

Figure 4-32:  Location of four motor mounting plate screws.

3a. If the belt still moves more than 12 mm (0.5 inch), remove it and 
cut off as many links as needed to achieve the proper tension.

3b. Replace the belt and tighten the four motor mounting screws.

4. Check the belt sprocket set screws—
4a. Check the belt sprocket set screws and tighten if necessary. 
4b. If a sprocket has loosened and is rubbing against the frame, 

reposition the sprocket up off the frame and tighten the set 
screw.

4c. Reinstall all panels.

Replacing a Shuttle Belt
[Label or Laser Marking, or Tape Out]  If the shuttle belt looks worn, 
it should be replaced.

CAUTION:  Health hazard. The Laser Marking System should be 
cleaned as described in Cleaning the Shuttle Assembly on page 
4-34 prior to performing work.

WARNING:  Electric shock hazard. Shut off the PS System power 
(see Turning Off the System on page 4-4) —switch off the main 
power switch before removing any panels.

1. Preparation—
1a. Shut off the PS System power and ensure the main power switch 

is in the OFF position.
1b. Remove the upper, left Option Bay panel.

2. Relieve belt tension—
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2a. Loosen the four motor mounting plate screws. See Figure 4-32 
above.

2b. Pull the motor toward yourself to reduce belt tension.

3. Remove the shuttle
3a. Rotate the belt until the shuttle is accessible and unscrew the two 

SHCSs (socket-head cap screws) on the inboard side of the car-
riage clamp (2 mm Hex Key).

4. [Tape Output only] Remove the belt cover.
4a. Unscrew three SHCSs attaching the Tape Out belt cover to the 

Option Bay (1/8 in. Hex Key). See Figure 4-33.

Figure 4-33:  Shuttle Belt cover screws [Tape Output only].

4b. Viewing the 
belt cover 
from the 
Taping Sys-
tem Opera-
tor’s view, if 
you see two 
screws on 
the left side 
of the cover 
skip the next 
step. 
If you see 
two screws 
on the right 
side of the cover (as shown in the figure above), continue.

4c. (Some assemblies only) Unscrew two SHCSs mounting the Tape 
Out PNP head Assembly to the Option Bay for access to more 
cover screws (3/16 inch Hex Key). See Figure 4-34. Without dam-
aging the probe, slide the bracket outboard and tip it out of the 
way. (Wires are still attached.)
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Figure 4-34:  Bracket support fasteners for the Tape Output Head
Assembly.

4d. Remove two screws in the side of the cover (5/64 inch Hex Key) 
and lift off the cover.

5. Remove the belt—
5a. Remove the belt by gently pulling one end completely out of the 

shuttle transfer assembly.

6. Install a new belt—
6a. Using the old belt as a template, cut the new belt to the same 

length. 
6b. Route the new belt through the shuttle transfer assembly as 

shown in Figure 4-35. Make sure all sprocket teeth mesh with 
the holes in the belt.

Figure 4-35:  The shuttle belt routing for systems with a marking
option, with and without the Tape Output option.

6c. Connect the belt ends to the shuttle clamp as shown in Figure 
4-36. Ensure that the teeth on the shuttle clamp are engaged with 
the holes on the belt. If the belt is too long, cut off excess length. 
Re-attach the shuttle clamp to the shuttle.

Data I/O Part Number for 
the Shuttle Belt is 
264-0009-001 or higher: 
• 1.8 M (6 feet) for Option 
Bay with Tape Output Mod-
ule. 
• 1.5 M (5 feet) for Option 
Bay with Marker only (no 
Tape Output).

Toward PS Machine operator

 Without Tape Output

With Tape Output 
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Figure 4-36:  Clamping the belt to the shuttle.

6d. Check belt tension and adjust if necessary as described in Adjust-
ing Shuttle Belt Tension on page 4-36.

7. Reinstall—
7a. [Tape Output only] Reinstall the belt cover by installing the 

three screws inside the Option Bay (before the other two). 
Ensure that the shuttle flag shown in the figure below does not 
hit the belt cover flange when it moves past the cover.

Figure 4-37:  The shuttle flag (tinted blue here) must clear the flange on
the belt cover (arrow).

7b. Reinstall the two other cover screws.
7c. (If applicable) reinstall the Tape Output Head Assembly sup-

port.
7d. Reinstall the Option Bay panel.

Cleaning the Shuttle O-Rings
[Laser Marking and Tape Output only]  The Shuttles used for Laser 
Marking and for Tape Output use O-ring seals. Dirty seals may leak 
enough air that devices fall from the shuttle. Cleaning intervals 
depend on amount of use. 

To clean the seals:

1. Move the shuttle to the PS work area—

Prior to reinstalling the 
Option Bay cabinet panels, 
you may wish to clean or 
replace the shuttle O-rings. 
See step 2 of Cleaning the 
Shuttle O-Rings on page 
4-40 or Replacing the 
Shuttle O-Rings on page 
4-41.
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1a. (This requires a Laser Marker to be selected in your 
winAH400.ini file.)Open TaskLink and select a task with the 
Laser Marker option and click Run. Follow on-screen dialogs. 

1b. After the AH500 Application opens, click Start, then System. 
You may need to enter a password.

1c. Click Shuttle/Options.
1d. Click the Go button adjacent to the PED 2, Load Pos.

2. Cleaning the O-rings
2a. Push the Emergency-Stop. 
2b. Open a workspace door and wipe the O-rings with a damp 

cloth. (Don’t use alcohols or solvents.)

Replacing the Shuttle O-Rings
To replace the shuttle O-rings:

1. Follow the steps to clean the O-rings (above).
2. Pull the O-ring off each shuttle cup nipple and push the new 

O-ring on. Ensure that the O-ring is higher than the metal nip-
ple. 

Laser Marking Filters
[Laser Marking only] The Laser Marking System has a total of five 
filters spread among two locations. In some PS Machines with Laser 
Marking, there is a Laser Computer computer— it has a small air 
filter requiring minimal care. And on all models with Laser Marking 
have a fume extractor with four filters stacked inside one extractor 
housing. The fume extractor filters require special safety precautions 
as noted in the following instructions. The fume extractor and the 
laser computer are both inside the Option Bay.

Removing the Fume Extractor Filters
[Laser Marking only]  The Handler Computer software monitors the 
air flow sensor on the laser filter system. If the sensor detects low air 
flow, an error message is displayed on the PS Monitor: 

Insufficient airflow at laser filter. 
Verify that the filter is turned on.
   Service might be required.

When this error message (above) displays, the laser system will mark 
up to ten more devices (as defined in the winAH400.ini file) before 
the message displays again. 
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Figure 4-38:  Fumex Laser Marker vacuum filter stacking order.

WARNING:  Health hazard. Failure to replace the laser vacuum 
filters at the required intervals could create a hazardous operat-
ing environment.

WARNING:  Hazardous Materials. This procedure involves expo-
sure to hazardous by-products from the laser marking process. 
Some device material may be carcinogenic.

Perform the following procedure only if you have successfully 
completed a training class regarding laser etching processes or 
handling hazardous materials.

Tools Required
 • sealable plastic bag (approximately. 1 cu. M)
 • protective gloves and goggles
 • Optional, a particle (dust) mask
 • Hex Keys

To replace the Fumex filters:

1. Preparation—
1a. Shut off PS System power and ensure the main power switch is 

in the OFF position. See Turning Off the System on page 4-4.

Air flow

Pleated filter

Carbon filter

Pre-filter

HEPA filter
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1b. If the machine also has a Tape Output Module, screw the feet on 
the black legs up so they don’t contact the floor.

1c. Remove lower back laser housing panel from the laser enclosure 
by removing the six or eight screws—depending on whether a 
Tape Output Module is installed. See Figure 4-39. 

Figure 4-39:  The lower back laser housing panel screw locations,
shown here with legs for the optional Tape Output module.

1d. Remove side laser housing panel by removing the four screws. 
See Figure 4-40.

WARNING:   Hazardous materials. Wear safety goggles and dis-
posable protective gloves. Do not clean the laser vacuum filters by 
blowing with compressed air, shaking, or using any method that 
allows the particulate trapped by the filters to be released into 
the work environment.
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Figure 4-40:  The lower, side laser housing panel and screw locations.

1e. Put on the disposable protective gloves and the safety goggles. 
Open the sealable plastic bag.

2. Detach vacuum hose—
2a. Loosen the clamp holding the vacuum hose to the extractor top 

and detach the vacuum hose from the extractor top. See Figure 
4-41.

Figure 4-41:  The Vacuum hose clamp.

3. Release the four spring clips (one on each side except on early 
models) securing the extractor top to the filter system. Pull the 
extractor top up hard to release it.
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Figure 4-42:  One of the spring clips securing the extractor top. Also, the
Fumex care label.

4. Remove the filters—
4a. Lift off the Pre-filter. Inspect and clean or replace with a new one 

as necessary. If replacing it, place the used one in the sealable 
bag.

4b. Unscrew the two thumb knobs and lift the pleated filter out with 
the frame. See Figure 4-43. Inspect and clean or replace with a 
new one as necessary. If replacing it, place the used one in the 
sealable bag.

Figure 4-43:  Knurled knobs release the pleated filter. The Pre-filter  has
already been removed.

Data I/O Model Names 
for ordering are:
• Pre-Filter, Polyester.
• Filter, Panel, Pleated
• Filter, HEPA, Particle, BD 
Frame
• Activated Carbon Cell, 
3lb NET
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4c. Lift out the HEPA filter. Inspect and replace as necessary. Inspect 
and clean or replace with a new one as necessary. If replacing it, 
place the used one in the sealable bag.

4d. Lift out the carbon. Replace with a new one as necessary. If 
replacing it, place the used one in the sealable bag.

4e. Place your gloves in the bag and seal the bag and dispose of as 
hazardous waste.

WARNING:  Hazardous Materials. Government regulations apply 
to the storage of hazardous waste. Ensure that contaminated fil-
ters are properly labeled and stored in your hazardous waste stor-
age area. Also, make sure that they are not stored on your site 
longer than government regulations allow (the typical limit is 90 
days). Check your government regulations for hazardous waste 
storage requirements.

Reinstall all the filters in the same stack-order (with new or cleaned 
filters). Reinstallation steps are in reverse order of the removal, 
above, with this precaution:

The HEPA filter is directional. Make sure that it is installed with the 
arrow (on its label) pointing down.

Removing the Laser Computer Air Filter
[Laser Marking only] On some models, the Laser Computer is 
located in the Option Bay and the filter can be accessed from the back 
of the Option Bay.

Note: Some PS models don’t have Laser Computers.

 See Figure 4-44. In general, clean this filter every month and replace it 
approximately every six months, depending on environment and 
amount of use.
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Figure 4-44:  The location of Laser Computer filter on the back of the
Laser Marker frame. (Some models only.)

To remove the Laser Computer air filter:

1. Unscrew the two captive thumb screws on the filter cover and 
open the cover door. See Figure 4-45.

Figure 4-45:  After opening the Laser Marker Computer filter cover,
drag the filter out with a pen or pencil. (Early filter covers are not

hinged.)

2. Remove the old air filter. Clean or replace with a new air filter as 
necessary.

3. Close the filter cover and screw in the thumb screws. 
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Handler Computer
The main PS Machine computer, or Handler Computer, is accessed 
from the front of the machine, in the lower left corner, and requires 
little maintenance.

Handler Computer Air Filter
The Handler Computer has a air filter that requires period cleaning 
or replacing. 

To remove the air filter:

1. Open the front panel by unlocking (if applicable) and twisting 
the key knob right 1/4 turn.

Figure 4-46:  The Handler Computer door and knob (A) and filter (B).

2. Pull out the filter to the right as shown in Figure 4-46. The fil-
ter should be white. Clean or replace as necessary.

Installing AH500 Software Updates
AH500 Software Updates are periodically published with improve-
ments. Delivery depends on contract options.

To install new AH500 Updates on the PS Handler Computer:

1. Create a backup copy of the winAH500.ini file (on your Handler 
computer).

2. Insert the AH500 CD and follow instructions in the Installa-
tion Instructions.rtf file.

3. Rename your.ini file again back to winAH500.ini (replacing the 
new.ini file) to keep your settings.

Note: Updating TaskLink is a different CD. For more TaskLink  
information, see TaskLink’s on-screen Help.

A B

Your CD looks similar to 
this.
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The Vision System
The vision system provides for angular correction up to 30 degrees 
for devices on the probe before they are placed in the programming 
socket. This angular correction is performed to reduce the likelihood 
of device damage from improper insertion.

Inspecting the Vision Camera

WARNING:   Electric shock hazard. The PS Machine operates at 
high voltage. Switch off the PS System main power switch before 
opening any access doors or removing any cabinet panels. See 
Turning Off the System on page 4-4.

1. Preparation—
1a. Shut off the PS System power and ensure the main power switch 

is in the OFF position. For more information see Turning Off the 
System on page 4-4.

1b. Open the right access door.

CAUTION:  Data could be rendered useless. When tightening fas-
teners, do not move the camera or the Vision System will need 
recalibration (page 4-50) and all your vision files will be need to 
be recreated (page 3-34). 

2. Check fasteners—
2a. Check the three mounting screws in the camera bracket and 

tighten if necessary with a 1/8 inch Hex Key. See Figure 4-47.
2b. Check the two mounting screws in the camera lens body and 

tighten if necessary with a 2 mm Hex Key.
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Figure 4-47:  Camera mounting screws and focus ring knobs. Dashed
ovals indicate screws hidden in this view.

2c. Check the two lens focus-ring thumb screws and tighten if they 
are not snug. If they are actually loose, the camera might need 
recalibration. Excessive device placement problems would con-
firm this. See Calibrating The Vision System below.

3. Reinstall all panels.

Calibrating The Vision System

When Does the Vision System Need Calibration?
If any of the following are true, the Vision System may require cali-
bration: 
 • The camera has been replaced, moved, refocused, or contrast 

changed.
 • Many devices are failing continuity due to placing errors.
 • Many placed devices have bent leads.
 • The PS Machine has been moved.

Prerequisites to Calibration
 • You have a password for Supervisor rights.
 • Prior to calibrating the camera, ensure that all fasteners are tight. 

See Inspecting the Vision Camera on page 4-49.
 • The probe vacuum is enabled.



■ The Vision System ◘ Calibrating The Vision System

PS Series Owner’s Manual 4—51

back

 • The probe is in the center of the taught Vision location.
 • The plastic lens cover is in place.
 • The camera picture is well-focused with adequate light.
 • The Glass Checkerboard Calibration Target is available. (Each 

square is 1.1 mm x 1.1 mm.)
 • Vision station height and travel height are the same.
 • Vision drop/pick height setting allows for the calibration target 

to clear the socket opener ribs (if present).
 • Ensure that  msec, delay before Vision Inspection equals 100  in 

the Parameters Tab.

Getting a Good Picture: Vision System
To get a good, clear picture with the Vision System (Cognex camera):

1. Navigate to the System > Gantry Window.

2. Go to socket 1 of any programmer or tray and pick a device. 
2a. To pick up a device: Click Tray 1 or Socket [X] in the Gantry Win-

dow to send the head to that component. 
2b.  Right-click to pick up the device. Click the Go To tab. 

3. Click the Go To Vision button. 

Figure 4-48:  The Vision System Dialog with a good quality picture.

4. At the Vision System dialog, visually check that the picture is 
good quality similar to the figure above. 

5. If the image is not good (blurry, too dark, etc): 
5a. Click the Calibration button. 
5b. Click the Display Live Video button. 

WARNING:  Electric shock hazard. Opening any access doors 
while the power is ON can be dangerous even when steps instruct 

If the glass target is 
unavailable, print a checker-
board target from the PDF 
file on the installation CD:
Use card stock. 
In the Adobe Reader Print 
dialog, select NONE for the 
PAGE SCALING field.
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you to do so. Use extreme caution and do not touch any electronic 
equipment except as directed.

5c. Open the right access door. 
5d. Without touching any live electronics, adjust the camera lens as 

follows:  
5d.1) Loosen the lower of the two ring locking screws (by 

hand). See figure. 

Figure 4-49:  Roughing-in camera lens adjustment by hand. 'B' is the
locking screw and adjustment ring for the Brightness. 'F' is the locking

screw and adjustment ring for the Focus.

5d.2) Turn the ring to lighten or darken the image. 
5d.3) Tighten the ring (by hand). 
5d.4) Loosen the upper ring locking screw. 
5d.5) Turn the ring to adjust focus. 
5d.6) Tighten the ring. 

5e. Close the Live Video window. 
5f. Click Exit.

6. Finish getting a good picture—
6a. Click Exit again to get back to the Gantry Window. 
6b. Replace the device into its original location. 
6c. Click the Vision button and visually check that the picture is 

good quality again. 

B

F
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Part 1–Calibrating Cognex Vision with Checkerboard 
Target

CAUTION:  After recalibrating your vision system, all existing .vpp 
files (Vision and Package files) will need to be retaught.

To calibrate the Vision System:

1. Preparation—
1a. Create a good Vision System picture. See the previous heading 

on page 4-51.
1b. Click the Vacuum on button.
1c. Place the calibration target by hand so that the checkerboard 

pattern is facing downward, towards the camera.

2. Verify settings—
2a. Navigate to the Camera Calibration Tab (System > Gantry > Go-to 

tab > Go-To-Vision button > Calibration tab) and then click the Cal-
ibrate tab.

2b. Verify that:
• the Calibration Mode is set to Scaling, Rotation and Translation, 
and
• Tile Size X & Y are 0.0433, and
• Fiducial Mark is checked. See the figure below.

You can position the blue axis by selecting Current.CalibrationIm-
age from the drop-down list above the image window, and drag-
ging the axis to the new location.

Figure 4-50:  The Vision Utilities Dialog with Camera Calibration Tab
selected, and then Calibrate tab selected. In this image, the Compute

Calibration function has finished successfully.
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3. Computing Calibration—
3a. Select Grab Calibration Image. 
3b. Perform calibration by selecting Compute Calibration. 
3c. Select Current.CalibrationImage from the pull-down list and ver-

ify that the majority of the picture is pink. The pink color means 
those tiles were used for calibration.

Figure 4-51:  This resulting calibration image shows plenty of pink
meaning more than enough tiles were used for calibration.

Note: Ensure no error messages display in the Calibration Info bar 
at the bottom of the screen.  If error information exists, apply the 
message recommendation, and try to calibrate again.

4. Assessing results—
4a. If successful, the green Calibrated message displays in the 

lower-left corner of the calibration screen. Save the current 
image to the CameraCalibration.vpp file by clicking the Save 
button, select CameraCalibration.vpp, and click Save. When 
asked to replace the existing file click OK.  Note that the Camera-
Calibration.vpp file must be saved from the Camera Calibra-
tion tab.

Note: If you accidentally replace the wrong file, there is folder 
named Backup with the original files in them. Copy the desired 
backup file to the current working directory.

4b. If NOT successful (there is not much pink color), then repeat 
from Step 3 above or make Electronic Vision Adjustments as fol-
lows:

4b.1) Click the Camera Setup tab.
4b.2) Click Electronic Mode (lightning bolt)
4b.3) Adjust the Brightness and Contrast sliders. 
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4b.4) Click the Camera Calibration tab and repeat from 
Step 3 Computing Calibration.

5. Finish Part 1—
5a. Click Exit. 
5b. Remove the checkerboard target by hand.

Part 2—Updating Vision File Parameters (and then the 
Vision File itself)

1. Preparation—
1a. In the Gantry Window, pick up device by moving the probe to 

socket 1 of a programmer and right-clicking. 
1b. Ensure that the device is centered on the probe. 
1c. Click the Go To tab. Click the Go To Vision button.

2. Update vision parameters—
2a. Click the Calibration button to open the Vision Utilities dialog. 
2b. Click the Vision Template tab. 
2c. Click the Train Parms tab. 
2d. From the Algorithm drop-down select PatMax – High Sensitivity. 
2e. Ensure that Ignore Polarity is unchecked. 
2f. Click Grab Train Image. 
2g. Select Current.TrainImage from pull-down menu above the right 

camera picture. 
2h. Adjust origin of the turquoise X-Y axes as close as possible to the 

center of the device. Position the axes by clicking it and drag-
ging. 

2i. Adjust the blue search-area rectangle to look similar to the one 
in the figure below (roughly: just under the size of the opener). 
Click a rectangle handle to resize it.
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Figure 4-52:  The Vision Utilities Dialog with Vision Template Tab
selected. After clicking the Grab Train Image button, the Info field

displays results.

3. Training the vision—
3a. Click the Grab Train Image button. Recheck that the X-Y axes 

symbol is still centered. If not, adjust it and then click Grab Train 
Image again. 

3b. Click the Train button.
3c. If the Train function was successful, Trained displays in the 

lower-left corner of the screen and no error messages display in 
the Info field. If an info message does appear, either create a bet-
ter vision system picture (Getting a Good Picture: Vision System on 
page 4-51), or adjust the quality of the current image with bright-
ness/contrast. 

Otherwise, if the info says successful click Save. Select your 
device-specific vision file (such as TSOP48.VPP) and click Save. 
Also, save this image as the VisionTemplate.vpp file— Save > 
select VisionTemplate.vpp > Save. 

3d. Click Exit.

Note: The VisionTemplate.vpp file must be updated every time the 
system is recalibrated.

Reteach the Vision Inspection Parameters

1. Teach the Parameters—
1a. Navigate to System > Gantry > Vision System (if you are not 

already there). 
1b. Click Setup. 

VisionTemplate.vpp is the 
vision template for all new 
vision files. To use it, copy, 
paste, and rename it (such 
as TSOP48.vpp) when cre-
ating vision files for new 
jobs.
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1c. Click a handle of the blue rectangle and adjust the search region 
to match the device boundary. 

1d. Click Teach.

Figure 4-53:  Testing the vision inspection with the Gantry Vision
Position buttons and rechecking the Results.

2. Test—
2a. Test the vision inspection by clicking Inspection and then verify-

ing that the results are PASS, X = 0, Y = 0, and A = 0.00. 
2b. Further test by clicking the position arrows and probe rotation 

buttons and then clicking Inspection and verifying the move-
ment in the Results fields. (This change is not saved.)

Note: Remember: prior to running existing jobs, reteach the vision 
file.

Navigation Arrows: 
each click moves the 
head 0.010 inches.

Rotation buttons: 
each click rotates the 
probe 1 degree.
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Troubleshooting
This section contains solutions to problems that may arise during 
operation of the PS System. 

Troubleshooting for the Tape Output System is covered in a separate 
heading; see Troubleshooting the Tape Output System on page 4-74.

Common Error Messages

Restarting after Trouble
If the AH500 Software closes, locks up, or experiences some trouble 
that qualifies as a crash, then the PS Machine power must be 
switched off for 20 seconds prior to restarting the software. This is 
required to reset internal amplifiers.

Error Message Resolution

“E-STOP 
ACTIVATED”
but . . .
the OK button is grayed 
out in error message 
(unavailable)

• Check that both E-Stop buttons are released.
• Check that all six safety shields are closed.
• Check that the Option Bay safety shield is closed.
• Check the LED sensors on the safety shields. Yellow LED indicates the 

sensor is not detecting that the safety shield is properly closed. Re-close 
safety shield.

• Once condition is solved, the OK button is enabled. Click OK.

TRAY NOT PRESENT Conditions: You swapped input tray but the PS does not detect the tray and 
when you click Run, you get error message Tray Not Present.

• Re-install the tray. 
• If the tray is still not detected, remove the tray and place a finger over tray 

present sensor. 
–If sensor is working, tray outline appears. Re-install tray.
–If sensor is not working, the tray outline does not appear. In this case, 
contact Data I/O Customer Support or a local Data I/O approved ser-
vice representative.

Z MOTION ERROR 800: 
LIMIT EXCEEDED ON 
AXIS 2

Conditions: A Red ERROR box appears in bottom right corner of the PS Machine 
Monitor.

Call the Service Technician.

ERROR: TAPE OUT • If a device is jammed in the Tape Output system, clear it. Click the reset 
button on Tape Output System. Then click OK on PS Machine Monitor.

• If above doesn't work, call the Service Technician.

MAIN AIR OFF • Check that the main input air valve is in the ON position.
• Check that the main air hose is connected.
• Check that the air pressure is within the required range (green LED read-

out instead of red on 2009 models and later.)
• Call the Service Technician.

VACUUM ERROR Call the Service Technician.
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Monitoring Daily Operation Logs
Daily operation logs are saved for each operation that the PS System 
performs. As the operation is performed, its completion status is 
noted in the log file. Log files can be used for troubleshooting and 
viewing machine status. 

To view the daily operation logs:
 • At the Setup Window, select System > Log File. 

Figure 4-54:  At the Log File Window, Information is displayed about the
successful or unsuccessful completion of any operation of the

PS System. The system keeps a maximum of 7 days of history.

The Log Files are named log1.mdb, log2.mdb, log3.mdb, and so 
on up to log7.mdb. They correspond to the days of the week, 
log1.mdb is for Sunday, log2.mdb is for Monday, and so on. On the 
eighth day, the first file is overwritten. To save a record of daily oper-
ation logs, print the files or save them to another location.

Collect all PS System Logs
Collect PS Logs is a software utility on AH500 Software Version 6.3.6 
and later, that collects all log files from the PS Machine. It creates a 
ZIP file containing all the information that Data I/O, or trained ser-
vice technicians, need to evaluate your PS Machine status. 

Programmer Related Problems
When you experience a programmer related problem:

1. Force the error to re-appear by running a job, or performing the 
same steps that led to the trouble.

2. Close all Data I/O software like TaskLink, AH500. (Close AH500 
the usual way: click Finish to stop a job, Exit the Run Window, 
Exit the program.)

3. Start Collect PS Logs.
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Other Problems
For problems that are NOT programmer related, run the Collect PS 
Logs application anytime after the problem has been seen.

Starting Collect PS Logs
There are two methods to start the Collect PS Logs application.

AUTO Mode uses default settings— The AH500 Software displays a 
button in each message box that allows you to start the Collect PS 
Logs application in AUTO Mode. 

Figure 4-55:  The Collect Logs button starts the Collect PS Logs Appli-
cation in Auto Mode.

When starting Collect PS Logs from a Message box (AUTO Mode), 
only a progress screen is shown on the lower left corner of the screen. 
All defaults are used and no user action is required.

The other method is to start from the Start menu (Windows XP) and 
and it offers some options. An icon appears in Start > All Programs > 
AH500 > Collect PS Logs.

After starting Collect PS Logs from the Start menu, the main window 
appears where you can select which items you wish to collected. 

1. Select or clear check boxes for files as desired.

Figure 4-56:  Only files with checked boxes are collected. The Collect PS
Logs Application automatically detects the name of the last job run. It
then identifies job-related files, including the data file used and serial

number configurations (if present).
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2. (Optional) Check additional SPC files if the error rarely 
appears or appeared a long time ago.

3. (Optional) To enter a text description to the Zip file:
3a. Click Add description.
3b. Type a description into the field available. In addition to what 

you type, the description will include the Date and Time the log 
was captured and the serial number information from the 
winah400.ini file.

4. Click Collect and ZIP.
A ZIP file is created in the same folder as the Collect PS Logs execut-
able. The ZIP file remains there even after exiting the Collect PS Logs 
application. It is also copied to the Windows Clipboard.

5. Click OK to the message about pasting the ZIP file to another 
desired folder.

Figure 4-57:  . The ABS files (white arrow) are collected only when the
AH500 is not active. This ABS file field is disabled (dimmed as shown)

when an active handler is detected. By default, the data file (black
arrow) is not checked and therefore, will not be collected into the ZIP

file.

Command Line Support
When the command line parameter [auto] is passed to the applica-
tion, no Log Collector Window is displayed and all defaults are used. 
A file with date/time stamp is being created. The naming format is 
LogFiles__DD_MM_YYYY__HH_MM_SS.zip 
for example: 
LogFiles__13_09_2010__16_20_07.zip. 
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Optionally, you can pass a second parameter [myfile.zip] as 
shown below which determines the zip file name.

CAUTION:  These command-line commands overwrite existing 
files without warning.

Examples:

Programmer Errors
Programmer errors discussed:
 • A Programmer is being skipped
 • Devices failure to program
 • Disabling a Programmer

Clearing a Programmer Disabled Status

The status indicator disappears from a programmer outline on 
the Run window, or 

The PNP head skips a programmer.
 Check the programmer status as follows:

1. Preparation—
1a. At the Run window, click Pause.
1b. Note which programmers are disabled, if any. Right-click the 

programmer and select an command from the drop-down 
menu.

For more information on changing programmer or socket status, 
see Changing Programmer Status on page 3-25.

Devices Fail to Program

One programmer has many continuity failures (in Statistics 
Window). 
 Move the Socket Adapter to another programmer to see if the 

problem is the programmer or the adapter, as follows:

Code Description

Collect_logs auto [myfile.zip] The application runs automatically and creates a 
myfile.zip output file where myfile.zip is the name you 
typed in the command line.

Collect_logs auto The application runs automatically creating a 
date/time stamped output file.

For information regarding 
calibration of the PNP 
head, see Teaching the 
Package File on page 
3-40.
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1.  If a job is running click Pause and wait until all programmer 
activity is done.

2. Check that there are no devices in the target adapter. If there are, 
click Finish.

3. Replace the target Socket Adapter with another empty adapter. 

If the failure moves with the Socket Adapter, check for bent, 
damaged or worn pins on the sockets. 

If continuity failures persists in the same programmer, recali-
brate the device locations for this socket adapter by reteaching 
the Package File. See Teaching the Package File on page 3-40.

4. If an Optima (Universal) programmer is not responding, switch 
off machine power and check the fuse—contact Data I/O sup-
port for location. 

Note: If a programmer is not performing and you cannot correct 
the error, you can continue to use other programmer sites after dis-
abling the non-functional programmer. See Disabling a Program-
mer below.

Many Programmers have continuity failures 
 The vision system may need calibration. See Calibrating The 

Vision System on page 4-50.

All programmers fail to program devices.
 Check that the Programmer Simulation switch on the Setup win-

dow is OFF. If not, switch it to OFF.
 Check that the Programmers circuit switch on the Power Panel is 

On.
 Check the Log file as follows:

1. Pause the job.
2. Exit the Run window.
3. At the Setup Window click System > Log File.

Disabling a Programmer
If a programmer is not functioning correctly and you cannot correct 
the error, disable the non-functional programmer and continue to use 
other programmer sites. 

To disable a programmer:

1. At the Setup Window, click System > Programmers.
2. Click the image of a socket on the target programmer.
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2a. Click the black DISABLED button. The socket image changes to 
black and the programmer is disabled. 

2b. Repeat for all sockets on the target programmer.

For more information on changing programmer or socket status, 
see Changing Programmer Status on page 3-25.

Pick and Place Problems
Devices are not being placed into sockets or output media accu-
rately.

The PNP Head does not center on the devices.
 Check that the probe is not bent.
 (Models prior to Feb. 2009) Check that the break-away probe tip 

is snapped fully into place.
 Check that fasteners on the head, gantry, and camera are tight. 

See Inspecting Gantry Parts on page 4-24 and Inspecting the Vision 
Camera on page 4-49.

 Reteach the Vision file. See Teaching the Reference Vision File on 
page 3-34.

 Calibrate the Vision System. See Calibrating The Vision System on 
page 4-50.

 Adjust the X-, Y-, and Z-axis positions using the adjustment 
arrows on the Gantry Window.  

The Probe is dropping devices.
 Clean or replace the rubber Probe Tips. See PNP Probe on page 

4-12.
 Clean the vacuum filter or silencer. See Vacuum Generator Filters 

and Silencers on page 4-15.
 Check that the main input air pressure is 5.5 ±0.7 Bar 

(80 ±10 PSI). Refer to Connecting Air on page 2-2.
 [PS288, PS388 and Optima Programmers only on PS588] If the 

problem looks like it could be caused by the sockets: reset the 
Socket Opener air pressure at the Power Panel. Pressure must be 
in the correct range for your PS Machine and adapter. See 
Adjusting the Socket Actuator Air Pressure on page 4-8.

Probe attempts to pick a device twice even though it picked up 
the device the first time.
 The Vacuum sensor may need calibrating. See PNP Head Vacuum 

Generator Sensor on page 4-19.
 If programming TQFP 144, you can increase the value of the fol-

lowing line in the Package File to maximum value of 500:

For more information, see 
Teaching the Package File 
on page 3-40.
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#39 100    MSEC, TRAYS & TUBES, VACUUM SUCKUP TIME 
AT CUPS DURING PICKUP

Trouble with the PNP Head.
 Two servo-amplifiers (inside the right access door) control the 

head. For more information see Head Error Codes in the on-screen 
Help. 

The Gantry only moves in one axis or not at all.
 Exit the AH500 and switch off machine power. Check the fuses 

on the Opto PCB, inside the right access panel. 

WARNING:  Electric shock hazard. The PCB has a spot on the 
near, right corner for testing the fuse. The PS Machine power must 
be ON for this test. Use extreme caution when the access panel is 
open and the power is on.

Figure 4-58:  The Opto PCB with spare fuse (left arrow) and fuse tester
labeled 1A2. PS388 shown. The location for PS588 is farther toward

the back.

Air Pressure Problems
There is no main air pressure.
 Make sure that the main air switch on the Power Panel is in the 

ON position.
 Check that the air regulator on the Power Panel displays within 

the acceptable range: 5.5 ±0.7 Bar (80 ±10 PSI). 

If not, replace the filter: See Replacing the Input Air Filter on page 
4-15. The digital display on the regulator will be green when air 

Note that there is no air 
pressure adjustment for 
FlashCORE program-
mers on the PS588.
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pressure is within the correct range and red when it is out of 
range. The regulator has been set at the factory and is not adjust-
able.

There is no or low vacuum on the PNP Probe.
 (Models prior to Feb. 2009) Check that the break-away probe tip 

is snapped fully into place .
 (Models Feb. 2009 or newer) Check that the probe is not loose 

and that the o-ring is not destroyed or leaking. Refer to Checking 
the Probe Assembly on page 4-12. 

 Determine if the PNP head probe is clogged. Clean if necessary.
 Check the Probe vacuum and blow-off solenoids as follows:

1. At the Gantry Window, click the Actuator tab.
2. In the Actuate box click the Vac On (green). You should be able to 

hear the vacuum at the probe and see the red LED light at the 
lower solenoid on the right side of the head.

3. Click Vac Off. The lower LED extinguishes.
4. Click Blow-Off On (green). A red LED should light on a solenoid 

to the right of the head and just above the Vac solenoid.
5. Click Blow-Off Off (red).

Tube Input and Output Problems
Neither of the tube platforms vibrates.
 Make sure that tube input or tube output has been selected on 

the Setup Window.
 Make sure the vibration controls are rotated clockwise for more 

vibration.

Only one tube platform vibrates.
 Check the fuse.

For PS Machines delivered prior to 2009 only— 
Switch off the PS Machine and check the 2 A 250 V fuse above 
the three-wire connector on the back of the I/O Controller. The 
input vibrating motor connector is labeled 9 1; the output vibrat-
ing motor connector is labeled 9 2.???

 Check the power cable source connection.???
 Check the 5A 250 V fuse on the bottom of the vibration control-

ler box (behind the control knobs).
 If the fuses are continually being blown, the vibration controller 

box may be defective and must be replaced. You can switch the 
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wire from the working controller to the defective controller to 
determine if this is the case. 

The PS Machine is putting the wrong number of devices into the 
tubes.
 Reset devices per tube in the Gantry Window as follows:

1. At the Setup Window,  Options tab, ensure that Input and/or 
Output options are set to tubes. 

2. Click System > Gantry (you may be prompted to enter your pass-
word). Click the yellow Vib1 label to move the PNP head to the 
first position of the input vibrator.

Figure 4-59:  The Vib1 label has been clicked. (The placement of your
Vib1 label may be different.)

3. Click the Tubes tab, then enter the correct number of devices 
per tube in the Chips/Tube field.
4. Click Save to store the new settings to the Package File.

Tray Feeder Problems
The Run Window indicates a tray is present on the TF20 Tray 
Feeder when there is not a tray there, or vice versa. 
 Navigate to the System > MISC I/O Window and verify that the 

Tray Present Sensor = ON.
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PS Computer Failure
A PS computer drive fails. A message indicates that a computer 
has crashed. 
 [Models built after 2010] Your PS System is equipped with a 

mirror-backup system called RAID that creates a real-time ghost 
image. You may see an error message, or see a very quick mes-
sage at system start-up that reads CRITICAL STATUS. Your 
PS System will continue to operate as normal on the backup 
drive. However, you must replace the failed drive for continued 
safety. Follow these steps for replacement.

1. Shut down the PS System. See Turning Off System Power on page 
3-27.

2. Unscrew four 3/8 inch SHCS from the front of the Handler com-
puter and pull open the computer drawer from the PS frame.

3. Remove the top panel from the computer. Some models have 
two screws on the back while others have thumb screws. With 
screws removed, the top cover should slide back about.5 inch.

4. Locate the computer drive that has failed.
5. Remove wires from the back of the drives.
6. Remove the failed drive removal by unscrewing the three Phil-

lips screws holding bracket that supports all the drives. 
Note that these have lock washers and at least one has a plastic 
standoff.

Figure 4-60:  Three Phillips screws (circled) secure the bracket holding
all the hard drives that are accessible from the from of the PS Machine.

Your PC Box and bracket may be different depending on manufacture
date.

7. Replace the failed drive with a similar model with 250 GB (not 
more, not less), and install it.

8. Re-install in the reverse order.

For more information, 
see the Promise Tech-
nologies, Inc. Fast Track 
Manual that came with 
your 2011-or-later 
PS System.
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9. Turn the PS System on.
10. After it starts up press Control + f to view the FastBuild Utility.
11. Assign RAID 0 (the new drive) to RAID 1. (It should display (2) 

RAID 1 drives.)
12.  For the fastest rebuild, leave the PS System power on for about 

seven hours for the RAID mirror backup system to rebuild the 
file system on the new drive. (If it gets turned off, the backup 
drive continues to get rebuilt the next time the power is turned 
on.)

Note: There will be no obvious on-screen indication that the new 
drive is running or being rebuilt.

[Model built prior to 2011] If you have a ghost backup of your 
hard drive, follow the instructions of the ghost software to install the 
backup. If you have any questions, contact Data I/O Service.
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Functional Block Diagram
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Tape Output System
The Tape Output System is an optional system for placing and taping 
programmed devices into device tape. 

Items not covered here can be found in the TM-50 Taping Module 
User’s Guide that came with your PS System.

The Tape Output also uses the Shuttle Transfer System to deliver 
devices to it. For maintenance issues regarding the Shuttle System see 
The Marking Systems and Shuttle on page 4-34.

Cleaning the Pressure Seal
The Pressure Seal Tape Output System requires cleaning to prevent 
problems with breaking the device tape or tearing the tape sprocket 
holes. The cleaning process removes adhesive built up from the cover 
tape application rollers and the drive sprocket top pressure idler 
wheel.

The Tape Output System also employs a PNP head. For information 
on cleaning and maintaining the Probe tip see PNP Probe on page 4-12.

Cleaning Tools Required: 
 • Dry or damp shop towel 
 • A reel of empty device tape (carrier tape)
 • A reel of cover tape

To clean the Pressure Seal Tape Output System:

1. Preparation—
1a. Switch on the PS System power and air. 

2. Start a job—
2a. Start TaskLink. (Optional and deprecated: start AH500 by dou-

ble-clicking the AH500 icon on the Windows Desktop, and then 
skip Step 2c below.)

2b. Select a job that requires the use of the tape output.
2c. Click Run (and Yes or Ok to subsequent dialogs), which opens 

AH500 automatically.
2d. Click Start.
2e. Switch on the Tape Output Controller by pushing the red Power 

button. Refer to Figure 4-61.

3. Configure the Tape Output Controller—
3a. At the V-TEK start-up screen, select Setup by pressing the left 

arrow button.
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Figure 4-61:  Tape Output Module Controller. The arrow points to the
Power On/Off button which is also the Emergency-Stop.

3b. Configure the Tape Output Controller by setting the following:

At the Setup menu:
• reset Count Stop to desired amount:

Press 1, to re-zero the present count
Press 2, then enter the desired number, then press the ENT but-
ton.

• select the desired device tape pitch from the Pitch Selection 
menu. Then press ENT.

Note: The pitch can be determined by using the pitch setting decal 
located on the loading track or the pitch setting guide found at the 
front of the TM-50 Taping Module User’s Guide.

At the Advance menu:
• set the number of pockets to advance to 1. Then press ENT.

At the Speed menu:
• set the advance speed between 40 to 100 depending on the 

device tape width and device size. Then press ENT.

Note: Prevent device tape breakage and advancement problems 
with  small devices and narrower tape widths by setting slower 
speeds— in the range 40 to 60. 

Higher speeds may cause the devices to be dislodged from the pock-
ets or may cause the sprocket holes on the tape to rip out. 

For more information, 
see the TM-50 Taping 
Module Users Guide 
that came with your 
equipment.
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At the Jog menu
 • jog the device tape forward to align the pocket with the 

PNP head.

At the Mode menu
 • select PSA mode for pressure seal cover tape. An asterisk indi-

cates the current setting. Then press ESC.

Note: The Heat Seal switch should be OFF.

At the Run menu
 • select Run Mode.  The run window displays all the selected setup 

parameters.
 • verify all settings for accuracy. 

4. Inspect the PSA Seal Rollers (cover tape rollers)—
4a. Inspect the seal rollers for build up of adhesive from the cover 

tape. See Figure 4-62.

Figure 4-62:  On the Tape Out Module, the PSA Seal Rollers (arrows)
and Sprocket Idler with O-rings.

5. If adhesive buildup exists on the PSA Seal rollers—
5a. Using a shop towel and alcohol or alcohol wipes, clean the adhe-

sive build up from the cover tape application rollers. Hold the 
alcohol cloth on the roller and rotate the roller 360°. 

5b. Repeat procedure for the other application roller. 

6. Inspect drive sprocket idler and rubber O-rings—
6a. Inspect the drive sprocket top idler and rubber O-rings for any 

build up of adhesive from the cover tape. See Figure 4-62.

7. If adhesive buildup exists on the idler and O-rings—

CAUTION:  O-rings might be easily damaged. Handle gently to 
avoid breaking them.

O-rings
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7a. Gently remove the two O-rings from the drive sprocket idler. 
7b. Using a shop cloth and alcohol or a commercial alcohol wipe, 

remove all adhesive from O-rings. 
7c. Wipe the idler clean.
7d. Reinstall the dry O-rings onto the idler.

Adjusting Pressure of the PSA Seal 
Rollers

1. Advance the device tape with the cover tape through the Seal 
Rollers using the manual advance pedal. Advance enough pock-
ets to correctly align the cover tape on the carrier tape. 

2. Perform a peel back test by peeling the cover tape from the carrier 
tape. Notice how well the cover tape adheres to the device tape. 
Perform a twist test by giving the tape a slight twist. Notice if the 
cover tape detaches from the device tape. 
If either test produces loose cover tape, increase the application 
roller pressure by screwing the PSA Seal pressure adjustment 
screw in (clockwise). 
If both tests look acceptable, visually inspect the sealed device 
tape for adhesive that may have been squeezed out during 
application. If adhesive is visible, the Seal Roller pressure is too 
high. Decrease the application roller pressure by screwing the 
PSA Seal pressure adjustment screw out and retest.

Troubleshooting the Tape Output 
System 

The Tape Output System contains sensors that detect these fault con-
ditions:
 • a device is on top the device tape (carrier tape)—Track Jam Sen-

sor
 • no cover tape is on the reel—Cover Tape Sensor 
 • device tape is not properly inserted in the device tape 

track—Device Tape Present Sensor
 • a pocket in the carrier tape is empty—Pocket Empty Sensor

When the AH500 software displays the error message Tape Out Unit, 
one of the tape output system sensors has been triggered. The most 
likely sensors to trigger are the Device Jam and Device Tape sensors. 
See Figure 4-63.
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Figure 4-63:  Optical Fiber Amplifiers: (left to right) Cover Tape Present,
Empty Pocket, and Device Tape Present.

Track Jam Sensor and Controller
The Track Jam sensor detects when a device is not properly seated in 
the pocket. This sensor is located on the Adjustable Loading Track 
immediately before the carrier tape enters the cover taping area. 

Tape Out Unit error message displays and a red LED lights in the 
Device Jam Sensor.
 Use a vacuum tool to seat the device in the device tape pocket.
 Re-seat the device tape in the Adjustable Loading Track. 
 Use air to blow any debris out of the Device Jam sensor path.
 Adjust the Device Jam Sensor Controller. See below.

Cover Tape Sensor and Amplifier
The Cover Tape sensor detects when there is no cover tape on the 
reel. When the Cover Tape sensor is triggered, a red LED is illumi-
nated in the Cover Tape Sensor Controller. 

Error message Tape Out Unit displays and a red LED is illumi-
nated in the Cover Tape Sensor amplifier (left amplifier).
 Replace the empty cover tape reel with a full one.
 If the reel still contains cover tape, adjust the Cover Tape Sensor 

Controller. See below.

Adjusting the Cover Tape Sensor Controller

1. Ensure that the Output Selector mode is set to D.ON by pressing 
the Mode button. (There may be an L/D ON button or toggle to 
change the mode.)

The Track Jam sensor
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2. Install a roll of cover tape onto the spindle. 
3. Press and release the SET button in the left amplifier.
4. Remove the cover tape.
5. Press and release the SET button again.

Note:  If an error occurs or the sensor fails to detect the cover tape 
after switching from a different type of cover tape, then the Cover 
Tape sensor may need to be re-taught to sense that particular type of 
cover tape. 

Device Tape Present Sensor and Amplifier
The Device Tape Present sensor detects when carrier tape is not 
inserted in the track guide. When the Device Tape Present sensor is 
triggered, a red LED is illuminated on the Device Tape Sensor ampli-
fier.

A Tape Out Unit error message displays and the red LED on the 
Device Tape Sensor amplifier lights (right amplifier).
 Replace the device tape reel if it is empty.
 Adjust the Device Tape Sensor amplifier if the reel still contains 

carrier tape. See below.

Adjusting the Device Tape Sensor Amplifier

1. Ensure that the Output Selector mode on the farthest amplifier is 
set to D.ON by pressing the Mode button. (There may be an 
L/D ON button or toggle to change the mode.)

2. Set the track width for the target device tape as follows:
2a. pull or push the side nearest the operator to correct width, 
2b. Tighten lock knobs.
3. Load a roll of device tape onto the spindle and into the track. 

Take up slack in the tape.
4. Press and release the SET button in the right amplifier.
5. Move the cover tape away from the sensor.
6. Press and release the SET button again.

Pocket Empty Sensor and Amplifier
The Pocket Empty sensor alerts the operator when a pocket is empty 
as the device tape approaches the cover taping location. This is the 
middle sensor in Figure 4-63 on page 4–75.

A Tape Out Unit error message displays and a red LED is illumi-
nated on the Pocket Empty Sensor amplifier.
 Adjust the Pocket Empty Sensor as follows:
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1. Set the track width for the target device tape
A) loosen the two Track Width Lock knobs, 
B) pull or push the side nearest the operator to correct width, 
C) tighten lock knobs.

2. Load a roll of device tape onto the spindle and into the track. 
3. Loosen the knob on the left side of the Pocket Empty Sensor 

bracket to adjust the height above the tape. Retighten.
4. Loosen the knob on top to center the sensor on the tape. 

Retighten.
5. Advance the tape until a pocket with a device in it is centered 

under the sensor.
6. Ensure that the Output Selector mode on the middle amplifier is 

set to D.ON by pressing the Mode button. (There may be an 
L/D ON button or toggle to change the mode.)

7. Press and release the SET button in the right amplifier.
8. Remove the device from the tape pocket.
9. Press and release the SET button again.

Note:  This must be reset for each new device type to be taped.
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Automatic Tray Feeder
The Automatic Tray Feeder is optional equipment to the PS Program-
ming Systems. It is a high-speed tray exchanger, delivering JEDEC 
trays to pick and place positions.

Information not found here, but important, can be found in the Tray 
Feeder Operation Manual, such as the location of possible pinch points.

Cleaning and Inspecting
If used regularly, the following should be performed monthly:
 • Wipe the feeder belts and platform with a cloth dampened with 

isopropyl alcohol. 
 • Check the urethane pinch roller attached to the tray clamping 

mechanism for signs of wear or damage. Replace if necessary.

Conveyor Speed Adjustments
The TF20 is designed to keep a tray from stopping too abruptly when 
it reaches either end of the conveyor. (Abrupt stops can cause devices 
to bounce.) Conveyor speed may need adjustment if trays are stop-
ping too abruptly and devices are moving on the trays.

Two sensors control the speed of the conveyor. 
 • The Return to Stack sensor is located near the end of the conveyor 

closest to the tray stack. The leading edge of a tray moving to the 
left passes triggers this sensor.

 • The Place in PS Machine sensor is located near the end of the con-
veyor closest to the center of the PS Machine. The leading edge 
of a tray moving to the right triggers this sensor. 

When either sensor is triggered, the conveyor shifts to slow speed 
operation. The speed of the conveyor is adjusted with the potentiom-
eters. Use light force to prevent stripping the potentiometers. 

See “Conveyor Ramp Down 
Delay” Adjustments in the 
separate manual for the 
Tray Feeder.
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Electrical Equipment Disposal 
Notice

This symbol displayed on your Data I/O product indicates that the item must 
NOT be discarded with general municipal waste. Either return products pur-
chased after the 13th August 2005 and displaying this symbol to Data I/O 
so that they may be recycled, reused, or otherwise properly disposed of, in 
accordance with the European Union's WEEE Directive or you may dispose 
of it yourself in accordance with the European Union's WEEE Directive.

Data I/O will collect this equipment at no cost to the equipment owner and 
process it accordingly. (This includes auxiliary equipment that came with 
your PS System such as Labelers, Tape-Out Module, and Tray Feeders.) 
Contact your nearest Data I/O office to receive information about returning 
WEEE labeled products with no charge.
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PS Series Owner’s Manual Glossary—1

Chapter  G

GlossaryGlossary
This glossary defines terms and acronyms used in this manual 
as they relate to the PS Series Programmers.

A Alphabetical
8P8C ~ 8 Position 8 Contact (also 8 position 8 conductor; it is often incorrectly called 

RJ45).

Access door ~ Large sheet-steel hinged panels with latches on most sides of the machine. See 
also, Safety shields, and Cabinet panels.

Actuator Plate ~ A plate that opens a socket(s) for loading a device(s).

AH500( ~ The Software for operating PS Systems. Also, a folder on the C: drive in Handler 
computer.

Air regulator ~ a valve which reduces the pressure of the incoming air to a set value.

algorithm ~ A software file containing specific step-by-step calculations required by the pro-
grammer to program a device. 

Allen Wrench ~ Hex Key, Umbrako key,

AutoPak ~ see Digital I/O.

B

boot ~ see Start.

bus ~ A set of connections for connecting various functional units in a computer.

C

Cabinet panel ~ Large sheet-steel sides screwed to the machine frame. See also, Access Doors.

CFM ~ Cubic Feet per Minute, a volume/time measure of the rate of air flow. 
One CFM = 28.32 liters per minute.

checksum ~ A computed value which is transmitted or stored along with the data in order to 
detect corruption of the data.
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chip ~ See Device.

chip feeder ~ A component feeder system which mounts onto, and feeds devices to, electronic 
SMT Machines. Also called a tape feeder.

contacts ~ The electrically conductive metal leads on a socket module which conduct pro-
gramming signals from the programmer to the pins on the device in the socket.

continuity check ~ A preprogramming test that checks the device for electrical connections to the 
socket. (No electrical connection to the die). Not all pins are checked during this 
test.

D

DAB ~ See Diagnostic Adapter Board

device ~ A programmable integrated circuit. You may have heard other terms such as 
chip, microchip, semiconductor device, PROM, or DUT (Device Under Test).

device package ~ The protective container or housing for an electronic device with external termi-
nals to provide electrical access to the components inside.

device tape ~ The device pocket tape, the devices, and the cover tape before they are sepa-
rated.

Diagnostic Adaptor 
Board

~ (DAB) A circuit board that replaces the Socket Adapter Board for performing pro-
grammer hardware diagnostics.

Digital I/O ~ Provides 24 VDC for sensor systems throughout the PS System. It may also be 
called the Modbus for Modular bus. See also, bus. 

(Note that PS Machines prior to 2009 have an AutoPak, or I/O Controller, 
instead of a Digital I/O.)

Door ~ See Access Doors.

E

E-plate 1 ~ PS588 Machines these are mounted horizontally. On PS288 & PS388 Machines 
these are mounted vertically.

E-plate 2 ~ PS588 only; mounted horizontally,???

E-plate 4 ~ PS288 & PS388 only; it is vertically mounted to the frame.???

End a job ~ See Finish a job.

ESD ~ Electrostatic Discharge. ESD can damage programmable devices and other 
static sensitive electronic components. 

Ethernet ~ The most popular type of local area network, which sends its communications 
through radio frequency signals carried by a coaxial cable. Software protocols 
used by Ethernet systems vary, but include Novell Netware and TCP/IP.

F

FEPROM ~ Flash Erasable Programmable Read Only Memory. Similar to EEPROM but eras-
ing can be done in blocks or to the whole chip.

firmware ~ Software stored in ROM or PROM; essential programs that remain even when 
the system is turned off.

Finish a job ~ Let the machine program the preset number of devices for that job, or end it pre-
maturely by clicking the Finish button on the Run Window.
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FLASH ~ See FEPROM.

FlashCORE ~ A programming architecture for socketed devices.

FlashCORE Adapter ~ A circuit board with 1 to 4 programming sockets that fit on any FlashCORE pro-
grammer.

FlashCORE II
(FC II)

~ FlashCORE II is the name of the second generation of FlashCORE programmers 
with more flexibility and supports more microcontrollers than FlashCORE (FC I).

FlashCORE III
(FC III)

~ FlashCORE III is the name of the third generation of FlashCORE programmers 
which can download jobs and program much faster than its predeseccors.

G

gantry ~ The rails that supports the pick and place head and moves it horizontally in the X 
and Y directions.

GND ~ Ground

H

Handler Computer This is the main PS System computer is access at the front of the machine in the 
lower left corner.

Head ~ see PNP Head

HEPA ~ High Efficiency Particulate Air

Hex Key ~ A tool for removing screws; also called Allen Wrench or Unbrako wrench.

HIC Socket Adapt-
ers

~ Socket Adapters with High Insertion Count sockets.

Home position ~ A place at the back, center of the workspace where the PNP Head stops when 
paused.???

I

I/O ~ Input/Output. 

I/O Controller Modbus Digital I/O. This replaced the AutoPAK in 2008.

J

JEDEC ~ Joint Electron Device Engineering Council.

job ~ A set of instructions, used by the PS Series Programmers, containing all the 
device programming parameters required to set up and program a specific set of 
semiconductor devices. Used interchangeably with task.

JTAG ~ Joint Test Action Group

K

kgf/cm2 ~ kilograms force per square centimeter.

kit ~ A collection of tasks that are run successively.

L

laptop ~ A portable computer. 

Laser Marker ~ A laser printer which marks the surface of the devices. WinMark is one brand.
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lead ~ The connection legs that extend from the body of a device.

Leader ~ (Applies to Tape Output System) The length of empty carrier tape required at the 
beginning of the finished reel of taped devices.

LED ~ Light Emitting Diode

LED ~ Light Emitting Diode.

Light Tower ~ The pole on top the PS System with colored lights indicating different machine 
statuses.

M

mA ~ milliampere

Main Window AH500-PS288/PS588 main window. This is the first window to display when the 
AH500 starts after clicking RUN in TaskLink. The window title bar simply says 
PS288 or PS588.

Marker ~ A system to inscribe identification onto devices, in this case by a laser.

MB ~ Megabyte; 1,048,576 bytes (1,024 x 1,024, or 10242).

μBGA ~ Micro Ball Grid Array. Sometimes written as MBGA.

MCBI ~ Mean Count Between Interruption

menu ~ A screen display that lists available command choices.

N

NVM ~ Non-Volatile Memory

NVRAM ~ Non-Volatile Random Access Memory

O

OEM ~ Original Equipment Manufacturer.

OPTIMA Program-
mer

~ A Flash programmer with many Socket Adapters and Tops making it useful in 
programming a large variety of different package types such as logic devices 
and older Flash EEPROMs.

Option Bay ~ The cabinet that attaches to the back of any PS Machine, which can house a 
Laser Marking System and a Tape Output System.

P

P&P Head ~ See PNP.

Package File ~ A package file contains information about the physical dimension of a specific 
device package and associated Socket Adapter, as well as position information 
of each socket on the workspace.

Park Position ~ A place at the back, right corner of the workspace where the PNP Head stops 
after a job is stopped.

PC ~ Personal Computer.

PCI ~ Peripheral Component Interconnect. A standard for connecting peripherals to a 
personal computer.

Pick and Place 
Head

~ The mechanism that supports the probe that picks up and places devices.
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pick position ~ The physical positions where the pick-and-place head picks up devices such as 
at the input media and at sockets.

PLC Controller ~ Taping Module toggle switches

PNP ~ Pick and Place. Also referred to as P&P.

PNP Head ~ The Pick and Place Head controlled by the Gantry for moving devices between 
sockets and media.

PNP Taping Head ~ The pick and place head on the Tape Output Module.

pocket tape ~ The pocketed film that carries the devices. This term usually implies that the 
cover tape has been removed. Also called device pocket tape.

Power Panel ~ Panel on the back of the PS Machine where AC power and air are connected.

probe ~ A tube attached to the pick and place head that picks up, carries, and releases 
devices. Usually a probe has a rubber tip on the end that allows it to create a 
good vacuum seal on the device. 

Programmer A FlashCORE or Universal assembly that accepts Socket Adapters and programs 
the devices.

programming ~ The process of electronically writing data into a device. (Burning is another term 
used to describe this operation.) “Input devices” are usually blank or un-pro-
grammed; “output devices” are usually programmed devices.

programming mod-
ule 

~ Module that contains the programming electronic circuit boards required to pro-
gram a device in the socket.

PSI ~ Pounds per Square Inch; a measurement of pressure. One PSI = 0.07031 kg per 

cm2.

Puff ~ A surge of air through the pick and place probes to release a device.

Pv ~ A designation used to indicate the programmer closest to the vision camera, or 
its label.

Q

QFP ~ Quad Flat Pack.

R

register ~ A high-speed memory location in a computer's CPU.

Reject Tray A tray or box that holds the rejected devices. May also be call a Reject Tray.

S

Safety Shield ~ One of the plastic, hinged doors that allow access to the workspace. See also, 
Access doors.

SCFM ~ Standard Cubic Feet per Minute, a measurement of flow.

SHCS ~ Socket Head Cap Screws

semiconductor ~ A programmable integrated circuit. Also called “devices,” they are made of a 
material whose electrical conductivity is between that of a conductor and that of 
an insulator.

Servo Motor Ampli-
fiers

~

SHCS ~ Socket-Head Cap Screw
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Shuttle Carriage ~ The part of the Shuttle Pedestal that clamps to the belt.

Shuttle Pedestal ~ A small round support, or table top, that holds a device, It is part of the Shuttle 
Transfer System. 

Shuttle Transfer 
System

~ The belt-driven shuttle system that transports devices to a marker, labeler, or a 
Tape Output System.

SNS ~ Serial Number Server

Socket Adapter ~ A part that allows a socket to fit the programmer.

Socket Adapter 
Board

~ A printed circuit board that connects to the Backplane Board to supply the elec-
trical connections for programming devices.

socket module ~ The device-specific part of the programmer that holds a device in place so that it 
can be programmed.

SRAM ~ Static Random Access Memory

Start ~ To load and initialize the operating system on a computer. Synonyms: boot.

T

Tape feeder ~ See Chip Feeder.

Tape Output
Tape Output Sys-
tem

~ Attached to the back of the Option Bay, the (modified) TM?50 Taping Module 
(V-TEK) places programmed devices into device tape.

TaskLink ~ Data I/O’s software for creating programming jobs for PS Series Programmers 
(as well as RoadRunner, FlashPAK, FLX500, Sprint™ Family Programmers and 
UniSite™ family Programmers). It is a Windows based program that simplifies 
task management.

teach ~ To communicate your directives to the system via software routines.

throughput ~ The rate at which correctly-programmed devices are produced.

tip ~ A rubber fitting often inserted onto the end of a probe that allows it to achieve 
the vacuum seal required to pick and hold a device. 

Trailer ~ (Applies to Tape Output System) The length of empty carrier tape required at the 
end of the finished reel of taped devices.

Tray Feeder ~ The TF 20 Tray Feeder mounts onto PS Systems to automatically deliver trays of 
unprogrammed devices to the work space and return full trays to the stack of 
programmed device trays.

TSOP ~ Thin Small Outline Package.

Universal 
Programmer

~ See Optima Programmer

V

vacuum tool ~ A hand tool that uses suction to manipulate objects. “Handy-Vac” is such a tool.

VCC DAC ~ Voltage Collector Common Digital to Analog Converter. Used to generate the sup-
ply power for the devices to be programmed or verified.

VDC ~ Volts (of) Direct Current

verify ~ A device operation that compares data in a programmed device with data in 
RAM or in a disk file. With logic devices, verifying can also include functional 
testing.
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Vision File A reference vision file stores a photo image of a specific device to verify proper 
alignment of devices picked

VPP DAC ~ Voltage Programming Power Digital to Analog Converter. A DAC that controls the 
programming power supply for devices.

W

WinAH400.ini ~ An initialization text file required by the AH500 software to define various fea-
tures and options on the system. 

Winmark Laser 
Marker

~ See Laser Marker.

Work Environment ~ The area defined by the absolute limits of the PNP Head. This term is used syn-
onymously with Workspace.

Work Surface ~ The main surface of the PS Machine where programmers and Socket Adapters 
are installed.

Workspace ~ The area where the pick and place and programming is done. Workspace 
includes the Socket Adapters and Actuator Plates but not the programmers 
themselves.

X
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Data File

creating from master device  3-58
description  3-32

Data I/O customer support offices  --x
Data/Time Settings  4-32
Device Jam Sensor  4-75
Devices

handling  1-6
Diagnostics on FlashCORE Programmers  4-29
Digital I/O

defined  Glossary-2
diagram  4-70

Disabling
programmer  4-63
re-enabling sockets  3-26

Disposal of equipment  4-79
Duplicating a job  3-32

E
Electrical Input Requirements  2-3

Index
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Emergency Stop
Button locations  3-23
description  1-4
function  3-22
Warning  3-22

End a Job  3-24
Environmental Requirements

PS288 & PS388  1-10
PS588  1-9

Errors teaching package file  3-50
ESD

precautions  1-6
Strap connection  1-15

Ethernet address for Laser Marker  2-27
External air  2-3

F
Facilities Required

PS288 & PS388  1-10
PS588  1-9

Fail Retries  3-18
Feeder Unit

aligning pick point  2-19
setting pitch  2-19
teaching location for package file  3-49

Firmware Update
see TaskLink’s online Help file

First Article Test
after Vision & Pkg files  3-33
before Vision & Pkg files  3-32
on FlashPAK  3-32
on PS Machine  3-33

FlashCORE Programmers
about  1-13
diagnostics  4-29
per PS Model  1-3
removing  4-30

FlashPAK  3-32
Footnotes Dialog  3-11
Frimware updates  4-48
Fume Extractor

replacing pleated filter  4-41
Functional Block Diagram  4-70
Fuses, Gantry  4-65

G
Gantry

description  1-12
Lead Screw grease fittings  4-27
trouble  4-65

Gantry, fuses  4-65
Get Movetimes  3-51
Goggle rating, laser protection  1-16
Ground connection  1-15

H
Handler Computer

overview  1-14
Handler Software

main window  1-21
HIC Adapters  3-4
HIC Socket Openers  3-5

I
ICOS Inspection System  3-17
Ignore Programmers feature  3-18
Input media  3-16
Input/Output Modules

Automatic Tray Feeder  2-10
standard and optional combinations  1-8
tube  2-12

Input/Output Tray  2-7
Inspection system  3-17
Installation  2-1

room size  1-28

Installation of PS Machine  1-28
Installing

Probe tips  3-7
Programmers, contact support
Socket Adapters, FC  3-3
Socket Adapters, Optima  3-6

Interface Cable, Tape Feeder  2-18

J
Job Statistics  3-53

“I don’t see Kibibit in here. It should be here.”
Let us know about any items you can’t find by e-mailing

userdocs@dataio.com
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K
Keyboard and Touchpad, description  1-15

L
Label Printing  3-60

label type  3-61
setting up  2-28

Languate
changing  1-3

Laser Filters
determining contents  1-26
handling and storage  1-27
replacing pleated filter  4-41

Laser Marking File
creating  3-62 to 3-68
editing  3-64
loading image file  3-65
template.mkh  3-64
verifying laser operation  3-67

Laser Marking System
ethernet address  2-27
safety interlock description  1-25
set up  2-27
specifications  1-25

Laser protection goggle rating  1-16
Laser template settings  3-64
Light colored devices, programming  2-26
Light Tower

colors  3-25
description  1-12
monitoring  3-25

Log Files
collecting  4-59

Log files  4-59

M
Machine

comparison  1-3
envelope  1-29

Machine envelope  1-29
Main air pressure  2-3
Maintenance, interval table  4-2
Mark devices only  3-18
Marking System

description  1-15
Master Device  3-58
Movetimes

teaching in the package file  3-51

N
Network Communication

O
Opener pressure  2-3
Openers vs. Actuators  1-13
Operator Functions  3-2

checking system readiness  3-2
switching on power  3-10
starting TaskLink and loading job  3-10
preselecting programmers  3-13
configuring input/output settings  3-16
checking input/output media  3-20
stopping the system  3-22
shutting down the system  3-27
clearing a disabled socket  3-26
disabling a programmer  3-26
light tower explanation  3-25

Operator Grounding connection  1-15
Operator Mode  3-33
Optima programmers

about  1-13
Optima Support Kit  1-13
Optimize Movetimes  3-51
Options tab  3-16
Output media  3-16

P
Package File

description  3-40
movetimes  3-51
Reject Bin locations  3-46
Shuttle locations  3-48
Tape Input  3-49
Teaching  3-40
Tray locations  3-44
Tube locations  3-46

Package Statistics  3-54
Part Number

see the part name
part numbers  3-9
Passwords  3-31
Pause programming  3-23
PC Backup system  4-1, 4-68
PC Drive Failure  4-68
Pick and Place Head (PNP)

description  1-12
Pin 1  3-21, 3-43
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Pitch
adjusting on tape input feeder  2-19

Pneumatic Input Requirements  2-2
PNP. See Pick and Place Head (PNP)
Pocket Empty Sensor  4-76
Porbllems

capturing information  4-59
Power

applying first time  2-5
switching on  3-10

Power Cable, connecting  2-3
Preventive Maintenance

interval table  4-2
Printer

label  3-60
laser  3-62

Probe
Breakaway tip  3-7
part numbers  3-7
sizes  3-7

Probe Tips  3-7
Process Errors, yields  3-58
Programmer

diagnostics  4-29
disabling  3-26, 4-63
per PS Model  1-3
replacing FC  4-30
types  1-13

Programming Yields
maximizing  3-57
monitoring statistics  3-52
process errors  3-58
socket issues  3-57
system maintenance  3-58

PS Machine
comparison  1-3
envelope  1-29

R
Reference Vision File

description  3-34
Teaching  3-34 to 3-40

Reference Vision File Teaching  3-34 to 3-40
Regulator

Red number  2-3
Reject 2  3-21
Reject Bin

installing  2-9
teaching locations  3-46

Removing
Socket Adapters, FC  3-4
Socket Adapters, Optima  3-6

Repair information  --x
Requirements

electrical  2-3
pneumatic  2-2
room ventilation  1-28

Restart E-Stop  3-23
Restarting after trouble  4-58
Retries, programming  3-18
Rotation Values  3-43
Run One  3-33
Running a job  3-21

S
Safety

main precautions  1-23
symbols  --x

Safety Interlocks
laser marking system  1-25

Safety Shields
cleaning  1-5
description  1-15
how to use  1-5

Security Profiles  3-31
see TaskLink online Help
Serial number  1-11
Serialization, with marker  3-62
Setting PS Options  3-16
Setup  3-16
Setup Window  3-16
Shutting down  3-27
Shutting Off  4-4
Shuttle Belt

adjusting  4-36
replacing  4-37

Shuttle Cups  3-9
installing  3-9

Shuttle locations
teaching in the package file  3-48

Socket Actuator
setting air pressure  4-8

Socket Actuator Pressure Regulator  2-3
Socket Actuator Sensor

adjusting  4-5
Socket Adapter

cleaning  3-57
installing, FC  3-3
installing, Optima  3-6
part number  3-11
removing, FC  3-4
removing, Optima  3-6
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Socket Openers
adjusting  3-14
collision hazards  3-6
HIC  3-5

Sockets
cleaning  3-57
disabling  3-26
disabling one site  4-63
yield issues  3-57

Software updates  4-48
Sort-On-Error-Code  3-21
Space requirements  1-28
Spare Tray setup  2-11
Specifications

PS288 & PS388  1-10
PS588  1-9

Start programming  3-21
Starting

after trouble  4-58
AH500  3-10

Static Tray Mount  2-7
Static trays

return to  2-11
Statistics  3-52
Statistics Window  3-54
Statistics, package

resetting  3-54
Stopping

Emergency Stop  3-22
end a job  3-24
pause programming  3-23

Switch Off PS System  3-27
Switch Power On  3-10
System Logs

collecting  4-59

T
Tape Feeder input

installing  2-16 to 2-19
Tape Input

feeder unit control panel  2-19
teaching in the package file  3-49

Tape Input Feeder
cable  2-18
description  1-17
pitch  2-19

Tape Output Module
adjusting PNP head  2-24
description  1-17
installing  2-19 to 2-25

Tape Output Sensors
carrier tape  4-76
cover tape  4-75
device jam  4-75
pocket empty  4-76

Task
creating  3-31

TaskLink  1-19, 3-10
creating a Task  3-31
loading a job  3-10
Modes  3-33
Session Data Logging  3-53
starting  3-10
updating  1-20

Teaching Package File  3-40
axis limit errors  3-50

Teaching Reference Vision File  3-34 to 3-40
Test Plan  3-32
TF 20, see Tray Feeder
Theta. See Rotation
Touch Screen Monitor

description  1-15
Transfer devices only  3-18
Tray

installing  2-7
orientation  2-7
reject  2-9 to 2-10
removing  2-8
static  2-11

Tray Feeder
maintenance  4-15
operation  3-29
setup  2-10

Tray Locations
teaching in the package file  3-44

Tray Mount  2-7
Magnetic  2-8
Thumb screw  2-7

Troubleshooting
general  4-58
Laser Printing  3-67
tape output sensors  4-74

Tube Input/Output Modules
description  1-17
setting up  2-12 to 2-16

Tube Locations
teaching in the package file  3-46

Turn On Power  3-10
Turning Off Power  3-27
Turning power off  4-4
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U
Universal programmers

about  1-13
Universal/Optima Support Kit  1-13
Unpacking  2-1
Updates

AH500  1-21
algorithms  3-58
programmers  4-32
software  4-48
TaskLink  1-20
vision file parameters  4-55

User Profiles  3-31

V
Vacuum Generator

adjusting blow-off  4-13
Vacuum Sensor

adjusting PNP head  4-19
adjusting Shuttle Ped 1 and 2  4-21
adjusting tape output PNP head  4-23

Ventilation  1-28
requirements  1-28

Vibration Adjustment Controls
adjusting  2-16
troubleshooting  4-66

Vision Background Plate  2-26
Vision Calibration  4-49
Vision contrast  2-26
Vision System

description  1-14
dialog box  3-37
setting up  3-16

Vision Template File  3-34

W
Warranty  --xi
Weee Directive  4-79
Winah400.ini

configuring for tape input  2-16
WinMark

editing  3-64
laser marking  3-62
trouble shooting  3-67

Work envelope  Glossary-7
Workspace  4-5

Y
Yields  3-57 to 3-58
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